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Preface

To suggest changes to documentation or to Help

• Complete a brief survey about this document by clicking the link below.
Thank you in advance for your help.

Related Documentation
TraceFinder documentation includes Help and the TraceFinder User Guide as a PDF file.

To view the TraceFinder manual

• Go to Start > All Programs > Thermo TraceFinder > Manuals > TraceFinder User 
Manual.

To open TraceFinder Help

• From the TraceFinder window, choose Help > TraceFinder Help. 

To find a particular topic, use the Help Contents, Index, or Search panes.

For more information, including upcoming application notes, visit www.thermo.com.

Contents

• Related Documentation

• Special Notices

• Introduction

• System Requirements

• Contacting Us
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Preface
Special Notices
This guide includes the following types of special notices:

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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Preface
System Requirements
Your system must meet these minimum requirements.

System Requirements

PC • 2 GHz processor dual core with 2 GB RAM
• CD/R-ROM drive
• Video card and monitor capable of 1280 × 1024 resolution (XGA)
• 75 GB available on the C: drive
• NTFS format

Instruments 
(supported or 
required)

Autosamplers
• CTC PAL HTC-HTS
• Accela™
• Surveyor™
• Agilent™ 1100 and 1200

LC Devices
• Accela Pump
• Agilent 1100
• Agilent 1200
• Surveyor MS Pump Plus
• Surveyor LC Pump Plus

Mass spectrometers
• TSQ Quantum Access Max™
• TSQ Quantum Access™
• TSQ Quantum Ultra™
• TSQ Vantage™

Software • Microsoft® Windows® XP Professional SP3
• Microsoft Office 2007 SP2 or Microsoft Office Excel 2007 SP2
• Dot Net 3.5 SP1
• Foundation 1.0.1 (available on the Xcalibur 2.1.0 CD)
• Xcalibur 2.1.0.1139 and Xcalibur 2.1.0.1140QF03489 quick fix
Thermo Scientific TraceFinder User Guide ix



Preface
Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the 
window. 

To suggest changes to documentation or to Help

• Fill out a reader survey online at 
http://www.surveymonkey.com/s.aspx?sm=R7gKOvhLXn3NTkpK2BefHQ_3d_3d.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
x TraceFinder User Guide Thermo Scientific
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1

Introduction

This chapter describes the general features of TraceFinder 1.0 quantitative software.

About the TraceFinder Application
The TraceFinder application is the next generation of Thermo Scientific quantitative software. 
The application focuses on environmental and food safety markets, creating the workflows 
that laboratories use.

In a single software package, the TraceFinder application provides a focused workflow for 
specific non-bioanalytical laboratory use and meets the need for a dynamic method 
development.

The TraceFinder application supports foreign language information systems and can export 
SRM data in .xml format so that other applications and foreign language systems can import 
the files into their databases. 

The TraceFinder application can import the following file types:
• Sample lists in .csv or .xml format
• Processing (.pmd) and instrument (.meth) method files from Xcalibur
• Compounds from .xml files that use the datastore format

The TraceFinder application can continuously run acquisitions for 72 hours while processing 
batches of data and producing reports. It checks accuracy and precision of data against systems 
that have previously been certified against a standard processing program, such as the 
Statistical Analysis System (SAS).

Contents

• About the TraceFinder Application

• TraceFinder Feature Summary

• Reporting Features
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1 Introduction
About the TraceFinder Application
Supported File Types

• Comma-separated values (CSV): A textual representation of value fields that are denoted 
as separated from a stream of alpha-numeric values that may be associated by a comma.

• Extensible Markup Language (XML): A generic framework for storing any amount of 
text or any data whose structure can be represented as a tree. The only indispensable 
syntactical requirement is that the document has exactly one root element (also called the 
document element). This means that the text must be enclosed between a root start-tag 
and a corresponding end-tag.

• METH: A proprietary file format for the Xcalibur software suite that contains specific 
instructions that let connected scientific instruments perform data acquisition.

• PMD: A proprietary file format for the Xcalibur software suite that contains specific 
instructions about processing data that has been acquired through the instruments 
attached to the system.

• RAW: A file type used for acquired samples on the system.

TraceFinder Directory Structure

The TraceFinder application creates folders for projects/subprojects/batches, methods, and 
templates in the ..\Thermo\TraceFinder directory. Within each batch folder, the application 
creates folders for data, methods, and reports.

IMPORTANT  Users cannot rename or move the folders created by the TraceFinder 
application.
2 TraceFinder User Guide Thermo Scientific



 1 Introduction
TraceFinder Feature Summary
TraceFinder Feature Summary
The TraceFinder system provides a workflow-oriented approach to high-throughput 
quantitation. The system uses a batch-centric approach and tools to automate and speed up 
the processes of method creation, loading samples, automatically generating data, manually 
reviewing and editing results, and finalizing the data review and reporting process. 

The TraceFinder software package includes data acquisition, processing, reviewing, and 
reporting capabilities designed to assist analysts in environmental and food safety applications. 
The application has a fully automated acquisition mode and a manual review mode.  You can 
use the data acquisition system to create and submit batches and monitor real-time review of 
results. 

The TraceFinder application uses a comprehensive processing method to provide improved 
handling of ion ratio calculations, review and reporting, a mass spectral comparison capability, 
and an integrated connection between the processes of data review and reporting. 

Key features include the following: 

• Role-based authorization for Lab Director, IT Administrator, Supervisor, Technician, and 
QAQC (quality assurance)

• Configuration mode with user administration, project administration, datastore 
administration, and application administration

• Method development mode with instrument method editor, processing parameters, 
QA/QC parameters, and reporting options

• Data Review mode with batch views, data review, local method views, and report views

• Acquisition mode

• Database-capable method development

• Quantification workflows, supporting capabilities present in LCquan and LabForms 2.5

• Pre defined, customized report formats

Features of the common workflow include the following:

• Acquisition and processing

• Peak detection

• Quantification to include calibration

• QA/QC analysis and flag setting

• Reporting

• Data persistence

• Raw data file handling
Thermo Scientific TraceFinder User Guide 3
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Reporting Features
Reporting Features
The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The TraceFinder application can produce both standard reports and custom reports. 
The following types of reports meet the requirements of various methods and worldwide 
regulatory agencies and are designed to help track the performance of the GC/LC system and 
method:

Standard Reports

• Batch Report 
• Blank Report 
• Breakdown Report 
• Calibration Density Report 
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Confirmation Report 
• Confirmation Report  2
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2  Long 
• High Density Sample Report 3 
• High Density Sample Report 3  Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report 
• Manual Integration Report 
• Method Detection Limit Report 
• Method Report 
• Method Validation Report 
• MSMSD Report 
• Quantitation Report 
• Solvent Blank Report 
• Surrogate Recovery Report 
4 TraceFinder User Guide Thermo Scientific



 1 Introduction
Reporting Features
Custom Reports

• AltCalibrationReport
• Alternate BatchReport
• Alternate CalibrationReport
• Alternate ConfirmationReport
• Alternate MatrixSpikeReport
• Alternate SampleReport
• Alternate SummaryReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport 
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long
• QuantitationReport

For additional information about custom and standard reports and a sample of each standard 
report type, see “Sample Reports” on page 221.
Thermo Scientific TraceFinder User Guide 5





2

Getting Started

This chapter describes the basic TraceFinder workflow and the procedures for getting started 
with the TraceFinder application.

TraceFinder Workflow
The TraceFinder software is structured with a typical laboratory workflow in mind—the user 
creates a batch and the system injects samples into the instrument, runs the samples, analyzes 
the data, and generates a report. You can set up a master method for specific compound 
groups or assays you expect to run in your lab. When you are ready to run a particular type of 
sample, select the appropriate method and you are ready to start. 

When using the TraceFinder application, follow these basic steps:

1. Create and save a master method. 

An instrument method defines only how raw data is acquired. A master method is a 
combination of instrument method and processing method that defines how the raw data 
is processed, how the QA/QC information evaluates the results, and how the results 
appear in reports. 

2. Create and submit a batch. 

A batch is a list of samples for processing and reporting using a specified method. Each 
row of a batch represents a unique sample. 

3. Monitor the status of the batch in the Real Time Status view. 

The real -time display is visible from the dashboard and all the TraceFinder modes. You 
can begin another batch while you watch the real-time display of the currently acquiring 
batch.

Contents

• TraceFinder Workflow

• Installing the TraceFinder Application

• Installing the QED and NIST Libraries

• Choosing a Mode
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2 Getting Started
Installing the TraceFinder Application
4. Evaluate the data in the Data Review mode. 

The Data Review mode includes views where you can review batches, batch data, reports, 
and local methods.

5. View and print reports in the Report View. 

Use the Report View to view or print the reports for the currently selected batch.

Installing the TraceFinder Application
Follow these instructions to install, start, and log on to the TraceFinder application.

To install the TraceFinder application

1. Follow the instructions on the included CDs to install the Xcalibur 2.1 application and 
your TSQ instrument driver.

2. Install the driver for your LC pump and autosampler.

3. Insert the TraceFinder 1.0 CD in the drive, and follow the on-screen instructions.

If the install windows do not automatically open, navigate to the Xinstall.exe file and 
launch it.

To start the TraceFinder application

1. Configure your instruments.

You cannot configure your instruments while the TraceFinder application is running.

2. Double-click the TraceFinder application icon on your desktop, or go to Start > All 
Programs > Thermo TraceFinder 1.0 > TraceFinder 1.0. 

To log on to the TraceFinder application

1. Enter your assigned user name.

Before you can log on to the TraceFinder application, a system administrator must have 
set up a user account for you. The administrator will have assigned you a user name and 
password and given you permission to access specific modes. 

2. Enter your password.

If your user name and password do not match, the system reports this error:

Correct the user name or password, or contact your system administrator.

3. Click Login.

The TraceFinder dashboard opens. See “TraceFinder dashboard” on page 15. 

4. To exit the TraceFinder application without logging on, click Exit TraceFinder.
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Installing the TraceFinder Application
TraceFinder log on screen

Table 1. Log on screen parameters

Parameters Description

Username The user’s assigned user name.

Password The assigned password for the user name.

Login Verifies the user name and password, and displays the dashboard.

Exit TraceFinder Quits the TraceFinder application.
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Installing the QED and NIST Libraries
Follow these instructions to install the NIST and QED libraries.

To install the NIST library

1. Launch the XInstall executable.

2. Click the NIST Library button.

The NIST 08 MS Search and AMDIS Setup wizard opens.

3. Follow the instructions in the setup wizard.

4. When the wizard prompts you to select a program folder, select Thermo TraceFinder 
1.0.

To install the QED library

1. On your desktop, double-click the Xcalibur icon, .

The Thermo Xcalibur Roadmap opens.
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2. Select Tools > Library Manager.

The Thermo Library Manager opens. The NIST library is displayed in the libraries list.

3. On the Library Manager, click Add.

The Add Library dialog box opens.

4. Click Browse, and locate your QED library in the C:\Thermo folder.

5. Click OK.

The application reports that the library has been added to the NIST software.

6. Click Dismiss to close the message box.

The application adds the QED library to the NIST libraries list in the Library Manager.
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7. Click Exit in the Thermo Library Manager.

8. Start the TraceFinder application.

9. Go to the Method Development mode.

10. Choose File > New > Method template from the main menu.

The QED NIST Library is listed in the Use these libraries list on the Method Template 
Editor.
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Choosing a Mode
The dashboard provides the current user with options applicable to assigned role of that user. 
The following table shows the available modes for each user role.

To choose a mode

1. From the dashboard, click the mode in which you want to work.

Your dashboard shows only the modes that you have permission to use. See “TraceFinder 
dashboard” on page 15.

2. To change modes from within any of the TraceFinder application modes, click the mode 
buttons in the lower left corner of the window.

Table 2. User roles and permissions

User role Method 
Development Acquisition Data Review Configuration

Lab Director × × × ×

IT Administrator ×

Supervisor × × ×

Technician × ×

QAQC ×

Blue indicates the 
current mode
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Choosing a Mode
To watch the real-time display from the dashboard

• Click Real Time Status.

The real-time status is displayed at the bottom of the dashboard.

For descriptions of all the features of the real-time display, see “Real-time Display” on 
page 176. 
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TraceFinder dashboard

A dashboard for a Lab Director, who has permission for all modes, looks like this:

Table 3. TraceFinder dashboard parameters

Parameters Description

Real Time Status Opens the real-time display for the current acquisition. The 
acquisition progress is displayed within the current mode window. 

Help Opens the TraceFinder Help.

Log Off Logs off the current user and displays the log on screen.

Method Development Opens the Method Development mode where you can create a 
master method, an instrument method, or a development batch.

Acquisition Opens the Acquisition mode where you can acquire and process a 
previously saved (.tbr) batch, create and acquire a new batch, 
reinject samples from a previously acquired batch, or create a 
batch template.

Data Review Opens the Data Review mode where you can create and review 
batches, batch data, reports, and local methods.

Configuration Opens the Configuration mode where you can set permissions, 
assign users to roles, configure available reports and import new 
reports, and maintain the various databases, including the 
Compound Datastore. 
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3

Using the Configuration Mode

This chapter discusses the configuration tasks assigned to the IT Administrator and Lab 
Director roles.

If your role is that of an IT Administrator or Lab Director, you are responsible for the 
following:

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

• Creating projects and subprojects

• Maintaining compounds in the compounds datastore

To access the Configuration mode

• Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens.

Contents

• User Administration

• Project Administration

• Compound Datastore

• Application Configuration
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Figure 1. Configuration navigation pane

Table 4.  Configuration navigation pane functions  (Sheet 1 of 2)

Functions Description

User Administration
Opens the User Administration view where you can add, 
remove, or edit user accounts and permissions. See “User 
Administration” on page 20.

Project Administration
Opens the Project Administration view where you can create 
and manage projects and subprojects. See “Project 
Administration” on page 28.
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Compound Datastore
Opens the Compound Datastore view where you can manage 
the definition of compounds in the current datastore. See 
“Compound Datastore” on page 30.

Application Configuration

Opens the Application Configuration view where you can 
configure the TraceFinder application to operate as a Liquid 
Chromatography (LC) technology or as a Gas 
Chromatography (GC) technology and specify a compound 
datastore to use for that technology. See “Application 
Configuration” on page 37.

Table 4.  Configuration navigation pane functions  (Sheet 2 of 2)

Functions Description
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User Administration
In the User Administration view of the Configuration mode, in the role of Lab Director or IT 
Administrator, you can add, remove, or edit user accounts and permissions. 

For detailed descriptions of each user role and the permissions and responsibilities for each 
role, see “User Roles” on page 25.

Use the following procedures:

• To open the User Administration view

• To add a user

• To edit user information

• To remove a user

To open the User Administration view

1. Do one of the following:

• From the dashboard, click Configuration.

–Or–

• Click Configuration in the navigation pane from any other mode.

2. Click the User Administration task pane.

The User Administration view opens. See “User Administration view” on page 23.

To add a user

1. Click the Add user icon, .

The parameters in the User area at the bottom of the view are enabled.

2. Enter a unique name in the Username field.

3. Select a role from the Role list.

All users must be assigned to one of these defined roles. For detailed information about 
the permissions allowed for each role, see “User Roles” on page 25.

4. Enter the user’s password.

There is no confirmation for the encrypted password you enter, so carefully enter it and 
make sure to communicate it to the user.

5. (Optional) Enter the user’s full name, account number, phone number, and e-mail 
address.
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6. To enable this user login, select the Enabled check box.

You can disable a user login without deleting the user’s information. See To edit user 
information. 

7. Do one of the following:

• When all the user information is correct, click the Save changes icon, .

The TraceFinder application adds the new user to the User Listing table, and the 
parameters in the User area are unavailable.

–Or–

• To discard all information and not create a new user from the parameter values 

you entered, click the Cancel changes icon, .

All information is discarded and the parameters in the User area are unavailable.

To edit user information

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

2. Click the Edit user icon, .

The parameters in the User area are enabled.

3. Edit any of the parameter values.

If you are editing your current user name, the Enabled check box is unavailable because 
you cannot make your own account unavailable.

Note  Clicking anywhere in the row selects the user.
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4. Do one of the following:

• When all the user information is correct, click the Save changes icon, .

The TraceFinder application adds the new parameter values to the User Listing, and 
the parameters in the User area are unavailable.

– Or–

• To discard all changes and not save the edits, click the Cancel changes icon, .

All changes are discarded, and the parameters in the User area are unavailable.

To remove a user

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

2. Click the Remove user icon, .

If you select your current user name, the Remove User icon is unavailable. You cannot 
remove yourself.

3. When prompted, confirm that you want to remove this user. 

If the user is currently logged on to the TraceFinder application, the user’s current session 
is not affected.

4. Click OK.

Note  Clicking anywhere in the row selects the user.

Note  Rather than completely removing the user, you can disable a user login without 
removing all the user information from the system. See To edit user information. 
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User Administration view

Table 5. User Administration parameters  (Sheet 1 of 2)

Parameter Description

Security Groups
All permission levels defined in the TraceFinder application. For 
detailed descriptions of user permissions, see “User Roles” on 
page 25.

User Listing

Username User login names.

Role The security group that defines user permissions.

Account Number User account numbers.

Phone Number User telephone numbers.

Email Address User e-mail addresses.

Enabled Available or unavailable status for the user account.

User

Username Login name for this user.

Role Security group that defines this user’s permissions.

Password Login password for this user.
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Full name The user’s actual name.

Account number Optional account number for this user.

Phone number Optional telephone number for this user.

Email address E-mail address for this user. Used to notify user of a randomly 
generated password.

Enabled Allows or disallows access for this user. When this user is 
currently logged on, disallowing takes effect after the user logs 
off.

Functions

 Add user Enables the fields in the User area where you can enter 
information for a new user.

 Remove user Deletes all information for the selected user.

 Edit user Enables the User area where you can edit any of parameters for 
the selected user.

 Save changes Adds the new parameter values to the User Listing table and 
disables the parameters in the User area.

 Cancel changes Discards all new or edited information.

Table 5. User Administration parameters  (Sheet 2 of 2)

Parameter Description
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User Roles

This section describes the responsibilities for five different types of users: Lab Director, IT 
Administrator, Supervisor, Technician, and QAQC.

User Permissions

A Lab Director or an IT Administrator assigns you to a role that gives you permission to 
access specific modes of the TraceFinder application. When you log on, the dashboard 
displays links to only the modes that you can access.

Lab Director

As a user in the role of Lab Director, you review graphically applicable data and manipulate 
data, batches, methods, and instruments. 

A lab director is responsible for these tasks:

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Running samples and reviewing data collected by others

• Reporting the data

• Understanding the results and giving final approval of the released data before archiving

IT Administrator

As a user in the role of an IT administrator, you set security, manage users into roles, and 
manipulate the various databases. You are is responsible for adding compounds into the 
various compound databases. 

An IT administrator is responsible for these tasks: 

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

Table 6. User roles and permissions

User role Method 
Development Acquisition Data Review Configuration

Lab Director × × × ×
IT Administrator ×
Supervisor × × ×
Technician × ×
QAQC ×
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Supervisor

As a user in the role of a supervisor, you are responsible for putting samples on the instrument 
and using previously built sequences and methods for processing and acquiring data. You also 
develop and edit methods for processing and acquiring data, review the data, and distinguish 
between the need to rerun samples or pass reports up to the lab manager or QAQC for final 
review. On a daily basis, you establish the priority for a list of samples to run and create the 
sequence of events.

A supervisor is responsible for these tasks: 

• Submitting samples 

• Creating and submitting batches

• Reporting the data to management

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Understanding the results, who ran the batch, and who passed along the results before 
you give intermediate approval and send the data to management

• Modifying new compounds or adjusting methods for specific result sets

Technician

A user in the role of a technician is responsible for putting samples on the instrument and 
using previously built sequences and methods for processing and acquiring data. A technician 
also edits existing methods for processing and acquiring data and is responsible for reviewing 
collected data and distinguishing between the need to rerun samples or pass reports up to the 
supervisor. On a daily basis, a technician is responsible for gathering the list of samples to run 
and creating the sequence of events. 

A technician is responsible for these tasks:

• Submitting samples 

• Creating and submitting batches

• Creating data to be reviewed by management

• Receiving instructions for new sets of samples for the TraceFinder application to analyze 
after finishing the current analysis

• Reviewing data from the mass spectrometer

• Understanding the resulting data, making integration changes, and passing those changes 
up for further approval.
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QAQC

As a user in the role of a QAQC, you review graphically applicable data and interpret the data 
but you do not manipulate the data.

A QAQC user is responsible for these tasks: 

• Reviewing data from the mass spectrometer

• Understanding the results and who ran and passed along the results before giving 
intermediate approval and sending the data on to management

• Receiving instructions for new sets of samples for the TraceFinder application to analyze 
after finishing the current analysis
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Project Administration
In the role of Lab Director or IT Administrator, you can create and manage projects and 
subprojects in the Project Administration view of the Configuration mode.

Use the following procedures:

• To open the Project Administration view

• To create projects or subprojects

• To delete projects or subprojects

To open the Project Administration view

1. Do one of the following:

• From the dashboard, click Configuration.

–Or–

• Click Configuration in the navigation pane.

2. In the Configuration navigation pane, click Project Administration.

The Project Administration view opens.

All projects are created under a main Projects folder on the C: drive:

C:\Thermo\TraceFinder\Projects
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To create projects or subprojects

1. Select the top-level project.

You can select the main Projects folder and create a new project under it, or you can select 
one of your existing projects and create a subproject under it.

When you select a project folder, the plus sign is enabled.

2. Click the plus sign.

The TraceFinder application creates a new, unnamed project folder under the selected 
project.

3. While the new project is still highlighted, type a new name.

Project names can contain spaces and special characters, except for the following special 
characters: \ / : * ? “ < > |

4. To save the new name, press Return or click anywhere in the view.

To delete projects or subprojects

1. Select the project or subproject you want to delete.

You can delete any project that contains no subprojects. You can delete any subproject 
that contains no batches. When the selected project or subproject is available for deletion, 
the minus sign is enabled.

2. Do one of the following:

• Click the minus sign.

–Or–

• Right-click and choose Remove project or Remove subproject from the shortcut 
menu.

3. At the prompt, click Yes to remove the selected project or subproject.
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Compound Datastore
In the role of Lab Director or IT Administrator, you can manage the definition of compounds 
in the current datastore in the Compound Datastore view of the Configuration mode.

The current datastore is the datastore specified for the current technology in the Application 
Configuration view. See “Application Configuration” on page 37.

Use the following procedures:

• To open the Compound Datastore editor

• To open a compound datastore

• To create a new compound datastore

• To import compounds

• To add a single compound

• To save a datastore

• To save a datastore to a new name

• To remove a compound or a compound’s transition information

• To filter the compound list
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To open the Compound Datastore editor

1. Do one of the following:

• From the dashboard, click Configuration.

–Or–

• Click Configuration in the navigation pane.

2. Click the Compound Datastore task pane.

The current datastore opens in the Compound Datastore view.

To open a compound datastore

1. Click Load Compound Datastore in the Compound Datastore task pane. 

The Open Compound Datastore dialog box opens.

2. To expand the folder, click the plus sign before the folder name.

3. Double-click the name of the datastore you want to open.

The selected datastore opens in the Compound Datastore view. See “Compound 
Datastore view” on page 35.
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To create a new compound datastore

• Click New Compound Datastore in the Compound Datastore task pane.

A new, empty datastore opens in the Compound Datastore view. You can import a file of 
compounds into the new datastore (see To import compounds), or you can manually add 
compounds one at a time (see To add a single compound).

To import compounds

1. Click Import Compounds in the Compound Datastore task pane.

2. In the browser, locate a .csv or .xml compounds file and open the file.

The TraceFinder application imports the compounds in the imported file, adds them to 
any compounds already in the datastore, and alphabetically sorts them.

To add a single compound

1. To add a single compound to the datastore, do one of the following:

• Click the Add compound icon, .

–Or–

• Right-click in the compounds list and choose Add compound from the shortcut 
menu.

A new empty compound row is added to the bottom of the compounds table. 

2. Click the first table cell, and enter the required Compound Name parameter.

3. (Optional) Enter values for the Category, Ionization, or Chemical Formula columns. 

4. To add a transition to the compound, select the compound and do one of the following:

• Click the Add transition information icon, .

–Or–

• Right-click and choose Add transition information from the shortcut menu. 

A new empty transition row is added to the compound. A transition includes quantitative 
values for the compound. Each compound requires at least one transition.
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5. Enter all required parameters. 

For a list of required and optional parameters, see the list of Compound Datastore 
parameters.

6. To save the new datastore, click Save Compound Datastore in the Compound Datastore 
task pane.

To save a datastore

1. Click Save Compound Datastore in the Compound Datastore task pane.

The database is stored as

..\Thermo\TraceFinder\Databases\<GC or LC>\foldername\filename.xml

If the datastore contains any compounds that do not have an associated transition, the 
Compounds that are missing Quans dialog box opens, listing the compounds.

2. Do one of the following:

• To remove the listed compounds from the datastore and save the datastore, click 
Continue.

–Or–

• To keep the listed compounds and return to the datastore, click Cancel.

Tip  You cannot add another new compound or save the compound datastore until 
you enter all required transition parameters or remove the transition from the 
compound. To remove a transition, right-click in the row and choose Cancel.

Note  You cannot save a compound that does not have an associated transition.
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To save a datastore to a new name

1. Click Save As Compound Datastore in the Compound Datastore task pane.

The Save Compound Datastore dialog box opens.

2. Enter a file name for the new compound datastore.

3. (Optional) Click Add Folder and enter the name for a new folder to be created in the 
..\Thermo\TraceFinder\Databases\<GC or LC> folder.

4. Click Save.

The database is stored as

..\Thermo\TraceFinder\Databases\<GC or LC>\foldername\filename.xml

To remove a compound or a compound’s transition information

1. In the Compound Datastore view, select the row you want to delete.

You can remove either of the following:

• An entire compound, including all associated transition information.

• A row of transition information.

Table 7. Select Compound Datastore parameters

Parameter Description

Compounds Lists the datastores you have created for this technology.

Default The default datastore defined for this technology.

File Name File name for the new datastore.

Save Writes the new datastore to the specified folder.

Add Folder Adds a new folder where you can save the datastore.

Cancel Closes the dialog box and makes no changes to the datastore 
for the current technology.
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2. Click the Remove transition icon, , or right-click and choose Remove transition 
from the shortcut menu.

3. At the prompt, click Yes if you are sure you want to delete the selected row.

The selected row and all items within it are deleted.

To filter the compound list

1. To display a filtered list of compounds, click the funnel icon, , in the column header.

For each column, a list of filterable criteria is displayed in a list box. On all list boxes, you 
can choose to filter by All, Blanks, NonBlanks, or by custom filter criteria. Other filter 
criteria are specific to the individual columns.

2. To create a custom filter based on column values, choose Custom from the menu.

For detailed instructions about creating a custom filter, see Appendix C, “Using Filter 
Criteria.”  

Compound Datastore view

Tip  If you add a row of compound or transition information and do not complete all 
the required values, you can right-click and choose Cancel to remove the entire row. 
You can cancel only incomplete compound or transition rows. 

Table 8. Compound Datastore parameters  (Sheet 1 of 2)

Parameter Description

Function Icons

 Adds a compound transition to the datastore. 

Adds a quantitation items row to the selected compound 
transition, or adds a confirming items row to the selected 
quantitation item. 

Deletes the selected compound transition. 
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Compound parameters

Compound Name Alphanumeric name assigned to the compound.

Category (Optional) Alphanumeric identifier. 

Ionization (Optional) Alphanumeric identifier. 
Valid values: ESI, APCI, EI, CI, APPI

Chemical Formula (Optional) Alphanumeric chemical identifier.

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the 
center of a target precursor-ion peak in mass-to-charge ratio 
(m/z) units. 
Default: 0.0
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quan ion. The location of the 
center of a target quan-ion peak in mass-to-charge ratio (m/z) 
units. 
Default: 0.0
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas. 
Range: -250.00 to 250.00

Lens (Optional) Range: -400 to 400

Polarity + (positive) or - (negative)

RT (min) Retention time. The application uses RT and Window values to 
determine the start and stop time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT - (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Window (sec) Acquisition window. The application uses RT and Window 
values to determine the start and stop time for the acquisition. 
Range: 0.00 to 499.50
Start time = RT - (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Energy Ramp (Optional) 
Range: 0.00 to 200.00

Color coding • Blue indicates a compound.
• Yellow indicates a quantitative transition.
• Green indicates a confirming transition.
• Pink fields are editable when you import new transitions 

into the datastore from method editor.

Table 8. Compound Datastore parameters  (Sheet 2 of 2)

Parameter Description
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Application Configuration
This section includes instructions for the following tasks:

• Specifying the General Configuration

• Specifying the Reports Configuration

Specifying the General Configuration

In the role of Lab Director or IT Administrator, you can configure the TraceFinder 
application as a Liquid Chromatography (LC) technology or as a Gas Chromatography (GC) 
technology in the Application Configuration view of the Configuration mode. Each 
technology uses a different compound datastore.

As a user in the role of Lab Director or IT Administrator, you can also choose a compound 
datastore to use with the LC or GC technologies.

Use the following procedures:

• To open the General page of the Application Configuration view

• To specify a technology

• To specify a datastore to use in method development

To open the General page of the Application Configuration view

1. Do one of the following:

• From the dashboard, click Configuration.

–Or–

• Click Configuration in the navigation pane.

2. Click Application Configuration.

The General page of the Application Configuration view opens. See “General page” on 
page 39.
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To specify a technology

1. In the Technology selection area, select a chromatography technique.

2. Click Apply.

The TraceFinder software reminds you that you must restart the application when you 
change technologies. 

• If you would like the TraceFinder application to restart for you, click Yes.

• If you want to restart the TraceFinder application yourself, click No.

Until you restart the TraceFinder application, you will not see the features specific to 
the new technology.

To specify a datastore to use in method development

1. In the Compound Datastore selection area, click Select.

The Select Compound Datastore dialog box opens.

The list of available datastores is specific to the current chromatography technique (LC or 
GC). If you change the chromatography technique, you must restart the application to 
populate the compound datastore selection list with the appropriate datastores.

2. Do one of the following:

• To use this datastore for all methods created for this technology, click Select.

–Or–

• To close the Select Compound Datastore dialog box and keep the currently specified 
datastore, click Cancel.

3. In the Application Configuration view, click Apply.

When you switch between techniques, the TraceFinder application remembers the 
datastore assigned to each technique.
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General page

Table 9. General configuration parameters

Parameter Description

Chromatography 
technique

Specifies Gas Chromatography or Liquid Chromatography.

Select Opens a browser where you can select a saved datastore .xml file.
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Specifying the Reports Configuration

In the Application Configuration view of the Configuration mode, as a user in the role of Lab 
Director or IT Administrator, you can configure a list of reports that are available to users 
when they generate reports from the Method Development or Acquisition modes. From the 
Reports page, you can configure standard reports or custom reports.

This section includes configuration instructions for the following reports:

• Standard Reports

• Custom Reports

To open the Reports page of the Application Configuration view

1. Do one of the following:

• From the dashboard, click Configuration.

–Or–

• Click Configuration in the navigation pane.

2. Click Application Configuration.

The General page of the Application Configuration view opens.

3. Click the Reports tab.

The Reports page of the Application Configuration view opens. 
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Standard Reports

The TraceFinder application supplies standard reports.

To specify which standard reports are available

1. Click the Standard reports tab.

The Standard report page opens. This page is the default when you first open the Reports 
page. See “Standard reports page” on page 42.

2. Use the directional arrows to move reports from the Available reports pane to the 
Configured reports pane.

All reports in the Configured reports pane are available to users in the Method 
Development and Acquisition modes.

3. Do one of the following:

• To return the report selections to their original state (when you first opened this 
page), click Undo changes.

–Or–

• To apply the current selections, do the following:

a. Click Apply.

A message reminds you that you must restart the TraceFinder application before your 
report selections are reflected in the reports available for the Method Development 
and Acquisition modes.

b. In the message dialog box, click Yes to restart the TraceFinder application now or 
click No to remain on the Reports page.

To import new standard report types

1. Click Import.

2. In the browser, locate a Crystal Reports .dll file and open the file.

The application writes the imported report to the TraceFinder installation directory.

The Available reports pane displays the new report.

Tip  Use the CTRL or SHIFT keys to select multiple reports.
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Standard reports page

Table 10. Standard reports parameters  (Sheet 1 of 2)

Parameter Description

Standard reports Displays all available standard reports.

Custom reports Displays all available custom reports.

Available reports All reports listed in the Available reports pane are potentially 
available for this application but have not been selected for the 
Method Development or Acquisition modes.

Configured reports All reports listed in the Configured reports pane have been 
selected for the Method Development and Acquisition modes.

>> Moves all reports from the Available reports list to the 
Configured reports list.

> Moves the selected reports from the Available reports list to the 
Configured reports list.

< Moves the selected reports from the Configured reports list to 
the Available reports list.
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<< Moves all reports from the Configured reports list to the 
Available reports list.

Import Opens a browser where you can choose a report file to add to the 
Available reports list.

Undo changes Returns the report selections to their original state (when you 
first opened this page).

Apply Applies the current selections, and reminds you that you must 
restart the application before the report selections are available 
for the Method Development and Acquisition modes.

Table 10. Standard reports parameters  (Sheet 2 of 2)

Parameter Description
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Custom Reports

The TraceFinder application lets you configure and import custom reports.

To specify which custom reports are available

1. Click the Custom reports tab.

The Custom reports page opens. See “Custom reports page” on page 45.

2. Use the directional arrows to move reports from the Available reports pane to the 
Configured reports pane.

All reports in the Configured reports pane are available to users in the Method 
Development and Acquisition modes.

3. To create a single report for an entire batch (rather than separate reports for each sample), 
select the Batch level report check box for the report type.

Rather than creating separate reports for each sample, this uses data from only the last 
sample to create a single report for the entire batch.

4. Do one of the following:

• To return the report selections to their original state, click Undo changes.

–Or–

• To apply the current selections, do the following:

a. Click Apply.

A message reminds you that you must restart the TraceFinder application before your 
report selections are reflected in the reports available for the Method Development 
and Acquisition modes.

b. In the message dialog box, click Yes to restart the TraceFinder application now or 
click No to remain on the Reports page.

To import new custom report types

1. Click Import.

2. In the browser, locate a Custom Reports .xltm file and open the file.

The application writes the imported report to the following folder:

..\Thermo\TraceFinder\Templates\Reports

The Available reports pane displays the new report.

Tip  Use the CTRL or SHIFT keys to select multiple reports.
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Custom reports page

Table 11. Custom reports parameters  (Sheet 1 of 2)

Parameter Description

Standard reports Displays all available standard reports.

Custom reports Displays all available custom reports.

Available reports All reports listed in the Available reports pane are potentially 
available for this application but have not been selected for the 
Method Development or Acquisition modes.

Configured reports All reports listed in the Configured reports pane have been 
selected for the Method Development and Acquisition modes.

>> Moves all reports from the Available reports list to the 
Configured reports list.

> Moves the selected reports from the Available reports list to the 
Configured reports list.
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< Moves the selected reports from the Configured reports list to 
the Available reports list.

<< Moves all reports from the Configured reports list to the 
Available reports list.

Batch level report Rather than creating separate reports for each sample, this uses 
data from only the last sample to create a single report for the 
entire batch.

Import Opens a browser where you can choose a report file to add to the 
Available reports list.

Undo changes Returns the report selections to their original state (when you 
first opened this view).

Apply Applies the current selections, and reminds you that you must 
restart the application before the report selections are available.

Table 11. Custom reports parameters  (Sheet 2 of 2)

Parameter Description
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Using the Method Development Mode

This chapter includes method development tasks assigned to the Supervisor or Lab Director 
roles.

To access the Method Development mode

• Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

Contents

• Using Published Methods

• Working with Instrument Methods

• Working with Development Batches

• Working with Master Methods
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Method Development navigation pane
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Table 1. Method Development navigation pane functions 

Functions Description

Instrument View See “Working with Instrument Methods” on page 51.

New instrument 
method

Opens the Instrument View where you can specify instrument 
settings for your configured instruments.

If the instrument you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then 
reopen the TraceFinder application. You cannot configure an 
instrument while the TraceFinder application is running.

Open instrument 
method

Opens a browser where you can choose an instrument method to 
open.

Import Published 
Method

Imports an instrument method (.meth) from the Published 
Methods folder. 

Recent Files Displays recently saved instrument methods.

Development Batch See “Working with Development Batches” on page 55.

Select batch location Specifies a location to store temporary development batch raw data 
files.

New sample list Removes acquired samples from your development batch so you 
can begin a new sample list.

Open Qual Browser Opens the Qual Browser where you can monitor the acquisition of 
your samples.

Method View See “Working with Master Methods” on page 62.

Create method Creates a new, empty master method. 

Launch Method Forge Opens the Method Forge dialog box where you can create a new 
master method.

Import method from 
PMD

Import a processing method created by Xcalibur or LCquan 
applications.

Open method Opens the Open Master Method dialog box where you can choose 
a master method to open.

Import Published 
Method

Imports a processing method (.mmx) from the Published Methods 
folder. 

Export SRM data Writes the data in the SRM table to the following file:

..\Thermo\TraceFinder\Methods\methodname.xml

You can use the data in this file in the instrument method editor 
when you open the TSQ 2.1 application.

Recent Files Displays recently saved master methods.
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Using Published Methods
Published instrument and processing methods reside in the C:\Thermo\Published Methods 
folder. All method files in this folder are accessible when you use the Import published 
method command in the Instrument view or Method view of the Method Development 
mode.

The instrument (.meth) and processing (.mmx) methods in your Published Methods folder 
can originate in any of the following ways:

• Create a method in the TraceFinder application and copy it to the C:\Thermo\Published 
Methods folder on any computer.

• Create a method in the Xcalibur or LCquan applications and copy it to your 
C:\Thermo\Published Methods folder.

• Install sample methods when you install the TraceFinder application. The application 
automatically writes these methods to your C:\Thermo\Published Methods folder. 

• Download methods from the TraceFinder Web site to your C:\Thermo\Published 
Methods folder.

To download a method from the TraceFinder Web site

1. Choose Help > TraceFinder Online > Published Methods.

The Customer Download Web site opens.

2. Do one of the following:

• If you are not a registered user, fill in all required fields and click Submit.

–Or–

• If you are a registered user, enter your user name and password and click Sign In.

3. On the Customer Download page, locate the method file you want to download.

4. Save the method file to the following folder:

..\Thermo\Published Methods
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Working with Instrument Methods
An instrument method is a set of experiment parameters that define the operating settings for 
an autosampler, liquid chromatograph (LC), gas chromatograph (GC), mass spectrometer, 
and so on. Instrument methods are saved as file type .meth.

Use the following procedures:

• To open the Instrument View

• To create a new instrument method

• To open an instrument method

• To import a published method

IMPORTANT  Do not open the Thermo Foundation Instrument Configuration tool while 
the TraceFinder application is running.
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To open the Instrument View

1. Do one of the following:

• From the dashboard, click Method Development.

–Or–

• Click Method Development in the navigation pane from any other mode.

2. Click the Instrument View task pane.

The Instrument View opens. All configured instruments are displayed on separate pages. 
This example shows the instrument page for the Accela autosampler (Accela AS).

Note  To open Help for any of your configured instruments, click Help on the 
instrument page.
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To create a new instrument method

1. Click New instrument method in the Instrument View task pane.

2. In the Instrument View, click the tab for the instrument you want to use for the method.

3. Edit the values on the instrument page.

4. From the main menu, choose File > Save As.

The Save Instrument Method dialog box opens.

5. Do one of the following:

• Type a new name for the instrument method and click OK.

–Or–

• Select an instrument method name to overwrite and click Overwrite.

The TraceFinder application saves the new instrument method in the following folder:

..\Thermo\TraceFinder\InstrumentMethods

To open an instrument method

1. Click Open instrument method on the Instrument View task pane.

A browser opens.

2. In the browser, select an instrument method from the list and open the file.

The selected method opens in the Instrument View. You can edit this method and save 
the changes, or you can save this method to another name.
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To import a published method

1. Click Import published method in the Instrument View task pane.

The Import Published Method dialog box opens, displaying all the methods in the 
Published Methods folder.

2. Select the method you want to import and click Import.

The Save Instrument Method dialog box opens.

3. Do one of the following:

• Type a new name for the instrument method and click OK.

–Or–

• Select an instrument method name to overwrite and click Overwrite.

The TraceFinder application reports that the method imported successfully. Published 
methods reside in the C:\Thermo\Published Methods folder.
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Working with Development Batches 
In the Development Batch view, you can test your instrument method in real time by creating 
and acquiring test samples. Development batches let you test different instrument methods 
and optimize parameters, such as LC gradients, MS source parameters, and autosampler 
variables, to find the best conditions for a master method. Development batches are not 
designed for high throughput in everyday analysis.

This section includes instructions for the following tasks:

• Creating a Development Batch

• Editing Samples in a Development Batch

• Acquiring Samples in a Development Batch

Creating a Development Batch

You create a development batch to test your instrument method and use it to acquire samples 
only once. You cannot save a development batch. 

Use the following procedures: 

• To a open the Development Batch view

• To add samples to the development batch

• To insert samples into the development batch

• To copy a sample

To a open the Development Batch view

1. Do one of the following:

• From the dashboard, click Method Development.

–Or–

• Click Method Development in the navigation pane of the current mode.

2. In the Method Development navigation pane, click Development Batch.

The Development Batch view opens a new, empty batch.
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To specify a location for development batch data

1. To specify a location for the files, click Select batch location in the Development Batch 
task pane.

By default, the TraceFinder application writes the temporary files, raw data files, and .sld 
method file to the following folder:

../Thermo/TraceFinder/Temp

2. In the browser, do one of the following:

• Locate the folder you want to use for the development batch files and click OK.

–Or–

a. Locate and select the folder where you want to create a new folder for the batch files.

b. Click Make New Folder.

The application creates a new folder in the selected folder.

c. Right-click the New Folder filename and choose Rename from the shortcut menu.

d. Type the name for the folder.

e. Click OK.

The TraceFinder application creates all development batch files in the specified folder.

To add samples to the development batch

• Do one of the following:

• Right-click and choose Add sample from the shortcut menu.

–Or–

• Use the spin box to select the number of rows and click the Add Sample icon to add 
multiple sample rows.

New, empty samples appear at the end of the sample list.
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To insert samples into the development batch

1. Select the sample above which you want to insert empty samples.

2. Do one of the following:

• Right-click and choose Insert sample from the shortcut menu.

–Or–

• Use the spin box to select the number of rows and click the Insert Sample icon to 
insert multiple sample rows.

New, empty samples appear above the selected sample.

To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert copy sample from the shortcut menu.

The copy of the sample appears above the selected sample.
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Editing Samples in a Development Batch

A development batch requires fewer parameters than a real batch, but the mechanism for 
managing the information is the same.

For detailed instructions about using Copy down or Fill down to enter column values, see 
Appendix B, “Using Copy Down and Fill Down.” 

Use the following procedures:

• To enter column values

• To resize or reorganize the columns

• To remove selected samples from the list

• To remove all samples from the list

To enter column values

1. Double-click the Filename column and type a file name for the raw data file.

2. (Optional) Enter values for the Sample name, Sample ID, or Comment columns.

3. Enter a vial position for each sample.

4. Enter an injection volume for each sample.

5. To enter an instrument method for each sample, click the down arrow in the Instrument 
method column and select a method from the list.

This list contains all the available instrument methods.

To resize or reorganize the columns

1. To resize a column, drag the header separator on the right side of the column.

2. To move a column, drag the column header.

You cannot move the Filename column.
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To remove selected samples from the list

1. Select the samples you want to remove.

Make sure the first column indicates that the samples are selected.

2. Right-click and choose Remove selected samples from the shortcut menu.

To remove all samples from the list

1. Click New sample list in the Development Batch task pane.

2. One of the following happens:

• If the samples in the current batch have all been acquired, the list is cleared.

• If the samples in the current list have not been acquired, a message confirms that you 
want to clear them and start a new list. 

3. To create a new empty list, click Yes.

Note  You cannot save a development batch when you create a new one; you can only 
create, acquire, and discard each batch after you use it. The application saves only the 
generated raw files in the specified batch location.

Selected samples
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Acquiring Samples in a Development Batch

In a development batch, you can submit the entire batch for acquisition or submit only 
selected samples.

Use the following procedures:

• To acquire selected samples

• To acquire the batch

• To open the Qual Browser

To acquire selected samples

1. Select the samples you want to acquire.

2. Do one of the following:

• Right-click and choose Submit selected samples from the shortcut menu.

–Or–

• Click the Submit selected samples icon, .

The TraceFinder application creates a raw data file for each selected sample. It writes the 
raw files and all temporary working files to the following folder:

../Thermo/TraceFinder/Temp

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw files and a MethodDevelopment.sld file remain in the folder.

If a sample is acquired more than once, the subsequent raw data files are timestamped 
with the acquisition time.

To acquire the batch

• Do one of the following:

• Right-click and choose Submit batch from the shortcut menu.

–Or–

• Click the Submit batch icon, .

The TraceFinder application creates a raw data file for each sample in the batch and a .sld 
method file. The TraceFinder application writes the raw data files, the .sld method file, 
and all temporary working files to the specified folder.

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw files and a MethodDevelopment.sld file remain in the folder.

If a sample is acquired more than once, the subsequent raw data files are time-stamped 
with the acquisition time.
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To open the Qual Browser

• In the Development Batch task pane, click Open Qual Browser.

The Thermo Xcalibur Qual Browser opens.

For detailed instructions about using the Qual Browser, refer to the Qual Browser Help.
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Working with Master Methods
The TraceFinder application uses a master method to specify the nature and types of 
acquisition, processing, and reporting that occur with a batch of samples. When you are 
testing for compounds in an assay, you can create a method designed specifically for that type 
of application. 

When you create a master method, the TraceFinder application uses the method to determine 
how the software works with a set of samples to provide a set of meaningful results. The 
application uses an instrument method to define how raw data is acquired, while the rest of 
the master method defines how the raw data is processed, how the flags information evaluates 
the results, and how the reporting functionality defines the way your data and results are 
output into reports. 

The TraceFinder application applies your master method to a batch, which is a list of one or 
more samples to be processed and reported. Together, the master method and batch provide a 
workflow-oriented approach to the processing of data and the reporting of information for 
small and large sets of samples. 

To speed up the creation of master methods, you can create a method template. Using a 
method template helps you to develop methods faster because all of your commonly used 
method settings, such as number of confirming ions, are saved in a template. 

This section includes instructions for the following tasks:

• Creating a New Method

• Creating a Method with Method Forge

• Importing an Xcalibur Method

• Importing a Published Method

• Exporting SRM Data

• Creating a Method Template

• Editing a Master Method
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Creating a New Method

You can create a new, empty method that has no compounds associated with it. You can then 
add compounds one at a time.

Use the following procedures:

• To open the Method View

• To open a new method

• To add compounds to the method

• To save the new method

To open the Method View

• Do one of the following:

• From the dashboard, click Method Development.

–Or–

• Click Method Development in the navigation pane from the current mode.

To open a new method

1. From the Method View task pane, click Create method.

A new, empty master method view opens.
Thermo Scientific TraceFinder User Guide 63



4 Using the Method Development Mode
Working with Master Methods
2. In the Labname box, type your laboratory name.

3. From the Instrument method list, select an instrument method.

4. (GC only) Select a breakdown method (if different from your instrument method).

5. (Optional) Enter any other parameters for the new method.

For detailed descriptions of all parameters on the General page, see “Editing the General 
Page” on page 88.

To add compounds to the method

1. Click the Compounds tab.

2. Click the Detection tab.

The Detection page shows an empty Compound list.

3. From the main menu, choose Master method > Associate a raw file.

A warning informs you that associating a new raw file with the method can update the 
target ion ratio values.
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4. Do one of the following:

• To associate a raw data file and update the ion ratio values, click Yes.

–Or–

• To associate a raw data file without updating the ion ratio values, click No.

–Or–

• To stop this action and not associate a raw data file, click Cancel.

Unless you cancel the operation, the What raw file would you like to use? dialog box 
opens.

5. Locate the raw file you want to use to identify compounds for this method and open the 
file.

The TraceFinder application displays the chromatographic and spectrum data for the 
compounds in the selected raw file.
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6. Select a filter from the Filter list.

7. Click the peak in the chromatogram that represents the compound you want to add to 
the method.

8. Right-click and choose Add this peak as new compound from the shortcut menu.

The TraceFinder application adds a new compound named Peak@RetentionTime and 
displays the quantitation peak information for the compound. If you have a NIST library 
installed and the compound is found in the library, the compound name is displayed 
instead.

9. Repeat these steps for each compound you want to add to the method.

For detailed descriptions of all parameters on the Detection page, see “Editing the 
Compounds Page” on page 95. 

To save the new method

1. Choose File > Save.

The Save Master Method dialog box opens.

2. Do one of the following:

• Type a new name for the master method and click OK.

–Or–

• Select a method name to overwrite and click Overwrite.

The TraceFinder application saves the new method data in the following folder:

..\Thermo\TraceFinder\Methods 
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Creating a Method with Method Forge

With Method Forge, you can create a master method by manually selecting peaks, cutting and 
pasting peak names, selecting multiple compounds, renaming peaks, or comparing mass 
spectra from the datastore searches, or the TraceFinder application can automatically create a 
master method for you. 

When the TraceFinder application automatically creates a master method for you, it performs 
the following functions:

• Reviews your raw data file and identifies compounds that are present in your sample. 

• Uses your mass spectral reference libraries to assign a compound name and CAS number.

• Uses mass spectral information to select potential quantification and confirming ions and 
a reference mass spectrum for the compound. 

A master method contains a list of compounds and an initial set of information for detecting, 
processing, and reporting those compounds. 

Use the following procedures:

• To automatically create a method

• To manually select compounds to create a method

To automatically create a method

1. From the Method View task pane, click Launch Method Forge.

The Method Forge dialog box opens. See “Method Forge” on page 71.

Use the Method Forge to create a master method from an existing raw data file or create a 
new raw data file to use for the master method. 

2. In the Method Forge dialog box, do one of the following:

• Select the Use the default template option. 

–Or–

• Select the Select a custom template option and highlight your custom template in 
the Method template table.

For detailed instructions on creating a custom method template, see “Creating a 
Method Template” on page 78.

3. Select the Name the master method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the method is named for the raw file used to create the 
method.
Thermo Scientific TraceFinder User Guide 67



4 Using the Method Development Mode
Working with Master Methods
4. Select the Automatically create the master method check box.

5. Do one of the following:

a. In the Raw file selection area, choose Use an existing raw data file.

b. Click the browse button and locate a raw data file to use for the method.

–Or–

a. In the Raw file selection area, choose Acquire a new raw data file.

b. From the Instrument method list, select a method (.meth) file to use for acquiring the 
data.

c. In the Raw filename box, type the name of the file where the application will write 
the raw data.

d. In the Path box, type a path or click the browse button and locate a folder where the 
application will save the raw data file.

e. (Optional) Type a comment about the acquired sample or the data file.

6. Do one of the following:

• Choose Manual injection.

–Or–

a. Choose Use autosampler.

b. In the Vial position box, type a vial position.

c. In the Injection volume box, type an injection volume.

7. To automatically create the master method, click OK (or Overwrite).

As the Method Forge creates the method, it displays the following status:
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When the acquisition completes, Method Forge performs peak detection, datastore 
searching, and characteristic ion and reference spectrum identification and then loads this 
information into a new master method. This process occurs immediately if you selected a 
previously acquired raw file.

Method Forge displays the detected compounds in the Edit compound dependent 
parameters dialog box.

8. (Optional) Select the compounds that you want to add to the compound datastore and 
click Add to CDS.

The selected compounds are added to the current compound datastore.

9. To use these compounds in your method and close the dialog box, click Continue to 
Method.

All compounds in the imported processing method are used in your method. The 
TraceFinder application displays the General page of the Master Method View.

10. From the Instrument method list, choose an Instrument method to use for your master 
method.

To manually select compounds to create a method

1. From the Method View task pane, click Launch Method Forge.

The Method Forge dialog box opens. See “Method Forge” on page 71.

Note  To add these compounds to the datastore, you must use this command before 
you continue to the method.
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2. In the Method Forge dialog box, do one of the following:

• Select the Use the default template option. 

–Or–

• Select Select a custom template and highlight your custom template in the Method 
template table.

For detailed instructions about creating a custom method template, see “Creating a 
Method Template” on page 78.

3. Select the Name the master method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the method is named for the raw file used to create the 
method.

4. Make sure the Automatically create the master method check box is not selected.

5. To select a raw data file, click the browse button and locate the file.

6. To manually create the master method, click OK (or Overwrite).

The Master Method view displays a list of compounds in the data file. 

When you select a peak in the Compound Name list, the peak spectrum is displayed in 
the right pane. When multiple peaks are selected, the peak spectrum display is blank.

7. Select a group of peaks to be included in your master method.

Hold down SHIFT to select a range of peaks or CTRL to select multiple, individual 
peaks.
70 TraceFinder User Guide Thermo Scientific



 4 Using the Method Development Mode
Working with Master Methods
Selected peaks are indicated with blue RT values and bold compound names.

8. After you manually select your peaks, click Create to create the master method. 

The results are displayed in the Master Method View.

9. To save the new method, choose File > Save from the main menu.

Method Forge
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Table 2. Method Forge parameters

Parameter Description

Method template 
selection

Use the default 
template

Creates a new method with the default template.

Select a custom 
template

Lists all the available method templates.

For detailed instructions about creating a custom method 
template, see “Creating a Method Template” on page 78.

Name the master 
method

The name for the new master method.

Automatically create 
the master method

When the acquisition completes, Method Forge performs peak 
detection, datastore searching, and characteristic ion and reference 
spectrum identification. This information is loaded into a new 
master method. This process occurs immediately when you select a 
previously acquired file.

Raw file selection

Use an existing raw 
data file

Enables the Raw filename box where you can select a raw data file 
to use to create the master method.

Acquire a new raw data 
file

Enables functions to acquire data to create a raw file to use to 
create the master method.

Instrument 
method

Saved method (.meth) file to use for acquiring the data.

Raw filename File name where the application will write the raw data.

Path Location where the application will save raw data file.

Sample comment (Optional) Comment about the acquired sample or the data file.

Manual injection Performs a manual acquisition.

Use autosampler Performs an autosampled acquisition.

Vial position The tray vial number used for the autosampler acquisition.

Injection amount The volume (in milliliters) injected by the autosampler 
acquisition.

Function buttons

Overwrite Overwrites the specified master method name. This function is 
enabled only when the specified master method name already 
exists.

OK Creates a master method using the data and parameters you 
specified.

Cancel Closes the Method Forge and does not create a master method.
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Importing an Xcalibur Method

You can create a new method from an existing Xcalibur processing method.

To import a method

1. From any mode, click Method Development.

2. In the Method View task pane, click Import method from PMD.

The Import method from PMD dialog box opens.

3. To select an Xcalibur processing method file to import, click the browse button for the 
PMD file to import box.

4. In the browser, locate the Xcalibur processing method file and open the file.

The TraceFinder application imports the compound information from the Xcalibur 
method file.

5. To associate a raw data file with this method, click the browse button for the Rawfile to 
associate box.

6. In the browser, locate the raw data file and open the file.

7. (Optional) Change the number of decimal places in the Mass precision box.

You can set the mass precision decimal places to an integer between 0 and 3.

8. Click OK.

If the compounds in the imported method file are not in the Compound Datastore, the 
TraceFinder application displays the compounds in the Edit compound dependent 
parameters dialog box.
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9. (Optional) Select the compounds you want to add to the Compound Datastore and click 
Add to CDS.

10. To add these compounds to your method and close the dialog box, click Continue to 
Method.

The TraceFinder application adds the compounds in the imported method to your new 
method.

11. Specify an Instrument method to use for the master method.

12. (GC only) Specify a Breakdown method to use for the master method.

13. To edit the imported compounds, follow the instructions in “Editing a Master Method” 
on page 87.

14. Choose File > Save As and specify a name for your new method.
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Importing a Published Method

In the TraceFinder application, you can import processing methods from the Published 
Methods folder. For information about the methods in the Published Methods folder, see 
“Using Published Methods” on page 50.

To import a published processing method

1. In the Method View task pane, click Import published method.

The Import Published Method dialog box opens.

2. Choose the method you want to import and click Import.

The TraceFinder application reports that the processing method (and any associated 
instrument method) imported successfully and displays the imported processing method 
in the Master Method View.
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Exporting SRM Data

In the TraceFinder application, you can export your selected reaction monitoring (SRM) data 
to an XML file.

To export SRM data

1. Open the master method from which you want to export SRM data.

2. From the Method View task pane, click Export SRM data. 

The TraceFinder application writes the data in the SRM table to the following file:

..\Thermo\TraceFinder\Methods\methodname.xml

The data in this file matches the TSQ .xml data and can be used in the instrument 
method editor when you use the TSQ 2.1 application.

SRM data examples

TSQ Quantum (LC) example

TSQ Quantum QED (LC) example
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TSQ Vantage (LC) example

TSQ Quantum QED (LC) example

TSQ Quantum™ (GC) example
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Creating a Method Template

In the TraceFinder application, you can create a processing method using a method template 
that contains the basic settings as defined by a user in the role of Lab Director or Supervisor. 

Use the following procedures:

• To create a method template

• To specify peak criteria

• To choose a library

• To specify confirming ions

• To calibrate the compounds

• To enter a note for the method

• To save the method template

To create a method template

1. Do one of the following:

• From the dashboard, click Method Development.

–Or–

• Click Method Development in the navigation pane from the current mode.

2. Click Method View in the navigation pane.

3. From the main menu, choose File > New > Method template.

The Method Template Editor opens. See “Method Template Editor” on page 84.
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To specify peak criteria

1. In the Find the peaks area, choose a sensitivity level.

In selecting the degree of sensitivity, you define how extensively the peak detector 
algorithm searches for low-level peaks. 

• The High (ICIS) peak detection algorithm is designed for MS data and has superior 
peak detection efficiency at low MS signal levels. 

• The Standard (Genesis) peak detection algorithm is provided for backward 
compatibility with Xcalibur 1.0 studies. 

2. To look for peaks only in a certain range of the entire chromatogram, select the Limit the 
retention time range check box and specify a retention time (RT) range. 

3. To indicate whether to select peaks by relative height or area and the percentage of the 
highest peak that will result in compound selection, select the Enable peak threshold 
check box.

To consider a peak for a processing method, the application uses the Enable peak 
threshold filter to determine which peaks meet the specified percentage of the largest 
peak.

4. To display a specific number of the largest peaks by height or area, select the Only select 
top peaks check box.
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To choose a library

1. In the Use these libraries box, select the libraries you want to search.

All libraries loaded on your instrument are displayed in the Use these libraries box. 

2. To limit the number of hits returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit library hits box.

3. To specify how to sort the library searches, choose a value for the Best match method list 
box.

To specify confirming ions

1. To set the number of confirming ions, select the Include confirming ions check box and 
set a value in the Number of confirming ions box.
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This value is the number of other ions in the spectrum whose ratio is compared to the 
quantitation ion. Using this ratio, you can then determine if it is the target compound or 
something else. This value defaults to 2 because you typically perform a 3-ion experiment 
with one quan mass and two confirming ions. 

The system selects the most intense ion to use as the quantitation mass and uses this mass 
for the mathematical operations. 

2. To define the criteria for evaluating confirming or qualifying ions, select the Specify 
default ion ratio ranges check box and set the following values:

a. To specify the maximum difference in retention time between a confirming ion peak 
and the quantification ion peak, set a value in the Ion coelution (min) box. 

b. To specify an absolute or relative calculation approach for determining the acceptable 
ion ratio range, select Absolute or Relative from the Window type list.

c. To specify the acceptable ion ratio range, set a value in the Window (+/– %) box.

3. To include the peak spectrum in the processing method, select the Include compound 
peak spectrum as reference spectrum check box.

Use this setting to perform a spectra comparison in Data Review mode. 

To calibrate the compounds

1. From the Calibration method list, select Internal or External.

2. From the Curve type list, select one of the following:

• Linear: All other settings are available with this exception: When Include is selected 
in the Origin list, all weighting values are unavailable except for Equal.

• Quadratic: All other settings are available with this exception: When Include is 
selected in the Origin list, all weighting values are unavailable except for Equal.

• Average RF: No selections in the Weighting or Origin lists are available. The 
Weighting list is set to Equal, and the Origin list is set to Ignore. 
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3. From the Origin list, select one of the following:

• Ignore: Specifies that the origin is not included as a valid point in the calibration 
curve when the curve is generated. When you select Ignore, the calibration curve 
might or might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation 
of the calibration curve. When you select Include, the calibration curve might or 
might not pass through the origin.

4. From the Weighting list, select one of the following:

• Equal: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Equal, the calibration curve might or might 
not pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their response (or response ratio). 

5. From the Response via list, choose Area or Height.

• Area: Specifies that the application use this area value in response calculations.

• Height: Specifies that the application use this height value in response calculations. 

To enter a note for the method

• Type in the Notes box, or paste text from another application using CTRL-V.

You can add a note to your method template so that there is a record of what makes this 
template unique. 
82 TraceFinder User Guide Thermo Scientific



 4 Using the Method Development Mode
Working with Master Methods
To save the method template

1. Choose File > Save from the Method Template Editor menu.

The Save Method Template dialog box opens.

2. Do one of the following:

• Type a new name for the master method and click OK.

–Or–

• Select a method name to overwrite and click Overwrite.

The TraceFinder application saves the new method template in the following folder:

..\Thermo\TraceFinder\Templates\Methods 
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Method Template Editor
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Table 3. Method Template Editor parameters  (Sheet 1 of 2)

Parameter Description

Find the peaks

Sensitivity Defines how extensively the peak detector algorithm searches for 
low-level peaks. 

Limit the retention time 
range

Min RT specifies the beginning of the range, and Max RT 
specifies the end of the range. 

Enable peak threshold Specifies whether to select peaks by relative height or area and 
the percentage of the highest peak that will result in compound 
selection.

Only select top peaks Displays a specific number of the largest peaks by height or area.

Identify the peaks

Use these libraries Lists the libraries you can search.

Limit library hits Specifies the number of hits returned when the system searches a 
spectrum against the selected libraries.

Best match method Specifies how to sort the library searches.

Handle confirming ions

Include confirming ions/
Number of confirming 
ions

Specifies the number of confirming ions, which are other ions in 
the spectrum whose ratio is compared to the quantitation ion to 
identify the compound.

This value defaults to 2 because you typically perform a 3-ion 
experiment with one quan mass and two confirming ions.

Specify default ion ratio 
ranges

Enables the ion ratio range features.

Window type An Absolute or Relative calculation approach for determining 
the acceptable ion ratio range.

Window (+/-%) The acceptable ion ratio range.

Ion coelution The maximum difference in retention time between a 
confirming ion peak and the quantification ion peak 

Include compound peak 
spectrum as reference 
spectrum

Includes the peak spectrum in the processing method. Use this 
setting to perform a spectra comparison in Data Review. 

Calibrate the compounds

Calibration method Specifies an internal or external calibration method.

Curve type Specifies a linear, quadratic, or average RF curve type.
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Origin Specifies that the origin is ignored, forced, or included in the 
generated calibration curve.

• Ignore: Specifies that the origin is not included as a valid 
point in the calibration curve when the curve is generated. 
When you select Ignore, the calibration curve might or 
might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the 
origin of the data point plot when the calibration curve is 
generated.

• Include: Specifies that the origin is included as a single data 
point in the calculation of the calibration curve. When you 
select Include, the calibration curve might or might not pass 
through the origin.

Weighting Specifies the weighting for the calibration data points.
• Equal: Specifies that the origin is included as a single data 

point in the calculation of the calibration curve. When you 
select Equal, the calibration curve might or might not pass 
through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
the square of their response (or response ratio). 

Response via Specifies if the application uses area or height in response 
calculations.

• Area: Specifies that the application use this peak area value in 
response calculations.

• Height: Specifies that the application use this peak height 
value in response calculations. 

Table 3. Method Template Editor parameters  (Sheet 2 of 2)

Parameter Description
86 TraceFinder User Guide Thermo Scientific



 4 Using the Method Development Mode
Working with Master Methods
Editing a Master Method

You can open a master method to view or edit the compounds, method instructions, and 
reporting options in the method.

This section includes instructions for the following tasks:

• Opening a Master Method

• Editing the General Page

• Editing the Acquisition List

• Editing the Compounds Page

• Editing the Flags Page

• Editing the Groups Page (GC only)

• Editing the Reports Page

Opening a Master Method

Use the following procedures:

• To open a master method

• To open a master method from the Recent Files list

To open a master method

1. From any view, click Method Development.

2. In the Method View task pane, click Open Method.

The Open Master Method dialog box opens where you can select a master method to 
open.

3. Select a master method and open the file.

The selected master method opens in the Master Method View.
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To open a master method from the Recent Files list

1. From any view, click Method Development.

When you save a method, it is added to the Recent Files list. The Recent Files list displays 
a list of your most recently saved master method files.

2. Click the method name in the Recent Files list. Do not double-click.

The selected method opens in the Method View.

Editing the General Page

The General page defines basic information about the master method.

Use the following procedures:

• To specify general information for a master method

• To update the instrument method parametersTo delete a compound from the list

To specify general information for a master method

1. In the Lab name box, type the name to be displayed on the top of each printed, saved, or 
exported report.

2. In the Assay type box, type the assay type to be targeted by the method.

3. From the Injection volume box, select the injection volume (in μL) to be used for sample 
injection.

Use either the up/down arrows to change the volume in increments/decrements of 1 μL, 
or the keyboard to enter non-integer injection volumes. 
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4. From the Ion range calc method box, select a method for calculating the ion ratio range 
windows.

If you select Level, an additional list box is displayed where you can choose a calibration 
level. These calibration levels are defined on the Compounds page. See “Editing the 
Compounds Page” on page 95.

5. From the Qualitative peak processing template box, select a template for performing peak 
detection on quantitative samples following target compound analysis.

These templates are defined by a user in the role of IT Administrator or Lab Director.

To update the instrument method parameters

1. To update any changes in the instrument method after you created this master method, 
click Update. 

2. (GC only) To update any changes in the breakdown method after you created this master 
method, click Update. 

General page
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Table 4. General parameters

Parameter Description

Lab name (Optional) The laboratory name to be displayed on the top of each 
printed, saved, or exported report. 

Assay type The name for the analysis type to be targeted by the method. The 
assay type associates the method with the analysis of a compound 
or specific class of compounds (for example, an assay type of PAH 
might be used for the analysis of Polynuclear Aromatic 
Hydrocarbons). The TraceFinder application uses this assay type in 
the batch template. You can also select an appropriate combination 
of method and batch template. 

Injection volume The system use the injection volume (in μL) for sample injection. 
Certain autosamplers, such as the AI/AS 3000, use the injection 
volume specified in the associated instrument method. For those 
autosamplers, the value entered in this field is ignored and the 
instrument uses a default method injection volume. Other 
autosamplers, such as the TriPlus, use the TraceFinder application 
method injection volume for sample analysis and override the 
instrument method. For a more detailed explanation, refer to the 
documentation for the autosampler.

Ion range calc method The application uses the ion range calc method to calculate the ion 
ratio range windows: Manual (default), Average, Level, or 
Weighted average.  When you select Level, an additional list box is 
displayed where you can choose a calibration level amount. These 
calibration levels are defined on the Compounds page. See 
“Editing the Compounds Page” on page 95.

Instrument method Instrument method used for processing samples.

Breakdown method 
(GC only)

Breakdown method used for processing samples.

Update Updates any changes to the instrument or breakdown methods 
after you created this master method.

Qualitative peak 
processing template

The application uses the qualitative peak processing template to 
perform peak detection on quantitative samples following target 
compound analysis.

Notes User-added notes about the method.
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Editing the Acquisition List

The Acquisition List page displays all compounds defined for the current method. From this 
page, you can add or delete compounds from the method. See “Acquisition List page” on 
page 93.

To filter the compound list

1. To display a filtered list of compounds, click the funnel icon, , in the column header.

For each column, a list of filterable criteria is displayed in a list box. On all list boxes, you 
can choose to filter by All, Blanks, NonBlanks, or by custom filter criteria. Other filter 
criteria are specific to the individual columns.

2. To create a custom filter based on compound values in a specific column, choose Custom 
from the column list box.

For detailed instructions about creating a custom filter, see Appendix C, “Using Filter 
Criteria.” 

To delete a compound from the list

1. Select the compound to remove from the list.

2. Do one of the following:

• Click the Remove compound transition icon, .

–Or–

• Right-click and choose Remove compound transition from the shortcut menu.

A confirmation dialog box opens, listing the compound to be removed.

3. To confirm the deletion, click Yes.

The selected compound is removed from the acquisition list. 

To add a compound transition to the list

1. Do one of the following:

• Click the Add compound transition icon, .

–Or–

• Right-click and choose Add compound transition from the shortcut menu.

The Select compounds to add dialog box opens, listing all the compounds defined in the 
compound datastore specified for the current technology (LC or GC).
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Figure 1. Select compounds to add dialog box

2. Select the check box for each of the compounds you want to add to the method and click 
Apply.

The compounds are added to the Acquisition List page and the Compounds page of the 
Master Method View. 
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Acquisition List page

Table 5. Acquisition List parameters  (Sheet 1 of 2)

Parameter Description

Function Icons

Adds a confirming items row to the selected quantitation item. 
The icon is unavailable when adding a quantitation items or 
confirming items row is not feasible (a confirming item row is 
selected).

Deletes the selected compound transition. The icon is 
unavailable when no row is selected.

Compound parameters

Compound Name Alphanumeric name assigned to the compound.

Category (Optional) Alphanumeric identifier. 

Ionization (Optional) Alphanumeric identifier. 
Valid values: ESI, APCI, EI, CI, APPI

Chemical Formula (Optional) Alphanumeric chemical identifier.

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the 
center of a target precursor-ion peak in mass-to-charge ratio 
(m/z) units. 
Default: 0.0
Range: 10.000 to 2999.999
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Product Mass The mass-to-charge ratio of the quan ion. The location of the 
center of a target quan-ion peak in mass-to-charge ratio (m/z) 
units. 
Default: 0.0
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas. 
Range: –250 to 250

Lens (Optional) Range: –400 to 400

Polarity + (positive) or – (negative)

RT (min) Retention time. RT and Window values are used to determine 
the start and stop time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Window (sec) Acquisition window. RT and Window values are used to 
determine the start and stop time for the acquisition. 
Range: 0.00 to 499.50
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Energy Ramp (Optional) 
Range: 0.00 to 200.00

Table 5. Acquisition List parameters  (Sheet 2 of 2)

Parameter Description
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Editing the Compounds Page 

The Compounds page sets all parameters for the identification, detection, and quantification 
for the target compound list.  From the Compounds page of the Master Method View, you 
can access the following pages:

• Identification

• Detection

• Calibration

• Calibration Levels

• QC Levels

Identification

The Identification page lists the compounds that are targeted for analysis, reporting, and other 
compound-specific values.

To filter the displayed compounds

• From the Show list box, select the type of compounds you want to display in the 
compounds list.

Compound Types Description

Quan compounds Displays only quan compounds, such as target 
compounds, internal standards, and surrogates.

Non quan compounds Displays only non quan compounds, such as native and 
breakdown compounds.

Target compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Surrogates Displays only surrogate compounds.
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Identification page

 

Table 6. Identification parameters 

Parameter Description

RT Retention time. RT and Window values are used to determine the 
start and stop time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Compound A list of compounds that have been identified. To customize the 
compound names, click the cell and type a new name. To display a 
filtered list of compounds, use the Show list box.

Compound type Compound types are Target Compound, Internal Standard, 
Surrogate, Native, or Breakdown. The application uses target 
compounds, internal standards, and surrogates in quantitative 
analysis, and it uses native and breakdown compound types in 
system evaluation, as defined on the Breakdown page for the GC 
technology. 

Active Identifies each compound to be included in data review and 
reporting. By default, all added compounds are set to active.

CAS No The Chemical Abstract Service (CAS) number that the 
TraceFinder application matched with each compound. To change 
or add a number, click the CAS No cell and enter a new number.

Use as RT Reference 
(GC only)

When performing peak detection with retention time standards, 
the application first identifies those compounds identified as 
retention time standards and then uses their observed retention 
times to adjust any associated target compound.

Reference compound
(GC only)

Reference compound to be used for retention time adjustment for 
a compound. This list includes all compounds that are selected in 
the Use as RT Reference column. 
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Detection

Use the Detection page to customize peak detection and integration for any ions that define 
peaks and compounds.

On the Detection page, you can configure how characteristic ions for targeted compounds are 
detected and integrated. You can also edit the list of characteristic ions for a specific 
compound. Refining these parameters in the master method for each compound and its ions 
can reduce the degree of manual integration that would otherwise be required. 

The Detection page includes these additional pages: 

• Times

• Signal

• Detect

• Spectrum

• Ratios

To filter the displayed compounds

• From the Show list box, select the type of compounds you want to display in the 
compounds list.

Compound types Description

Quan compounds Displays only quan compounds, such as target 
compounds, internal standards, and surrogates.

Non quan compounds Displays only non quan compounds, such as native and 
breakdown compounds.

Target compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Surrogates Displays only surrogate compounds.
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Table 7. Additional detection pages

Pages Description

Times Page to define the retention time and window for a quan peak.

Signal Page to define the detector and its parameters used to display each 
chromatogram trace.

Detect Page to define the peak detection algorithm and its options.

Spectrum Page to define a reference mass spectrum for a quan peak or 
compound.

Ratios Page to define the criteria for evaluating, confirming, or qualifying 
ions.
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Times

Use the Times page to define the retention time and window for a quan peak. 

Times page

Table 8. Times parameters

Parameter Description

Expected RT (min) Expected retention time.

Window (sec) Width of the window (in seconds) of how far around the expected 
retention time the system will look for a peak apex. 

View width (min) Viewable size of the ion chromatogram display. Changing the view 
width does not affect the process of peak detection; the 
TraceFinder application uses it only for graphical display. 
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Signal

Use the Signal page to define the detector and its parameters as you display each 
chromatogram trace. 

Signal page

Table 9. Signal parameters  (Sheet 1 of 2)

Parameter Description

Detector MS: Mass spectrometers. 
Analog: Supplemental detectors (for example, FID, ECD). 
AD card: If you have a detector not under data system control, you can 
capture the analog signal and convert it to digital using an interface box (for 
example, SS420X) for storage in the raw file. 
PDA (photo diode array): Detectors used for LC. 
UV (Ultra-violet): Detectors used for LC. 

Filter Represents a particular data acquisition channel. For example, the filter 
option + c Full ms [35.00-500.00] represents a positive ion centroid signal 
acquired in single-stage, full-scan mode from m/z 35 to 500.
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Trace Represents a specific range of the data. In conjunction with the filter, the 
application uses the trace to identify the characteristic ions for a 
compound. The options are: Mass range, TIC, or Base peak.

m/z The initial mass value. 

Table 9. Signal parameters  (Sheet 2 of 2)

Parameter Description
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Detect

Use the Detect page to define the peak detection algorithm and its options and to determine 
the area under a curve. There are two different modes - Standard (Genesis) and High (ICIS). 
On this page, you can choose how you want each mode to run.

Detect page for Standard (Genesis)
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Table 10. Detect parameters for Standard (Genesis)  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the Standard (Genesis) peak detection algorithm.

Detection method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points
Default: 1 

S/N threshold Current signal-to-noise threshold for peak integration. Peaks with 
signal-to-noise values less than this value are not integrated. Peaks 
with signal-to-noise values greater than this value are integrated. 

Range: 0.0 to 999.0

Enable valley detection Uses the valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. 

Expected width (sec) The expected peak width parameter (in seconds). This controls the 
minimum width that a peak is expected to have if valley detection 
is enabled. 

With valley detection enabled, any valley points nearer than the 
[expected width]/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the application 
terminates the peak at that point. The TraceFinder application 
always terminates a peak when the signal reaches the baseline, 
independent of the value set for the expected peak width. 

Range: 0.0 to 999.0

Constrain peak width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
peak width check box enables the Peak Height (%) and Tailing 
Factor options.
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Peak height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when the Constrain peak width check box is selected. 

Range: 0.0 to 100.0%

Tailing factor A factor that controls how the TraceFinder application integrates 
the tail of a peak. This factor is the maximum ratio of the trailing 
edge to the leading side of a constrained peak. This text box is 
active only when the Constrain the Peak Width check box is 
selected. 

Range: 0.5 through 9.0

Min peak height (S/N) For the valley detection approximation method to use the Nearest 
RT Peak Identification criteria, this peak signal-to-noise value 
must be equaled or exceeded. For component identification 
purposes, the TraceFinder application ignores all chromatogram 
peaks that have signal-to-noise values that are less than the S/N 
Threshold value. 

Range: 0.0 (all peaks) through 999.0

Peak S/N cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 
200, the application defines the right and left edges of the peak 
when the S/N reaches a value less than 200. 

Range: 50.0 to 10000.0

Table 10. Detect parameters for Standard (Genesis)  (Sheet 2 of 3)

Parameter Description
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Valley rise (%) The peak trace can rise above the baseline by this percentage after 
passing through a minimum (before or after the peak). 

This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

When the trace exceeds rise percentage, the TraceFinder 
application applies valley detection peak integration criteria. 

This test is applied to both the left and right edges of the peak. 

The rise percentage criteria is useful for integrating peaks with 
long tails.

Range: 0.1 to 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this 
parameter ensures that the surrounding measurements are higher. 

Range: 1.0 to 100.0
Default: 2.0

# background scans Number of background scans performed by the application.

Report noise as Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak to Peak.

Table 10. Detect parameters for Standard (Genesis)  (Sheet 3 of 3)

Parameter Description
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Thermo Scientific TraceFinder User Guide 107



4 Using the Method Development Mode
Working with Master Methods
Table 11. Detect parameters for High (ICIS)  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the High (ICIS) peak detection algorithm.

Detection method Highest peak uses the highest peak in the chromatogram for 
component identification. 

Nearest RT uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points
Default: 1 

Area noise factor The noise level multiplier used to determine the peak edge after 
the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Range: 1 through 500
Default: 5

Peak noise factor The noise level multiplier used to determine the potential peak 
signal threshold. The ICIS peak detection algorithm uses this 
value.

Range: 1 through 1000
Default: 10

Baseline window The TraceFinder application looks for a local minima over this 
number of scans. The ICIS peak detection algorithm uses this 
value.

Range: 1 through 500
Default: 40

Constrain peak width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
peak width check box enables the Peak Height (%) and Tailing 
Factor options.

Peak height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when the Constrain peak width check box is selected. 

Range: 0.0 to 100.0%
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Tailing factor A factor that controls how the TraceFinder application integrates 
the tail of a peak. This factor is the maximum ratio of the trailing 
edge to the leading side of a constrained peak. This text box is 
active only when the Constrain the Peak Width check box is 
selected. 

Range: 0.5 through 9.0

Min peak height (S/N) For the valley detection approximation method to use the Nearest 
RT Peak Identification criteria, this peak signal-to-noise value 
must be equaled or exceeded. For component identification 
purposes, the TraceFinder application ignores all chromatogram 
peaks that have signal-to-noise values that are less than the S/N 
Threshold value. 

Range: 0.0 (all peaks) through 999.0

Noise method The options are INCOS or Repetitive.

INCOS uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but it takes longer. 

Min peak width The minimum number of scans required in a peak. The ICIS peak 
detection algorithm uses this value.

Range: 0 to 100 scans
Default: 3

Multiplet resolution The minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Range: 1 to 500 scans
Default: 10 

Area tail extension The number of scans past the peak endpoint to use in averaging 
the intensity. The ICIS peak detection algorithm uses this value.

Range: 0 to 100 scans
Default: 5

Table 11. Detect parameters for High (ICIS)  (Sheet 2 of 3)

Parameter Description
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Area scan window The number of allowable scans on each side of the peak apex. A 
zero value defines all scans (peak-start to peak-end) to be included 
in the area integration. 

Range: 0 to 100 scans
Default: 0 

RMS Specifies that the TraceFinder application calculate noise as RMS. 
By default, the application uses Peak To Peak for the noise 
calculation. RMS is automatically selected if you manually 
determine the noise region.

Table 11. Detect parameters for High (ICIS)  (Sheet 3 of 3)

Parameter Description
110 TraceFinder User Guide Thermo Scientific



 4 Using the Method Development Mode
Working with Master Methods
Spectrum

Use the Spectrum page to store a reference mass spectrum for a quan peak or compound.

Use the following procedures:

• To update confirming ion ratios

• To change the quantitation mass used for a quan peak

• To add ions together to get an accumulated signal

• To add a quan peak to an existing compound

• To add one or more confirming ions to an existing compound

• To zoom in the chromatogram or spectrum displays

To update confirming ion ratios

1. Click a peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the spectrum pane. 

2. Right-click the spectrum pane and choose Update confirming ion ratios with this 
spectrum from the shortcut menu.

To change the quantitation mass used for a quan peak

1. Click a peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the spectrum pane. 

2. In the spectrum pane, click the ion.

A red box around the ion’s relative intensity value indicates that the ion is selected.

3. Right-click and choose Set this mass as quan mass from the shortcut menu.

To add ions together to get an accumulated signal

1. Click an ion in the spectrum pane. 

A red box around the ion’s relative intensity value indicates that the ion is selected.

2. Right-click and choose Add this mass to existing quan mass range from the shortcut 
menu.

You can now update the ion ratios to adjust the confirming ion comparisons to the new 
summed quan peak signal.

To add a quan peak to an existing compound

1. Click the peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the spectrum pane. 
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2. In the spectrum pane, click the ion.

A red box around the ion’s relative intensity value indicates that the ion is selected.

3. Right-click and choose Set this mass as new quan peak from the shortcut menu. 

To add one or more confirming ions to an existing compound

1. Click the peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the spectrum pane. 

2. In the spectrum pane, click the ion.

A red box around the ion’s relative intensity value indicates that the ion is selected. 

3. Right-click and choose to Add this mass as new confirming ion from the shortcut 
menu.

To zoom in the chromatogram or spectrum displays

1. Drag your cursor to delineate a rectangle.

The display zooms into the specified rectangle.

2. To return to the original display, right-click and choose Reset Scaling from the shortcut 
menu.
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Spectrum page

Table 12. Spectrum shortcut menu functions 

Functions Description

Update confirming ion 
ratios with this spectrum

Updates the confirming ion ratios using the selected peak.

Set this mass as quan 
mass

Adds the quan mass of the selected ion to the quantitation mass 
used for the quan peak.

Add this mass to 
existing quan mass 
ranges

Adds the selected mass to your existing quan mass ranges. You can 
then update the ion ratios to adjust the confirming ion 
comparisons to the new summed quan peak signal.

Set this mass as a new 
quan peak

Adds a new quan peak to an existing compound.

Add a mass as new 
confirming ion

Adds one or more confirming ions to an existing compound.

Reset scaling Returns the chromatogram or spectrum display to its original 
size. 
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Ratios

Use the Ratios page to define the criteria for evaluating confirming or qualifying ions. the 
TraceFinder application detects compounds that have confirming ion values outside their 
acceptable window and flags them in Data Review mode and on reports. 

To specify ion ratio criteria

1. Enable or disable the use of the particular confirming ion. 

2. In the Target ratio box, select the theoretical ratio of the confirming ion's response to the 
quantification ion's response. 

3. In the Window type box, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

4. In the Window (+/-%) box, select the acceptable ion ratio range. 

5. In the Ion coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak 

In the following example:

• The target ratio is expected to be 61.02% and the window is Absolute 20%, so the 
acceptable window for this confirming ion is 41.02% to 81.02%. 

• If, instead, the window type was Relative, the plus or minus value would be 20% of 
61.02% (or 12.20%), so the acceptable window for this confirming ion would be 
48.82% to 73.22%. 
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Ratios page

Table 13. Ratios parameters

Parameter Description

Target ratio (%) The theoretical ratio of the confirming ion's response to the 
quantification ion's response. 

Window type The absolute or relative calculation approach for determining the 
acceptable ion ratio range. 

Window (+/-%) The acceptable ion ratio range.

Ion coelution (min) The maximum difference in retention time between a confirming 
ion peak and the quantification ion peak.
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Calibration

Use the Calibration page to set or edit the mathematical model used for preparing the initial 
calibration evaluation for one or more calibration standards. 

Each target compound can have its own initial calibration settings, independent of the other 
compounds. You can modify the calibration approach on this page or in Data Review mode 
when you view the results of an actual calibration batch. 

Calibration page

Table 14. Calibration parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Compound type Displays the compound type as an internal standard, an external 
standard, or a target compound.

Standard type Specifies Internal or External standards.

Response via The use of area or height.

Curve type Specifies Linear, Quadratic, or AverageRF curve types.

Origin The origin treatment as Ignore, Include, or Force. The Origin and 
Weighting columns are active only when you are using Linear or 
Quadratic curve types. 

Weighting Specifies the weighting as Equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.

Units The units to be displayed with the calculated values.

ISTD The internal standard (ISTD) for a target compound or surrogate 
if the standard type is set to Internal. If you set the standard type to 
External, this field is inactive.

Amount The amount of the internal standard for ISTD compounds. 
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Calibration Levels

On the Calibration levels page for a master method, you can define the standards for 
calibration. You can edit calibration levels and concentrations for master methods only. The 
contents of this page are read-only when you are editing a local method. 

To specify calibration levels and concentrations

1. Select the compound whose calibration levels and concentrations you want to define. 

2. In the Manage Calibration levels area, type a value for the first calibration level.

The application adds a new, empty calibration level row beneath the edited row.

3. Continue adding calibration levels.

When you finish adding calibration levels, you can specify the concentrations for each 
level for each compound.

4. To enter the concentrations to the table, do the following:

a. Select the first calibration level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

5. Repeat Step 4 for all calibration levels associated with the first compound.
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6. To specify the same concentration values for all compounds, select the value you want to 
copy, right-click and choose Copy down from the shortcut menu. 

Calibration levels page

Table 15. Calibration levels parameters 

Parameter Description

RT Retention time for the compound.
Compound The compound name.
cal1-caln User-defined calibration levels for the compound.
Manage Calibration 
levels

Defines calibration levels for the selected compound.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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QC Levels 

Use the QC levels page for a master method to define the standards for QC levels. You can 
edit QC levels for master methods only. The contents of this page are read-only when you are 
editing a local method. 

To specify QC levels and concentrations

1. Select the compound whose QC levels, percentage test values, and concentrations you 
want to define. 

2. In the QC levels area, type a name for the first QC level.

The application adds a new, empty QC level row beneath the edited row.

3. Type a value for the % Test.

The % Test is the acceptable difference (as a percentage) between the known amount and 
the calculated (measured) amount of each QC level.

4. Continue adding QC levels and values for percentage test.

When you finish adding QC levels, you can specify the concentrations for each level for 
each compound.

5. To enter the concentration values to the table, do the following:

a. Select the first QC level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.
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6. Repeat Step 5 for all QC levels associated with the first compound.

7. To specify the same concentration values for all compounds, select the value you want to 
copy, right-click and choose Copy down from the shortcut menu. 
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QC levels page

Table 16. QC levels parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

QC1-QCn User-defined quality control levels for the compound.

QC levels

Level User-defined quality control level names.

% Test A value for the acceptable difference (as a percentage) between the 
known amount and calculated (measured) amount of each QC 
level.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Editing the Flags Page

Use the Flags page to set limits and ranges so the TraceFinder application can review the data 
and results as an aid to final approval.

From the Flags page of the Master Method View, you can access these additional pages:

• Quan Flags

• Calibration Flags

• QC Check Flags

• Blank Flags

• ISTD Flags

• Solvent Blank Flags

• Surrogate Flags

• Matrix Spike Flags

• Lab Control Flags (GC only)
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Quan Flags

Use the Quan page to define levels of review for quantified results. Quantified results appear 
on printed and electronic reports. You can also define when a quantified value is reported 
instead of reporting less than a particular limit. 

Quan page

Table 17. Quan flag parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

LOD (Detection limit) Limit of detection. The lowest amount that can be detected. 
Usually derived from a method detection limit (mdl) study.

LOQ (Quantitation 
limit)

Limit of quantitation. The lowest amount that can be confidently 
and accurately quantitated. This is usually the lowest calibrator 
amount.

LOR (Reporting limit) Limit of reporting. Also called cutoff in some industries. This is 
the highest amount that can be reported, as determined by each 
laboratory’s standard operating practices.

ULOL (Linearity limit) Upper limit of linearity. This is usually the highest calibrator 
amount.

Carryover limit The highest amount of a substance that does not leave a residual 
amount in the instrument. If a substance has a carry over limit of 
5, amounts higher than 5 usually dirty the instrument and leave 
residue behind, tainting the following sample. A carryover limit of 
less than 5 does not leave any residual amounts of the substance.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Calibration Flags

Use the Calibration page to define acceptable criteria for initial calibration. The TraceFinder 
application makes the evaluation by comparing the initial calibration results for each 
compound found in the sample to the values defined on this page. 

On the Calibration report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

Calibration page

Table 18. Calibration flag parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

R^2 threshold The minimum correlation coefficient (r2) for an acceptable 
calibration (when in linear or quadratic mode). 

Max RSD (%) The maximum relative standard deviation (RSD) for an acceptable 
calibration (when in average RF mode). 

Max Amt Diff (%) The maximum deviation between the calculated and theoretical 
concentrations of the calibration curve data points (when in linear 
or quadratic mode). 

CV Test (%) Coefficient of Variation test. These values are added to the Data 
Review display.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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QC Check Flags

Use the QC Check page to review the calibration on an on-going basis. The TraceFinder 
application makes the evaluation by comparing the check standard results for each compound 
in the sample to the initial calibration using values defined on this page. 

On the Check Standard report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

For linear and quadratic modes, the maximum difference for the calculated concentration in 
the QC check sample versus the theoretical value is set on the QC levels page of the 
Compounds page. 

QC Check page

Table 19. QC Check flag parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Max RF Diff (%) The maximum deviation between the response factor (RF) of the 
QC check sample and the average response factor from the 
calibration (when in average RF mode). 

Min RF The minimum response factor for the QC check standard (when 
in average RF mode). 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Lab Control Flags (GC only)

Use the Lab Control page to view and edit QC values for lab control sample and lab control 
sample duplicate analyses. The TraceFinder application makes the evaluation by comparing 
the calculated concentration for each compound in the sample to the theoretical 
concentration and range defined on this page. 

You can prepare samples (typically known as clean matrices) as LCS or LCSD. These 
represent samples to which you have added known concentrations of target analytes. To define 
an LCS and its duplicate in a batch, select the appropriate sample type and a common sample 
ID. 

On the Lab Control report. the application flags the calculated values for spiked compounds 
that exceed these limits.

Lab Control page

Table 20. Lab Control flag parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Theo Conc Values for each lab control compound that represent the expected 
theoretical concentration of that compound in the sample. 

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that the application can determine by 
comparing the observed calculated concentration in the analysis to the 
expected concentration. Each LC/LCSD compound can have its own 
values for these fields, independent of other LC/LCSD compounds. 

Max recovery (%)

Max RPD Specify a maximum value for relative percent difference (RPD) 
between two spiked samples. 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention 
time column

Displays or hides the RT (retention time) column in the compound 
list.

Delete compound 
from method

Removes the selected compound from the current master method.
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Meth Val Flags (GC only)

Use the Meth Val page to view or edit QC values for method validation reporting. The 
application makes the evaluation by comparing the calculated concentration for each 
compound in the sample to the theoretical concentration and range defined on this page. 

You can use these parameters to evaluate the performance of your method. For this evaluation, 
prepare, analyze, and evaluate a number of samples (typically 4 to 10) to document method 
accuracy and precision as a comprehensive whole. To define a method validation sample in 
the batch, select the appropriate sample type. 

On the Method Validation report, the application flags the calculated values for method 
validation compounds that exceed these limits. 

Meth Val page

Table 21. Meth Val flag parameters

Parameter Description

RT Retention time for the compound.
Compound The compound name.
Theo Conc Values for each compound that represent the expected theoretical 

concentration of that compound in the sample. 
Min recovery (%) A range of the allowable minimum recovery percentage and the 

maximum recovery percentage that the application can determine 
by comparing the observed calculated concentration in the analysis 
to the expected concentration. Each method validation compound 
can have its own values for these fields, independent of other 
method validation compounds. 

Max recovery (%)

Max RSD (%) The maximum relative standard deviation of the set of observed 
concentrations for a component across the set of method 
validation samples. 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Breakdown Flags (GC only)

Use the Breakdown page to view and edit values used for the evaluation of breakdown and 
degradation reporting. The TraceFinder application makes the evaluation by calculating the 
ratio of breakdown compounds to the native compounds. 

To display the list of compounds in a group

• Click anywhere in the group row.

To select a group for breakdown calculation

• Select the Active check box in the group row.

You can select any group in the method for breakdown calculation, but the TraceFinder 
application calculates and reports only those that contain breakdown and native 
compounds.

Breakdown page

Table 22. Breakdown flag parameters

Parameter Description

Groups Lists all groups created on the Groups page. See “Editing the 
Groups Page (GC only)” on page 136.

Active Specifies which groups are used for breakdown analysis.

Max % breakdown The maximum allowable percentage of breakdown to native 
compounds. This value is calculated by summing the responses of 
the breakdown compounds and dividing them by the sum of the 
native compounds. 

On the Breakdown Report, the application flags the calculated 
values for breakdown and native compounds that exceed these 
limits. 

Compounds for group Lists all compounds in the selected group.
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Blank Flags

Use the Blank page to define acceptable levels of target compounds in blank samples. The 
application makes the evaluation by comparing the calculated concentration for each 
compound in the sample to the maximum concentration defined on this page. You can enter 
the maximum concentration as a percentage of a flag value or as a specified value. 

On the Blank report, the application flags the calculated values for internal standard 
compounds that exceed these limits. 

To specify the maximum concentration as a percentage

1. From the Method column list box, choose one of the following methods:
• % of LOD
• % of LOQ
• % of LOR

2. In the Percentage column, type a percentage value.

To specify the maximum concentration as an absolute value

1. From the Method column list box, select Concentration.

2. In the Max Conc column, type an absolute value.

To specify no maximum concentration

• From the Method column list box, select None. 

Blank page

Table 23.  Blank flag parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Method The evaluation process used for comparing the calculated 
concentration. You can specify no maximum, a specific 
concentration, or a percentage of the LOR, LOD, or LOQ. 
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ISTD Flags

Use the ISTD page to review response and retention time of internal standards (if available). 
The application makes the evaluation by comparing the area and retention time results for 
each internal standard compound in the sample to a specified range.

If all of your target compounds are set to external calibration mode or you have not identified 
any compounds as internal standards, this page does not show any values. 

ISTD page

Percentage The percentage of the LOR, LOD, or LOQ if you are using the 
percentage approach. 

Max Conc The maximum concentration if you are using an absolute value. 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.

Table 24. ISTD flag parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Min recovery (%) The minimum and maximum percent recoveries for the internal 
standards to define an acceptable range. For check standards, the 
TraceFinder application compares the response of each internal 
standard in each sample to a range around the average of the 
responses of that compound in all of the calibration standards. For all 
other samples, the application calculates the comparison range 
around the check standard responses if a check standard is available in 
the batch. If no check standard is available, the application tests 
against the initial calibration.

Max recovery (%)

Table 23.  Blank flag parameters  (Sheet 2 of 2)

Parameter Description
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Min RT (–min) The minimum and maximum drift (in minutes) for the internal 
standards to define an acceptable range. For check standards, the 
TraceFinder application compares the retention time of each internal 
standard in each sample to a range around the average of the retention 
times of that compound in all of the calibration standards. For all 
other samples, the application calculates the comparison range 
around the check standard retention times if a check standard is 
available in the batch. If no check standard is available, the 
application tests against the initial calibration.

Max RT (+min)

CV Test (%) Coefficient of Variation test.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention 
time column

Displays or hides the RT (retention time) column in the compound 
list.

Delete compound 
from method

Removes the selected compound from the current master method.

Table 24. ISTD flag parameters  (Sheet 2 of 2)

Parameter Description
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Solvent Blank Flags 

Use the Solvent Blank page to view or edit QC values for solvent reporting. The evaluation is 
made by comparing the calculated response for each compound in the sample to the 
maximum response defined on this page. 

On the Solvent Blank report, the application flags the calculated values for internal standard 
compounds that exceed these limits. 

Solvent Blank page

Table 25. Solvent Blank flag parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Method The evaluation process to use a response for the quan ion only 
(Quan Ion RT) or a summed response for the quan ion and any 
confirming ions (All Ion RT). You can deactivate the solvent blank 
test by selecting None. 

Upper Limit Specifies an upper limit for each compound in the sample if an 
evaluation process is selected. These values are not concentrations; 
they are raw response values.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Surrogate Flags

Use the Surrogates page to view or edit QC values for surrogate reporting. The application 
makes the evaluation by comparing the calculated concentration for each surrogate 
compound in the sample to the range defined on this page. 

On the Surrogate report, the application flags the calculated values for internal standard 
compounds that exceed these limits. 

Surrogate page

Table 26. Surrogate flag parameters

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Theo Conc Values for each surrogate compound that represent the expected 
theoretical concentration of that compound in the sample. You 
can apply or not apply the dilution factor for a sample to the 
calculated surrogate concentrations using the Correct surrogates 
option on the Reports page. See “Specifying Report Options” on 
page 142.

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that can be determined by 
comparing the observed calculated concentration in the analysis to 
the expected concentration. Each surrogate can have its own values 
for these fields, independent of other surrogates. 

Max recovery (%)

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Matrix Spike Flags

Use the Matrix Spike page to view or edit QC values for matrix spike and matrix spike 
duplicate analyses. The application makes the evaluation by comparing the calculated 
concentration for each compound in the sample (after subtracting the original sample value) 
to the theoretical concentration and range defined on this page. 

To evaluate matrix spike (MS) or matrix spike duplicate (MSD) compounds, prepare samples 
as MS or MSD. These represent samples to which you have added known concentrations of 
target analytes. To define a sample, its MS, and its MSD in the batch, select the appropriate 
Sample Type and a Sample ID. 

On the MS/MSD report, the application flags the calculated values for spiked compounds 
that exceed these limits. 

Matrix Spike page

Note  Sample IDs must be unique. Duplicating Sample IDs can cause incorrect samples to 
be included in reports.

Table 27. Matrix Spike flag parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time for the compound.

Compound The compound name.

Theo Conc Values for each surrogate compound that represent the expected 
theoretical concentration of that compound in the sample. You 
can apply or not apply the dilution factor for a sample to the 
calculated surrogate concentrations using the Method Options.

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that can be determined by 
comparing the observed calculated concentration in the analysis to 
the expected concentration. Each surrogate can have its own values 
for these fields, independent of other surrogates. 

Max recovery (%)

Max RPD Specify a maximum value for relative percent difference (RPD) 
between two spiked samples. 
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Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT (retention time) column in the 
compound list.

Delete compound from 
method

Removes the selected compound from the current master method.

Table 27. Matrix Spike flag parameters  (Sheet 2 of 2)

Parameter Description
Thermo Scientific TraceFinder User Guide 135



4 Using the Method Development Mode
Working with Master Methods
Editing the Groups Page (GC only)

Use the Groups page of the Master Method View to organize compounds into functional or 
logical groups. You can use these groups for creating a subset of target compounds for 
quantitative processing or a list of non-quantitative compounds for breakdown processing.  
See “Groups page” on page 137.

For quantitative processing, the TraceFinder application processes all compounds in the 
method and stores the complete result set, but only those in the selected group are visible in 
Data Review mode. Limiting the displayed compounds to those in the selected group can be 
useful when working with a master method containing a large list of compounds, only some 
of which are required for analysis in certain samples. In that case, the application requires only 
a single method and can reduce the results. To display only those compounds to be used in 
quantitative processing, select Quan compounds from the Show list box. 

For non-quantitative processing, you can select the Breakdown and Native compounds that 
the TraceFinder application uses for breakdown reporting. To view only those compounds to 
be used in non-quantitative processing, select Non-quan compounds from the Show list box. 

You can create as many quantitative and non-quantitative groups as you want and the same 
compound can be in multiple groups. 

To create a group

1. From the Show list box, select the type of compounds you want to view.

2. At the bottom of the Groups area, click Add Group.

The Add a new Group dialog box opens.

3. Type a name for the new group and click OK.

The new group appears in the Groups area.

4. Drag a compound from the Compounds area onto a group name (as if you were moving 
files into a folder).

5. To remove all the compounds from a group, rename the group, or delete it, right-click the 
group name and choose from the shortcut menu.
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6. To remove a single compound, click the compound name in the group, right-click. and 
choose Remove from group from the shortcut menu.

Groups page

Table 28. Groups parameters 

Parameter Description

Compounds Lists all available compounds.

Groups Lists all available groups.

Add Group Opens the Add a new Group dialog box where you can create a 
new group.

Shortcut menu

Empty group Removes all compounds from the selected group.

Rename group Changes the name of the selected group.

Delete group Removes the selected group and all the compounds in it.

Remove from group Removes the selected compound from its group.
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Editing the Reports Page

Use the Reports and Custom Reports pages to specify how you want to save or print your 
reports. 

For the Quantitation Report type, you can modify quan report, user interface, quan flag, and 
surrogate correction options in the Report Options pane. 

This section includes instructions for the following tasks:

• Specifying Report Formats

• Specifying Report Options

Specifying Report Formats

For each standard report you generate, you can create a hardcopy printout, a PDF (.pdf ) file, 
or an XML (.xml) file. In addition to the report type, you can specify a report title for each of 
your reports. The default report title is the report name.

For each custom report you generate, you can create a hardcopy printout or an XLS (.xlsm) 
file. You cannot specify a report title for a custom report. 

Use the following procedures:

• To specify standard reports types and output formats

• To view an example standard report

• To specify custom report types and output formats

To specify standard reports types and output formats

1. Click the Reports tab.

The Reports page displays the Report Name, Report Title, and the options to create a 
hardcopy, a PDF file, or an XML file. See “Reports page” on page 140.

2. To edit the Report Title, double-click the name and type your new name.

The TraceFinder application uses this name for all reports that use this master method. 
You cannot edit the Report Title from other report views.

3. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

4. To duplicate the output type for all reports, click the cell to select it, then right-click and 
choose Copy down from the shortcut menu.
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All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell.

By default, all report types are cleared.

To view an example standard report

1. Click the magnifying button, , to view an example PDF of the report type.

The right pane of the view displays an example PDF report with typical PDF viewer 
controls.

2. To minimize the PDF viewer, click the minimize icon, .

To specify custom report types and output formats

1. Click the Custom Reports tab.

The Custom Reports page lists all the reports that are saved in the following folder:

..\Thermo\TraceFinder\Templates\Reports

The Custom Reports page displays the Report Name and the options to create a hardcopy 
printout or XLS file. See “Custom Reports page” on page 141.

2. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

3. To duplicate the output type for all reports, right-click the cell and choose Copy down 
from the shortcut menu. 

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell.
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Reports page

Table 29. Reports parameters

Parameter Description

Example Displays a sample of the report type.
Report Name The name of a report. 
Report Title The user-defined title to be used on a report. 
Print Reports to be sent to the printer. 
Create PDF Reports to be saved as PDF files. 
Create XML Reports to be exported in XML format. 
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Custom Reports page

Table 30. Custom Reports parameters

Parameter Description

Report Name The name of a report. 

Print Reports to be sent to the printer. 

Create XLS Reports to be exported in Excel spreadsheet (.xlsm) format. 
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Specifying Report Options

Use the report options to choose display features for standard report types.

Use the following procedures:

• To specify quantitation report options

• To specify user interface options

• To specify quantitation flag options

• To correct surrogates

To specify quantitation report options

1. To report the calculated concentration at all times or only when the quantified value 
exceeds LOD, LOQ, or LOR, choose the appropriate value from the Report 
concentration list box.

These limits are defined in “Quan Flags” on page 123. 

2. To select the number of decimal places to report for calculated concentrations, set the 
value in the Decimal places to be reported box.

3. To include a chromatogram of the sample in the report, select the Show chromatogram 
on Quantitation Report check box.

4. To display only valid compounds, select the Display valid compounds only check box.

To specify user interface options

1. To shade a compound row on any of the reports if a value fails one of the criteria used for 
evaluation, select the Shade row when sample is outside of evaluation criteria check 
box.
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2. To separate the ion overlay pane from the confirming ion plots, select the Separate ion 
overlay display check box.

3. To use an alternate format for the Calibration Report designed to print more concisely 
and limit the report to a maximum of 7 calibration standards, select the Use alternate 
calibration report format check box.

4. To display flags and a legend on high density reports, select the Display Quan flags and 
legend check box.

To specify quantitation flag options

• Select the values you want to display in the report.

Values are above or below the limits defined on the Quan page. 

These flags appear on a variety of reports and are defined in the Report options 
parameters table.

To correct surrogates

• To apply the conversion factor (specified in the sample row in the batch) to the sample’s 
calculated concentrations for surrogates as the conversion factor is applied to target 
compounds, select the Correct surrogates check box. 
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Report options

Table 31. Report options parameters  (Sheet 1 of 2)

Parameter Description

Quan Report Options

Report concentration Report the concentration at all times or only when the quantified 
value exceeds either the limit of detection (LOD), the limit of 
quantitation (LOQ), or the limit of reporting (LOR). Report 
concentration: Always, >LOD, >LOQ, or >LOR.

Decimal places to be 
reported

Number of decimal places to be included in the report. Maximum 
value is 6.

Show chromatogram 
on Quantitation 
Report

Displays a chromatogram (TIC trace) of the sample on the 
quantitation report. 

Display valid 
compounds only

Prints only the positive compounds in a sample. If a compound is 
valid within a sample and is above the specified Quan Flag 
Options limits, the application reports the compound.

User Interface Options

Shade row when 
sample is outside of 
evaluation criteria

Shades a compound row on any of the reports if a value fails one of 
the criteria used for evaluation. 

Separate ion overlay 
display

Separates the ion overlay pane from the confirming ion plots in 
data review. 

Use alternate 
calibration report 
format

Uses an alternate format for the Calibration Report that is 
designed to print more concisely (this report is limited to a 
maximum of 7 calibration standards). 

Display Quan flags and 
legend

Displays manual flags, confirming manual flags, quan flags, and a 
legend on high density reports.

Quan Flag Options
Values that are above or below limits defined on the Quan flags 
page. These flags appear on a variety of reports. 
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Flag values below LOD Flags values below the limit of detection (LOD).

Flag values below LOQ Flags values below the limit of quantitation (LOQ).

Flag values above LOR Flags values above the limit of reporting (LOR).

Flag values above 
ULOL

Flags values above the upper limit of linearity (ULOL).

Flag values above 
Carryover

Flags values above the carryover limit.

Flag values between 
LOD and LOQ

Flags values between the limit of detection and the limit of 
quantitation.

Surrogate Correction 
Option

Correct surrogates Applies the conversion factor (specified in the sample row in the 
batch) to the sample’s calculated concentrations for surrogates as 
the conversion factor is applied to target compounds. For example, 
if you added surrogates to the sample as part of sample preparation 
and you require a dilution for analysis, the application dilutes the 
surrogates and target compounds and it can apply a dilution 
correction to correct for this dilution. However, if you added 
surrogates after a dilution has occurred, then you can leave the 
option cleared, so that while the target compounds are corrected 
for the dilution, the surrogates are reported ‘as is.’ 

Table 31. Report options parameters  (Sheet 2 of 2)

Parameter Description
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5

Using the Acquisition Mode 

This chapter describes the tasks associated with the TraceFinder Acquisition mode.

When you plan to work with multiple samples or use similarly designed batches, use the 
Acquisition mode to reduce the amount of data you must enter. 

Because the nature and types of batches are often similar (in some cases specified by laboratory 
standard practices), a user in the role of Lab Director or Supervisor can define a batch 
template that supplies the basic structure of a batch. 

If you have a master method, you can create a batch and run the samples. Batches represent 
one or more samples that are to be acquired, processed, reviewed, and reported as a set. After 
you create a batch of samples, you can submit the batch and review the results in the Data 
Review mode or you can go directly to viewing and printing reports. 

You can also set up a calibration batch with known concentrations of the target compounds to 
compare the sample against the calibration in future batches. 

Contents

• Working with Batches

• Real-time Display

• Sample Types
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Working with Batches 
This section includes instructions for the following tasks:

• Opening and Navigating the Acquisition Mode

• Creating Batches

Opening and Navigating the Acquisition Mode

To open the Acquisition mode, click Acquisition in the navigation pane or from the 
dashboard.

The TraceFinder application does not use the navigation pane in the Acquisition mode in the 
same way it uses the navigation pane in other modes. In the Acquisition mode, this pane 
keeps track of your progress as you move through the views to create and submit a batch or a 
batch template. 

Figure 2. Task pane when you enter Acquisition mode 
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The status of each view in the Acquisition mode shows you which tasks are completed and 
which tasks are not.

As you complete each view, the task panes display the parameters you specified for your batch. 

Figure 3. Example task pane when you have completed Acquisition mode 

Completed view

Incomplete required view

Current view

Unvisited view
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Creating Batches

These are the major steps you use in Acquisition mode to create a batch:

• Selecting a Batch

• Selecting a Method

• Defining the Sample List

• Selecting and Reviewing Reports

• Submitting the Batch

Workflows

Depending on how you create your batch, you use different views in the Acquisition mode. 
The following workflows show the Acquisition views required for each batch creation 
approach. Depending on the approach you use to create a batch, you will use one of these 
specific workflows. 

Creating an original batch

To create an original batch, start with the instructions “To start a new batch” on 
page 152.

Batch

Finish

Reports

Samples

Method
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Acquiring a previously saved (.tbr) batch

To acquire a previously saved batch, start with the instructions “To select a 
ready-to-acquire batch” on page 153.

Editing and processing a previously acquired batch

To process a previously acquired batch, start with the instructions “To select a previously 
acquired batch” on page 154.

Creating a batch template

To create batch template, start with the instructions “To create a batch template” on 
page 155. 

Batch

Finish Samples

Batch

Finish

Samples

Batch

Finish

Reports

Samples

Method

This workflow is available only to users in 
the role of Lab Director or Supervisor. 
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Selecting a Batch

In Batch/Template Selection view of the Acquisition mode, you can choose to create a new 
batch in any of your current projects/subprojects. 

Use the following procedures:

• To start a new batch

• To select a template for the new batch

• To select a ready-to-acquire batch

• To select a previously acquired batch

• To create a batch template

To start a new batch

1. Click the New batch tab.

From this page, you can create a new batch.

2. Type a name for the new batch in the Batch name box.

3. Select the project and subproject where you want to create the new batch.

4. To continue to the next view, click Next.

The Method selection view of the Acquisition mode opens. See “Selecting a Method” on 
page 156.

Tip  If the Next button is not enabled, the batch name you gave already exists. Type a 
new name or add a numerical character to the end of the name. The Next button is 
enabled as soon as you change the batch name to a unique name.
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To select a template for the new batch

1. Click the New batch tab.

From this page, you can create a new batch using a batch template.

2. Select the template and method combination you want to use.

The system creates a Batch name with the selected template name and the date/time 
stamp. The default project and subproject associated with this template are selected, but 
you can change them.

3. (Optional) Select a different project and subproject where you want to create the new 
batch.

4. To continue to the next view, click Next.

The Sample definition view of the Acquisition mode opens. See “Defining the Sample 
List” on page 157.

To select a ready-to-acquire batch

1. Click the Ready to acquire tab.

All your unacquired, saved batches are displayed with the file extension .tbr (to be run). 
All .tbr batches are stored in the following folder:

..\Tracefinder\Projects\projectname\subprojectname\Batches

2. Select the batch you want to acquire.

3. To continue to the next view, click Next.

The Finish view of the Acquisition mode opens. From the Finish view, you can save the 
batch, submit the batch for acquisition, or go to the Sample definition view to edit the 
samples list for this batch.
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4. Do one of the following:

• To prepare the batch for acquisition, click Acquire.

For detailed instructions, see “Submitting the Batch” on page 168. 

–Or–

• To edit the samples list, click Previous.

For detailed instructions on editing a samples list, see “Defining the Sample List” on 
page 157.

–Or–

• To save the batch to the Ready to acquire list, click Save.

The TraceFinder application saves your batch as a to-be-run (.tbr) file, closes the 
Acquisition mode, and returns you to the application dashboard.

Batches are saved to the following folder with the file extension .tbr:

..\TraceFinder\Projects\projectname\subprojectname\Batches

To select a previously acquired batch

1. Click the Acquired batches tab.

From this page, you can resubmit a previously acquired batch, edit the batch, or save it to 
be acquired later.

2. In the Project pane, select a project name.

All subprojects included in the selected project are displayed in the Subproject pane.

3. In the Subproject pane, select a subproject name.

All previously acquired batches included in the selected subproject are displayed in the 
Batch pane.

4. In the Batch pane, select the batch you want to reacquire.

5. To continue to the next view, click Next.

The Sample definition view of the Acquisition mode opens. See “Defining the Sample 
List” on page 157.
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To create a batch template

1. Click the Templates tab.

From this page, you can create a new batch template. 

2. In the Template name box, type a name for your new batch template.

3. Select a project name in the Project pane.

The Subproject pane displays all subprojects included in the selected project.

4. Select a subproject name in the Subproject pane.

5. To continue to the next view, click Next.

The Method selection view of the Acquisition mode opens. See “Selecting a Method” on 
page 156.

Note  This page is available only to users in the role of Lab Director or Supervisor. 
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Selecting a Method

On the Method selection view of the Acquisition mode, select a method to use for the batch 
or batch template you are creating.

To specify a method

1. Select a method from the Method list.

The Compounds pane displays the compounds in the method. You cannot edit the 
compounds list from the Acquisition mode.

2. On the Method selection view, click Next. 

The Sample definition view opens. See “Defining the Sample List” on page 157.
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Defining the Sample List

On the Sample definition view of the Acquisition mode, you can create a list of samples for 
the batch. You can add samples, insert samples, import a sample list, or remove samples from 
the list. 

As you enter sample values, you can use the Copy down and Fill down commands to enter 
column values. For detailed instructions on using Copy down and Fill down to enter column 
values, see Appendix B, “Using Copy Down and Fill Down.” 

Use the following procedures:

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

When you have finished defining the list of samples, click Next.

• If you are creating a batch from scratch, creating a batch from a template, or editing a 
batch template, the Report selection view opens. See “Selecting and Reviewing 
Reports” on page 163.

• If you are editing a previously acquired a batch or a .tbr batch, the Finish selection 
view opens. See “Submitting the Batch” on page 168.

To add samples to the list

1. Select the number of sample rows to add and click Add.

2. Type a file name in the Filename column for each sample. 

3. Select a sample type from the Sample type list box for each sample. 

For a detailed description of sample types, see “Sample Types” on page 179.

Tip  To add a single sample row, you can use the Add button or you can right-click 
and choose Add sample from the shortcut menu.

Available sample types

LC and GC

Matrix Blank Chk Std MS Unknown

Cal Std MDL MSD Solvent

GC only

LCS LCSD Meth Val Breakdown
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4. For each Cal Std or Chk Std sample, select a level from the Sample level list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample level list, ask a user with Supervisor or Lab Director permissions to edit the 
method and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

5. Type a vial position in the Vial position column for each sample. 

6. Type a volume in the Injection volume column for each sample. 

7. (Optional) Type or edit the values for the remaining columns.

To insert samples into the list

1. Select the sample above which you want to insert new, unknown samples.

You cannot use the Insert command to create the first sample row.

2. Select the number of samples to insert and click Insert.

The application inserts the unknown samples above the selected sample.

3. Type a file name in the Filename column for each sample. 

4. Select a sample type from the Sample type list box for each sample. 

For a detailed description of sample types, see “Sample Types” on page 179.

Tip  Use the Fill down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the samples list, the 
Status and Filename columns stay fixed while the other columns scroll right and left. 

Available sample types
LC and GC

Matrix Blank Chk Std MS Unknown
Cal Std MDL MSD Solvent
GC only

LCS LCSD Meth Val Breakdown

Inserted 
samples
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5. For each Cal Std or Chk Std sample, select a level from the Sample level list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample level list, ask a user with Supervisor or Lab Director permissions to edit the 
method and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

6. Type a vial position in the Vial position column for each sample. 

7. Type a volume in the Injection volume column for each sample. 

8. (Optional) Type or edit the values for the remaining columns.

To import samples into the list

1. Click Import.

The Sample import tool dialog box opens.

From this dialog box, you can import a sample list from a .csv file or .xml file.

2. Click Browse and select a .csv or .xml file that contains the sample definitions you want 
to import.

3. From the Imported samples will be list, select either appended to the end of the list or 
inserted at the selected row.

4. Click Import.

The Sample import tool dialog box closes, and the specified samples are added to the 
Samples list. 

Tip  Use the Fill down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the samples list, the 
Status and Filename columns stay fixed while the other columns scroll right and left. 

Note  The .csv or .xml file format must match the TraceFinder file format. 
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5. For each Cal Std or Chk Std sample, select a level from the Sample level list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample level list, ask a user with Supervisor or Lab Director permissions to edit the 
method and specify the levels. 

For detailed instructions on defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

6. Type a vial position in the Vial position column for each sample. 

7. Type a volume in the Injection volume column for each sample. 

8. (Optional) Enter or edit the values for the remaining columns.

To remove samples from the list

1. Select the samples you want to remove.

2. Right-click and choose Remove selected samples from the shortcut menu. 

Tip  Use the Fill down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the samples list, the 
Status and Filename columns stay fixed while the other columns scroll right and left. 

Tip  Use the CTRL or SHIFT keys to select multiple samples.
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Sample definition view
  

Table 32. Sample definition view parameters  (Sheet 1 of 2)

Parameter Definition 

Add Adds the specified number of empty rows to the sample grid.

Insert Inserts the specified number of empty rows above the selected 
row.

Import Opens the Sample import tool where you can import samples 
defined in a .csv file or an .xml file.

Previous Returns you to the previous Acquisition mode view.

Cancel Confirms that you want to exit the Acquisition mode. When you 
cancel out of the Acquisition mode, your edits are not saved.

Next Takes you to the next Acquisition mode view.

Shortcut menu

Add sample Adds a single empty row to the sample grid.

Insert sample Inserts a single empty row to the sample grid above the selected 
row.

Insert copy sample Copies the currently selected row and inserts a copy above the 
row.

Remove selected samples Removes selected samples from the sample grid.
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Copy down Copies the value in the selected row to all rows below it. For 
detailed instructions about using the Copy down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Fill down Enters sequential values in the column starting with the value in 
the selected row and ending with the last row in the column. For 
detailed instructions about using the Fill down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Status color codes  Sample is acquired but not processed.

 Sample is acquired and processed.

 Sample is not acquired.

Table 32. Sample definition view parameters  (Sheet 2 of 2)

Parameter Definition 
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Selecting and Reviewing Reports

On the Report selection view, you can specify the types of reports you want to create. For a 
complete list of report types and examples of output files, see Appendix A, “Reports.” 

For each standard report you generate, you can create a hardcopy printout, a PDF (.pdf ) file, 
or an XML (.xml) file. In addition to the report type, you can specify a report title for each of 
your reports. 

For each custom report you generate, you can create a hardcopy printout or an XLS (.xlsm) 
file. You cannot specify a report title for a custom report. 

When you have finished specifying your report options, click Next. to go to the Finish view. 
See “Submitting the Batch” on page 168.

The resulting output files for your reports are written to the following folder:

..\projectname\subprojectname\Batches\batchname\Reports

Use the following procedures:

• To edit a standard report title

• To preview a standard report

• To specify a standard report in print, PDF, or XML format

• To specify a custom report in print or XLS format

• To export standard or custom reports to a specific folder

To edit a standard report title

1. Click the Reports tab.

The Reports page lists all the available standard reports. The Reports page displays the 
report name, report title, and the options to create printed, PDF, or XML output. See 
“Standard Reports page” on page 166.

2. Click the Report Title column and edit the default title.

The default report title is the same as the report name. The TraceFinder application lists 
reports in alphabetical order by Report Title. When you change a report title and refresh 
the view, it rearranges the reports accordingly.

To preview a standard report 

1. Click the Reports tab.

The Reports page lists all the available standard reports. The Reports page displays the 
report name, report title, and the options to create printed, PDF, or XML output. See 
“Standard Reports page” on page 166.
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2. Click the magnifying icon, , to view an example of the report type as a PDF file.

The right pane of the view displays an example PDF report with typical PDF viewer 
controls.

3. To minimize the PDF viewer, click the minimize icon, .

To specify a standard report in print, PDF, or XML format

1. Click the Reports tab.

The Reports page lists all the available standard reports. The Reports page displays the 
report name, report title, and the options to create printed, PDF, or XML output. See 
“Standard Reports page” on page 166.

2. For each type of report you want to create, select the check box in the Print, Create PDF, 
or Create XML columns.

3. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell.

To specify a custom report in print or XLS format

1. Click the Custom Reports tab.

The Custom Reports page lists all the reports that are saved in the following folder:

..\Thermo\TraceFinder\Templates\Reports 

The Custom Reports page displays the Report Name and the options to create printed or 
XLS output. See “Custom Reports page” on page 167.

2. For each report you want to create, select the check box in the Print or Create XLS 
columns.

3. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell.
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To export standard or custom reports to a specific folder

1. Select the Export Results check box at the bottom of the view.

The Browse For Folder dialog box opens.

2. Locate and select the folder where you want to save the reports.

3. To create a new reports folder within the selected folder, click Make New Folder and type 
the new folder name.

4. Click OK.

All standard and custom reports are written to the specified folder in addition to the 
batch Reports folder. 
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Standard Reports page

Table 33. Standard reports parameters  (Sheet 1 of 2)

Parameter Description

Example Displays an example PDF for the report type. This example 
provides a model of the report type only; it does not reflect your 
data.

Report Name The name of a report. 

Report Title User-editable title to be used on a report. 

Print Reports to be sent to the printer. 

Create PDF Reports to be saved as PDF files. 
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Custom Reports page

Create XML Reports to be exported in XML format. 

Shortcut menu:
Copy Down

Copies the selected or cleared state to all subsequent reports in the 
column. 

Table 34. Custom Reports parameters

Parameter Description

Report Name The name of a report. 

Print Reports to be sent to the printer. 

Create XLS Reports to be exported in Excel Macro-Enabled Workbook file 
(.xlsm) format. 

Shortcut menu:
Copy Down

Copies the selected or cleared state to all subsequent reports in the 
column.

Table 33. Standard reports parameters  (Sheet 2 of 2)

Parameter Description
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Submitting the Batch

On the Finish view of the Acquisition mode, you can specify a startup method, a shutdown 
method, or a calibration batch. You can save the batch to be acquired later or you can choose 
to acquire data, process data, or create reports. See “Finish view” on page 174.

Use the following procedures:

• To specify startup or shutdown methods

• To specify a calibration batch

• To specify device states

• To save a batch for later acquisition

• To start an acquisition

• To view the output files

To specify startup or shutdown methods

1. (Optional) Select a method from the System Startup Method list.

The TraceFinder application runs this method before running the batch. No autosampler 
injection takes place. This feature is not available for all instruments.

2. (Optional) Select a method from the System Shutdown Method list.

The TraceFinder application runs this method after running the batch. No autosampler 
injection takes place. This feature is not available for all instruments.

Note  If you are working with a batch template, the only available function is Save.
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To specify a calibration batch

1. In the Calibration area, select a calibration (.calx) file from the list.

2. Do one of the following:

• To use the selected calibration file to process the current data, select the Use 
calibration option.

The method must be the same for the calibration batch and the current batch. 

–Or–

• To add calibration data from the current batch to the selected calibration file, select 
the Extend calibration option. 
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To specify device states

• In the System Status area, select the name of the device, right-click, and then choose a 
device state from the shortcut menu.

Table 35. Instrument states

Instrument state Description

Turn Device On Keeps the system in the On state when the current run is 
completed, so you can begin another run without waiting. All 
power and flows are maintained at operational levels. 

Default: On

Turn Device Standby Keeps the system in the Standby state when the current run is 
completed, so you can begin another run with only a short 
delay between runs. 

Some devices do not have a Standby feature. For devices with 
this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on in approximately 15 minutes. Depending on the 
instrument, this state turns gas and liquid flows off but 
maintains heaters and other subsystems in an On state so that 
there is no warm-up time required when you change from 
Standby to On. 

Turn Device Off Keeps the system in the Off state when the current run is 
completed. The Off state indicates that all power to the 
instrument, which can be controlled by the TraceFinder 
application, is turned off. This includes power to all heaters 
and subassemblies, but in some cases not all subassemblies. 

Some devices do not have an Off feature. For devices that do 
have this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on. When several runs are queued, the application uses the 
system power scheme of the last submitted run. 
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To save a batch for later acquisition

• From the Finish view, click Save.

The TraceFinder application saves your batch as a to-be-run (.tbr) file, closes the 
Acquisition mode, and returns you to the application dashboard.

To start an acquisition

1. Click Acquire.

The Submit Options dialog box opens. See “Submit Options” on page 172.

2. Select the tasks you want to perform: acquire data, process data, or create reports.

3. Select the Use check box for the device that you want to use for this acquisition.

4. (Optional) Select the Start Device check box to indicate the device that is used to initiate 
the communication with the other instruments. 

This is usually the autosampler.

5. (Optional) Select the Start when ready check box to tell the application to start all 
instruments together when they are all ready. 

When this is cleared, individual instruments can start at different times and then have to 
wait for the last instrument to be ready.

6. (Optional) Select the Priority check box to move this batch to the top of the queue (after 
any currently acquiring batch).

7. (Optional) Click Cancel to exit the Acquisition mode without performing any tasks.

8. To start the selected processes, click OK.

The selected processes begin, and the TraceFinder application returns you to the 
dashboard and shows the real-time display at the bottom of the dashboard.

The real-time display is visible from the dashboard and all modes. You can begin another 
batch in the Acquisition mode while you watch the real-time display of the currently 
acquiring batch.
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Figure 4. Submit Options

Table 36. Submit Options parameters  (Sheet 1 of 2)

Parameter Description 

User name Name of the current user.

Acquire data Submits the current batch to acquisition.

Process data Processes the data for the current batch.

Create reports Creates reports for the current batch.

Acquisition pane

Device Name Lists all configured instruments. 

If the instrument you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then 
reopen the TraceFinder application. You cannot configure an 
instrument while the TraceFinder application is running.

Use Specifies the instruments used for this acquisition.

Start Device Specifies the instrument that is used to initiate the 
communication with the other instruments. This is usually 
the autosampler.
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To view the output files

• The TraceFinder application writes saved batches to the Batches folder with the file 
extension .tbr (to be run):

..\TraceFinder\Projects\projectname\subprojectname\Batches

• For each acquired sample, the application writes an RSX file to the Data folder:

..\projectname\subprojectname\Batches\batchname\Data

• The application saves method information to the Methods folder:

..\projectname\subprojectname\Batches\batchname\Methods\methodname

• The application writes the reports to the Reports folder:

..\projectname\subprojectname\Batches\batchname\Reports

Start when ready Tells the TraceFinder application to start the specified device 
when all the instruments are ready to acquire data. When this 
is cleared, individual instruments can start at different times 
and then have to wait for the last instrument to be ready.

Priority When there are batches in the queue, moves this batch to the 
top of the queue, after the currently acquiring batch.

Hide/Show Details Collapses or expands the acquisition details of the Submit 
Options dialog box.

OK Begins the selected processes.

Cancel Closes the Submit Options dialog box without submitting any 
tasks.

Table 36. Submit Options parameters  (Sheet 2 of 2)

Parameter Description 
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Finish view

Table 37. Finish view parameters  (Sheet 1 of 2)

Parameter Description 

System Status The System Status pane displays the following: 
• The devices used for the acquisition
• The project, subproject, and name of the batch
• The number of samples in the batch
• The number of standard and custom reports to be printed 

and saved as PDF, XML, or XLS files
• The local method and instrument method used for the 

batch
• The number of compounds in the method

System Startup 
Method

The instrument method that runs before the batch. No 
autosampler injection takes place. This feature is not available 
for all instruments.

System Shutdown 
Method

The instrument method that runs after the batch. No 
autosampler injection takes place. This feature is not available 
for all instruments.
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Calibration • Use calibration: Uses the selected calibration file to 
process the current data.

• Extend calibration: Adds calibration data from the current 
batch to the selected calibration file.

Save Saves the current batch as a to-be-run (.tbr) file.

Acquire Opens the Submit Options dialog box where you can specify 
options for acquisition, processing, and generating reports.

Table 37. Finish view parameters  (Sheet 2 of 2)

Parameter Description 
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Real-time Display
You can access the real-time display from the dashboard and from any mode in the 
TraceFinder application.

To access the real-time display from the dashboard

• Click Real Time Status.

The real-time status displays at the bottom of the dashboard.

To access the real-time display from all modes

• Click Real time status.

The real-time status displays at the bottom of the current view.

The real-time status display has four additional pages of information:

• Acquisition page

• Instrument page

• Devices page

• Queues page

Figure 5. Acquisition page
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Figure 6. Instrument page

Figure 7. Devices page
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Figure 8. Queues page
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Sample Types
The TraceFinder application uses the following sample types in all sample definitions and 
reports. 

To view example standard reports specific to a sample type, see Appendix A, “Reports.” 

Table 38.  Sample type definitions  

Sample type Definition

Matrix Blank Contains no target compounds but might contain an ISTD when 
you use the internal standard quantitative analysis technique. By 
analyzing a blank sample, you can confirm that there are no 
residual compounds in the solvent system that can cause erroneous 
results.

Cal Std (Calibration standard) Contains known amounts of all target 
compounds. The purpose of a standard is to measure the response 
of the instrument to the target compounds so that the processing 
software can generate a calibration curve for each compound.

Chk Std (Check standard) Contains a known amount of one or more 
specific target compounds. The application places check standard 
samples in the sequence so that it can test quantitative analysis 
results for quality assurance purposes. After the application 
analyzes the check standard sample, it compares the measured 
quantity with the expected value and an acceptability range. The 
quantitative analysis of a check standard sample is classified as 
passed if the difference between the observed and expected 
quantities is within the user-defined tolerance. A check standard 
sample is classified as failed if the difference between the observed 
and expected quantities is outside the user-defined tolerance.

LCS (GC only) Lab control sample.

LCSD (GC only) Lab control sample duplicate.

MDL Method detection limits sample.

Meth Val (GC only) Method validation sample.

MS Matrix spike sample.

MSD Matrix spike duplicate sample.

Breakdown (GC only) Used in gas chromatography for breakdown methods. 

Solvent Contains only solvent.
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Using the Data Review Mode 

This chapter includes instructions for using the features of the Data Review mode.

In the Data Review mode, you can review batches, batch data, reports, and local methods.

To access the Data Review mode

• Click Data Review from the dashboard or the navigation pane.

The Data Review navigation pane opens.

Contents

• Working in Batch View

• Working in Data Review

• Working in Report View

• Working in the Local Method View
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Working in Batch View
In the Batch view, you can manually create and edit a new batch or open and edit a previously 
saved batch. When you submit a batch, you can acquire, process, or create reports for the 
submitted samples.

This section contains information about the following:

• Creating a New Batch

• Editing a Batch

• Submitting a Batch

Creating a New Batch

In Batch view, you can create a new batch.

Use the following procedures:

• To create a batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To copy a sample

• To re-inject a sample

• To edit sample values

• To rearrange the columns

• To remove samples from the list
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To create a batch

1. Choose New batch in the Batch View task pane or choose File > New > Batch.

A new, unnamed batch opens with one Unknown sample. You must choose a master 
method before you can save your new batch.

2. Choose a master method from the Method list. 

3. Choose File > Save > Batch.

The Batch Save dialog box opens.

4. Select a project and a subproject and enter a name for your new batch.

5. Click Save.

To add samples to the list

• Right-click the sample list pane and choose Add sample from the shortcut menu, or use 
the Add Sample icon to add multiple sample rows.

The application adds the specified number of new, empty samples to the end of the 
sample list.

Tip  To enable the Save button, you must select a subproject and enter a unique batch 
name. If the Save button is not enabled, either you have entered a name that is already 
used or you have not selected a subproject.
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To insert samples into the list

1. Select the sample above which you want to insert empty samples.

2. Right-click the sample list pane and choose Insert sample from the shortcut menu, or use 
the Insert Sample icon to insert multiple sample rows.

The new, unknown samples are inserted above the selected sample.

To import samples into the list

1. Click Import.

The Sample import tool dialog box opens.

From this dialog box, you can import samples from a .csv file or .xml file.

2. Click Browse and select a .csv or .xml file that contains the samples you want to import.

3. From the Imported samples will be list, select appended to the end of the list or inserted 
at the selected row.

4. Click Import.

The Sample import tool dialog box closes and the application adds the specified samples 
to the Samples list. 
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To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert copy sample from the shortcut menu.

TraceFinder inserts the copy above the selected sample.

To re-inject a sample

1. In the sample list, select the sample you want to re-inject.

2. Right-click and choose Reinject this sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional re-injections of the same sample are numbered INJ002, 
INJ003, and so forth.

The TraceFinder application copies all parameter values from the original sample.

To edit sample values 

1. For each sample, double-click the Filename column (or right-click and choose Browse in 
raw file from the shortcut menu) and locate the raw data file to use for the sample. 

2. For each added sample, click the Sample type column and select a sample type from the 
list.

3. For each Cal Std or Chk Std sample, click in the Sample level cell and select a level from 
the list.

The sample levels were defined in the master method. If there is nothing to select in the 
Sample level list, do the following:

a. Return to the Method Development mode.

b. Open the method.

c. Click the Calibration levels tab.

d. Add the levels.

e. Save the method.

f. Return to the Data Review mode, and begin this batch again.

You must close your original batch without saving and start a new batch. For detailed 
instructions, see Chapter 4, “Using the Method Development Mode.” 

Available sample types

LC and GC

Matrix Blank Chk Std MS Unknown

Cal Std MDL MSD Solvent

GC only

LCS LCSD Meth Val Breakdown
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4. Enter or edit the values for the remaining columns.

When you use the scroll bar at the bottom of the samples list, the Status and Filename 
columns remains fixed and only the other columns scroll right and left. 

For instructions to automatically copy or fill values in these columns, see Appendix B, 
“Using Copy Down and Fill Down.” 

To rearrange the columns

1. To resize a column, drag the header separator on the right side of the column.

2. To move a column, drag the column header.

The Status and Filename columns can be swapped with each other, but they cannot be 
moved to any other location in the table.

When you close the application, it saves the new column order and width.

To remove samples from the list

1. Select the samples you want to remove.

Make sure the first column indicates that the samples are selected.

2. Right-click and choose Remove selected samples from the shortcut menu.

Selected samples
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Editing a Batch

In Batch view, you can open a saved batch and edit the samples list. You can add samples, edit 
samples, or remove samples. If the batch has already been acquired, you can select specific 
samples for re-injection. If the batch has unacquired samples when you complete your edits, 
you can save it as a .tbr (to be run) batch. 

Use the following procedures:

• To open a saved batch

• To edit samples in a batch

• To re-inject a sample from a previously acquired batch

• To submit all samples in the batch

• To submit selected samples

To open a saved batch

• Do one of the following:

• From the Batch View task pane, click Open Batch.

–Or–

• Click a batch name in the Recent Batches list. Do not double-click.

The selected batch opens in the Batch View.

To edit samples in a batch

• Use the commands described in “Working in Batch View” on page 182.

You can edit samples, add new samples, re-inject acquired samples, or delete samples.

To re-inject a sample from a previously acquired batch

1. In the sample list, select the sample you want to re-inject.

2. Right-click and choose Reinject this sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional re-injections of the same sample are numbered INJ002, 
INJ003, and so forth.

The TraceFinder application copies all parameter values from the original sample.
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Previously acquired samples are indicated with a green status indicator (acquired and 
processed) and are grayed out. Samples created for re-injection are indicated with a blue 
status indicator (not acquired).

3. To save this batch with the new samples for re-injection, choose File > Save > Batch from 
the main menu.

The batch is saved as a .tbr batch. You can open this batch from the Ready to acquire page 
in the Acquisition mode and acquire the re-injection samples.
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Submitting a Batch

In Batch view, you can submit an entire batch or only selected samples in the batch. When 
you submit a batch, you can choose to acquire, process, or create reports for the submitted 
samples.

To submit all samples in the batch

1. Do one of the following:

• Right-click and choose Submit batch from the shortcut menu.

–Or–

• Click the Submit batch icon, .

2. In the Submit Options dialog box, select if you want to process data and create reports in 
addition to acquiring the samples.

• You can choose to process samples that have already been acquired. 

• You can choose to acquire and process unacquired samples (including re-injections).

• You can choose to create reports for all submitted samples. 

3. Click OK. 

To submit selected samples

1. Select the samples you want to submit.

2. Do one of the following:

• Right-click and choose Submit selected samples from the shortcut menu.

–Or–

• Click the Submit selected samples icon, .

3. In the Submit Options dialog box, select if you want to process data and create reports in 
addition to acquiring the samples. 

• You can choose to process samples that have already been acquired. 

• You can choose to acquire and process unacquired samples (including re-injections).

• You can choose to create reports for all submitted samples.

4. Click OK.
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Batch view

Table 39. Batch View shortcut menu

Command Description

Add sample Adds a single empty row to the sample grid.

Insert sample Inserts a single empty row to the sample grid above the selected 
row.

Insert copy sample Copies the currently selected row and inserts a copy above the 
row.

Reinject this sample Creates a copy of the selected sample and appends INJ001 to the 
file name. Additional re-injections of the same sample are 
numbered INJ002, INJ003, and so forth.

Remove selected samples Removes selected samples from the sample grid.

Import samples Opens the Sample Import Tool. See “To import samples into the 
list” on page 184.

Submit selected samples Submits all selected samples to be acquired or processed.

Submit batch Submits all samples in the batch to be acquired or processed.

Browse in raw file Opens a dialog box where you can select a rawfile to use for the 
sample row.
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Working in Data Review
In the Data Review view, you can view the data generated by the master method. Use the Data 
Review view to verify the data for a sample-specific compound before you generate reports. 
You can use the functions in the Data Review view to investigate and edit the quantification 
values in a batch. 

To open the Data Review view

1. Do one of the following (to open Data Review mode):

• From the dashboard, click Data Review.

–Or–

• Click Data Review in the navigation pane of the current mode.

2. In the Data Review navigation pane, click Data Review (to open the Data Review view).

The Data Review view for the currently selected batch opens. 

Data Review Panes

The Data Review view is divided into four panes: 

• Use the Quantitative data pane to select a particular sample.  Status indicators for each 
sample indicate if the sample is unacquired, acquiring, or completed. See “Quantitative 
Data” on page 192.

• Use the  Compounds pane to select a particular compound within that sample’s result set. 
When you select a file and compound, the values displayed in the data grid reflect the 
quantification data for that unique combination.  See “Compounds” on page 199.

• The Quantification peak pane and Qualification pane provide graphical information to 
complement the textual information displayed in the upper panes. See “Quantification 
Peak” on page 200 and “Qualification” on page 205.
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Quantitative Data

The Quantitative data pane displays all the quantitative data for the samples of a batch.  The 
list of compounds that are available for a specific method is displayed in the Compounds 
pane.

The currently active compound is highlighted in the Compounds pane. You can then select it 
by clicking the name. The Compounds pane works with the Quantitative data pane to select a 
unique sample and compound combination, which then has its textual and graphical values 
displayed throughout the rest of the Data Review window. 

Quantitative data pane Compounds pane

Quan peak pane Qualification pane

Tip  To resize the panes, drag the separators that divide the panes.
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In the Quantitative data pane, you can make a compound active or inactive. Switching a 
compound to inactive status does not remove its data and calculated values from the result set; 
instead, the TraceFinder application masks off the appearance of that compound for that 
particular sample and grays the compounds in the Compounds list. For a calibration standard, 
the application no longer uses the data file’s calibration point for the calibration and removes 
it from the graphical view of the calibration curve displayed in the Qualification pane. It is no 
longer part of the result set. 

The Flags column in the Quantitative data pane displays a red flag if there is a problem with 
the results of the sample. 

When your cursor pauses over a flag, a Tooltip displays the specific problems with the sample 
or compound. 

Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing:

• Yellow for samples that have not been acquired 
• Orange for samples that are currently acquiring
• Blue for samples that have been acquired but not processed 
• Green for samples that have been acquired and processed

Sample Flags 

Sample flags are displayed when compounds within the samples have an error. Sample flags 
are always red.

• Sample flags remain static when you switch between compounds for chromatogram 
review until a change is completed, for example, when a compound is manually 
integrated and no longer falls outside the accepted criteria.

Status indicators

Sample flags
Compound flags
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• Sample flags list a summary of all compound indicator messages within the sample when 
your cursor pauses over the flag.

Compound flags

Flags are displayed in these situations:

• When a compound has violated (or is activated by) any of the values set in the method. 
See “Editing the Flags Page” on page 122. 

• For compounds that are not found in Cal Std, Chk Std, and Surrogate sample types.

• For compounds that are outside the specified ion ratio range.

• For compounds that are not found. 

These criteria do not apply to Matrix Blank sample types when the compound is an internal 
standard.

The compounds list is sorted first by flag indicators, and then by compound names. 
Compound flags indicate the following:

• Red flags for compounds that have ion ratio failures or method validation failures.

• Orange flags for compounds that are below the LOQ, below the LOD, or between the 
LOD and LOQ values specified in the method.

• Green flags for compounds that are over the LOR amount specified in the method.

• Yellow flags for compounds that are below the LOR amount specified in the method.

• No flag for compounds that have no errors or there were no report options selected.

Use the following procedures:

• To make a compound active or inactive

• To exclude a calibration point
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To make a compound active or inactive

1. Select the sample in the Quantitative data pane.

All compounds in that sample are displayed in the Compounds pane. The status of a 
compound in a sample is determined by the Component Active Status pane in the Batch 
View for the batch. Inactive compounds are grayed out.

2. In the Compounds pane, select the compound you want to make inactive.

3. In the Quantitative data pane, select or clear the Active check box.

Use the horizontal scroll bar at the bottom of the table to scroll to the Active column.

To exclude a calibration point

• In the Quantitative data pane, select the Excluded check box for the sample.

When a value is no longer used for calibration, it remains part of the calibration dataset 
and is displayed in the graphical view of the calibration curve. 

Inactive
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Quantitative data pane

Cells in the Quantitative data pane that should not have a value, such as theoretical 
concentration for an unknown, are shaded and empty. Cells that should have a value, but 
none exists, report N/A (not available). Results for compounds that are not detected display 
N/F (not found).

Table 40. Quantitative data parameters  (Sheet 1 of 3)

Parameter Description

Status • Yellow for samples that have not been acquired 
• Orange for samples that are currently acquiring
• Blue for samples that have been acquired but not processed 
• Green for samples that have been acquired and processed

Flags Displayed only when a compound within the sample has an error. 
Sample flags are always red.

Filename Name of the raw data file that contains the sample data.
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Sample type Defines how the TraceFinder application processes the sample 
data. Each sample is classified as one of the following sample types:

LC and GC: Matrix Blank, MDL, Solvent, Cal Std, MSD, 
Unknown, Chk Std, or MS

GC only: LCS, LCSD, Meth Val, or Breakdown

Sample level The level defined for a calibration sample or quality control 
sample.

Sample ID A user-defined alphanumeric string that identifies a sample.

Sample name A user-defined name that identifies a sample.

Comment A user-defined comment for the sample.

Vial Position The tray vial number used for the autosampler acquisition.

Injection volume The injection volume in microliters of sample to be injected. 

When you are using an autosampler, you can set the default 
injection volume in the Autosampler dialog box in the Instrument 
View. The minimum and maximum injection volumes that you 
can use depend on the Autosampler you configure. The usable 
range depends on the injection mode and might be smaller than 
the range displayed.

Integration mode Indicates whether the peaks have been manually integrated or 
integrated from the original method.

Height The distance from the peak maximum to the peak base, measured 
perpendicular to the ordinate. When the Resp ratio is specified as 
Height, this column is indicated with an asterisk (*Height).

Area The area obtained by integrating peak intensities from the start to 
the end of the peak. When the Resp ratio is specified as Area, this 
column is indicated with an asterisk (*Area).

Actual RT Actual retention time for the compound. Retention time is the 
time after injection at which a compound elutes and the total time 
that the compound is retained on the chromatograph column.

Expected RT Expected retention time for the compound.

Calc Amt The amount present in the sample, as determined using the 
calibration curve and the response ratio.

Theo Amt Theoretical amount of the compound expected in the sample. 

Table 40. Quantitative data parameters  (Sheet 2 of 3)

Parameter Description
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Resp ratio The ratio of the Response value to the IS Response value. If the 
Response is specified as Area in the processing method, the units of 
both Response and IS Response are counts-sec. If the Response is 
specified as Height in the processing method, the units of both 
Response and IS Response are counts.

IS Amt Amount of internal standard.

IS Resp Response of the internal standard.

Active Displays or hides a compound for a particular sample. When a 
calibration standard is marked inactive, the application no longer 
uses the data file’s calibration point for the calibration and removes 
it from the graphical view of the calibration curve displayed in the 
Qualification pane. It is no longer part of the result set. 

Excluded Turns a compound on or off in the Calibration curve of the 
Qualification pane. 

%Diff The calculated amount minus the expected amount, divided by 
the expected amount, and then multiplied by 100.

%RSD Standard deviation of the multiple samples of one level, multiplied 
by 100, and divided by the average of the multiple samples of that 
level. This calculation is based on the calculated amounts.

%CV Coefficient of Variation. Standard deviation of the multiple 
samples of one level, multiplied by 100, and divided by the average 
of the multiple samples of that level. This calculation is based on 
the areas of the peaks.

Table 40. Quantitative data parameters  (Sheet 3 of 3)

Parameter Description
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Compounds

The Compounds pane works with the Quantitative data pane to display textual and graphical 
values for a unique file and compound combination.

To display peaks for a specific compound

1. In the Quantitative data pane, select the sample.

The Compounds pane lists all compounds specified in the method.

2. In the Compounds pane, select the compound in the sample.

The Quan peak pane displays the peaks for the selected compound and its internal 
standard. 

To display specific problems with a compound

• Pause the cursor over the flag to display the problems with the compound.

Compound peak

Sample Compound

Internal standard
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Quantification Peak 

The Quantification pane displays the compound selected in the Quantitative data and 
Compounds panes. You can store two peak value sets (method and manual integration 
settings) with each compound in each file. These settings can result in a different set of stored 
values. The method values were originally calculated based on the processing method 
parameters. The manual values are a result of what has been viewed or altered. 

When the sample contains an internal standard, the chromatogram shows both the analyte 
and the internal standard in side-by-side panes.

Use the following procedures:

• To zoom in on a peak

• To manually integrate a quantification or qualification ion

• To manually add a peak

• To remove a manually created peak

• To switch between method and manual Integration modes

• To change the displayed information for detected peaks

• To modify the peak detection settings

To zoom in on a peak

1. In the chromatogram plot, drag your cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view to help you examine the peak limits for 
enhanced review and confirmation.

2. To restore the default view, right-click the chromatogram plot and choose Reset scaling 
from the shortcut menu. 

To manually integrate a quantification or qualification ion

1. Place your cursor over one of the two peak delimiter tags in the Quantification peak pane.

When the tag can be selected, the cursor changes to a crosshair style cursor. You can zoom 
in on the baseline to make it easier to select the tag. 

2. Drag the tag to another location, and release your cursor to place the peak delimiter tag at 
its new location and automatically update the peak values (area, height, and so forth) into 
the result set. 

Both the Quantification peak pane and the Integration mode column in the 
Quantification data pane reflect the change between method and manual modes. The 
generated reports for these data identify the manual modifications.
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To manually add a peak

1. Right-click anywhere in the Quantification peal pane, and choose Add peak from the 
shortcut menu.

If a peak is already detected, the Add peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

The application places the peak delimiter tags at these locations and automatically 
updates the peak values (area, height, and so forth) in the result set. 

To remove a manually created peak

• Right-click the chromatogram plot, and choose Remove peak from the shortcut menu.

The application removes the manually added peak.

To switch between method and manual Integration modes

• Right-click the chromatogram view and choose Method integration settings or Manual 
integration settings from the shortcut menu. 

Initially, the method and manual integration settings that are stored for a compound and 
file are identical and when you select one mode it does not affect the saved result set. 
However, when manual data are available, the chromatogram plots and the result set 
update as you switch between method and manual modes. 

As you switch between modes, the changes are reflected in each pane. The generated 
reports for this data identify the manual modifications.

To change the displayed information for detected peaks

1. Right-click the quantification chromatogram plot and pause the cursor over Peak labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

Manually added 
base points
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3. To remove a label, select the label type again and clear it.

Label settings are globally applied to quan peaks, confirming peaks, and internal standard 
peaks. 

To modify the peak detection settings

1. Right-click the chromatogram view and choose Peak detection settings from the 
shortcut menu. 

The Peak detection setting dialog box opens. This dialog box contains the detection 
settings defined in the method.

Note  The labels do not always update on all peak displays. To update all labels, select 
a different compound, and then reselect the compound whose labels you changed.
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2. Edit any of the detection settings.

For detailed descriptions of all detection settings, see “Detection” on page 97.

3. To save your changes to this compound in all samples in this batch, click Apply to All. 

Quantification peak shortcut menu

Command Description

Method integration settings Displays method integration settings.

Manual integration settings Displays manual integration settings.

Add peak - Remove peak - 
Cancel add peak

Adds a peak, removes a peak, or cancels an add peak 
operation in progress.

Confirming ion list Select the confirming ions to be viewed.

Peak labels Displays or hides the peak labels (Label area, Label 
retention time, Label height, or Label signal to noise).

Show peak info Displays peak information for the selected compound. 
For example:

Reset scaling Resets the original scaling after a zoom operation.

Peak detection settings Opens the Peak detection settings dialog box for the 
selected compound. 
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Peak Detection Settings

Use the Peak detection settings dialog box to adjust detection settings that were specified in 
the method.

For detailed descriptions of all detection settings, see “Detection” on page 97.
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Qualification

The Qualification pane displays the compound selected in the Quantification data pane and 
Compounds pane. 

The Qualification pane consists of five pages: 

• Calibration Curve 

• Spectra 

• QED Spectra

• Confirming Ions 

• Ion Overlay 

Calibration Curve

The Calibration curve page displays a graphical view of the calibration curve for the selected 
compound and key statistical values for evaluating the quality of the calibration. 

To manually exclude a calibration point

• In the Quantitative data pane, select the Excluded check box for the sample.

To zoom in on an area

1. In the Calibration curve plot, drag your cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the calibration curve plot and choose 
Reset scaling from the shortcut menu. 

Changes to the calibration settings are immediately applied to the entire results set, but 
they are saved only when you save the batch.  
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Spectra 

The Spectra page displays a comparison of the spectra found in the data and the method 
reference. 

To zoom in on an area

1. Drag your cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the spectra plot and choose Reset scaling 
from the shortcut menu.  

Calibration curve shortcut menu

Command Description

Standard type Sets the standard type to External or Internal. 
Calibration curve type Sets the calibration curve type to Linear, Quadratic, or Average 

RF. 
• Linear: Allows all settings with this exception: When Origin 

is set to Include, all Weighting values are grayed out and 
Weighting is set to Equal.

• Quadratic: Allows all settings with this exception: When 
Origin is set to Include, all Weighting values are grayed out 
and Weighting is set to Equal.

• Average RF: Allows no Weighting or Origin selections. All 
Weighting and Origin values are grayed out. Weighting is set 
to Equal, and Origin is set to Ignore. 

Response via Sets the response via to Area or Height.
Weighting Sets the weighting to equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.
Origin Sets the origin to Ignore, Force, or Include.
Units Sets the units.
Done with settings
Reset scaling Resets the original scale in the calibration curve pane.
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QED Spectra 

The QED spectra displays the averaged QED spectra from the rawfile and the datastore 
match. If the sample contains no QED data, the page is blank.

To zoom in on an area

1. Drag your cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the spectra plot and choose Reset scaling 
from the shortcut menu. 
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Confirming Ions

The Confirming Ions page displays a graphical view of all qualifying/confirming ions for the 
selected sample and compound and displays calculated ion ratios and ion ratio acceptance 
windows. A red border indicates that an ion ratio is outside of its window. Depending on the 
method option settings, another ion view is available on the Ion Overlay page. See “Ion 
Overlay” on page 212.

A red border indicates that an ion ratio is outside of its window.

Use the following procedures:

• To manually add a peak

• To remove a manually created peak

• To zoom in on a peak

• To change the displayed information for detected peaks

• To display the peak information window
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To manually add a peak

1. Right-click the chromatogram plot and select Add peak from the shortcut menu.

If a peak is already detected, the Add peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

The application places the peak delimiter tags at these locations and automatically 
updates the peak values (area, height, and so forth) in the result set. 

To remove a manually created peak

• Right-click the chromatogram plot, and choose Remove peak from the shortcut menu.

The application removes the manually added peak.

To zoom in on a peak

1. In the chromatogram plot, drag your cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view to help you examine the peak limits for 
enhanced review and confirmation.

2. To restore the method default view, right-click the chromatogram plot and choose Reset 
scaling from the shortcut menu. 

To change the displayed information for detected peaks

1. Right-click the chromatogram plot and pause the cursor over Peak labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to quan peaks, confirming peaks, and internal standard 
peaks. 

Note  The labels do not always update on all peak displays. To update all labels, select 
a different compound, then reselect the compound whose labels you changed.

Manually added 
base points
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To display the peak information window

1. Right-click the quantification and confirming ion chromatogram plots.

2. Choose Show Peak Info from the shortcut menu.

Information in this window includes the data stream processed for this ion, consisting of 
a particular detector, filter (if applicable), and trace. For example, an MS detector might 
show a filter of “+ c Full ms [35.00-500.00]” and a Mass Range trace. 

This window also shows the peak area and height, along with the retention times of the 
peak integration and the peak apex. 

Confirming ions shortcut menu  (Sheet 1 of 2)

Command Description

Method integration settings Displays method integration settings.

Manual integration settings Displays manual integration settings.

Add peak - Remove peak - 
Cancel add peak

Adds a peak, removes a manually added peak, or cancels an 
add peak operation in progress.

Range Calc method: Manual Selects the method used to calculate the ion ratio range 
windows: Manual, Average, Weighted average, or Level 

Range calc level Range based on the calibration level

Target ratio: Specifies the theoretical ratio of the confirming ion's 
response to the quantification ion's response. 

Window type: Specifies the Absolute or Relative calculation approach for 
determining the acceptable ion ratio range. 

Window: % Specifies the acceptable ion ratio range. 

Peak labels Displays or hides the peak labels (Label area, Label retention 
time, Label height, or Label signal to noise).
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Show peak info Displays peak information for the selected compound. For 
example:

Reset scaling Resets the original scaling after a zoom operation.

Peak detection settings Opens the Peak detection settings dialog box for the selected 
compound. See “Peak Detection Settings” on page 204.

Confirming ions shortcut menu  (Sheet 2 of 2)

Command Description
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Ion Overlay 

The Ion Overlay page represents an overlay of the entire ion set—quantification and 
qualifying/confirming—for the selected sample and compound. Use this page to graphically 
review the peak apex alignment and co-eluting peak profiles. 

To zoom in on a peak

1. Drag your cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the chromatogram plot and choose Reset 
scaling from the shortcut menu. 
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Working in Report View
Use the Report View to view the reports for the currently selected batch in the Data Review 
view.

To open the Report View

1. Do one of the following:

• From the dashboard, click Data Review.

–Or–

• Click Data Review in the navigation pane.

2. In the Data Review navigation pane, click Report View.

The Report View for the currently selected batch opens.

To display a report

1. Select a report type from the Select a report list.

Only the report types created for the current batch are displayed in the list. 

2. (Optional) When the report type includes separate reports for each sample, select a 
sample file.

To print a report

1. Select the report you want to print from the Select a report list.

2. Do one of the following:

a. Click the Print Report icon, .

The Print dialog box for your default printer opens.

b. Follow the typical procedure to print from your printer.

Landscape reports are automatically rotated to fit the paper.

–Or–

• Choose File > Print Batch from the main menu.

All reports for the batch are sent to your default printer. There is no dialog box or 
confirmation message.
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To export a report

1. Select the report you want to print from the Select a report list.

2. Click the Export Report icon, .

The Export Report dialog box opens.

3. Locate the folder where you want to write the report file and click Save.

The TraceFinder application writes the Crystal Reports (.rpt) or custom reports file to the 
specified folder.

To search for text

1. Select a report from the Select a report list.

2. Click the Find Text icon, .

The Find Text dialog box opens.

3. Enter your text and click Find Next.

When the TraceFinder application locates the text, it encloses the text in a red box.

To enlarge the report text

1. Select a report from the Select a report list.

2. Click the Zoom icon, , and select a zoom scale.
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Working in the Local Method View
A local method is a copy of a master method associated with a batch.

To open the Local Method View

1. Do one of the following:

• From the dashboard, click Data Review.

–Or–

• Click Data Review in the navigation pane.

2. In the Data Review navigation pane, click Local Method.

The Local Method View for the currently selected batch opens. Local methods are named 
BatchName_MasterMethodName.

You can edit many of the method parameters in a local method. 

For detailed descriptions of method parameters, see “Working with Master Methods” on 
page 62.

3. Enter any local changes to the method.

4. Choose File > Save.

5. To process the batch or create new reports with the edited local method, return to the 
Batch View and submit the batch.
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Reports

This appendix contains information about standard and custom reports.

The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The following types of reports meet the requirements of various methods and 
worldwide regulatory agencies and are designed to help track the performance of the system 
and method. The TraceFinder application can produce both standard reports and custom 
reports.

Specifying Reports
As an IT Administrator or Lab Director, you can configure a list of reports that are available 
for Method Development or Acquisition modes. 

For detailed information about configuring reports, see “Specifying the Reports 
Configuration” on page 40.

For detailed information about specifying reports when you create a method, see “Editing the 
Reports Page” on page 138.

For detailed information about specifying reports when you create a batch in Acquisition 
mode, see “Selecting and Reviewing Reports” on page 163.

Contents

• Specifying Reports

• Report Flags

• Sample Reports
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Standard Reports

For each standard report you generate, you can create a hardcopy print, a PDF (.pdf ), or an 
XML (.xml) output format. In addition to the report type, you can specify a report title for 
each of your reports. The default report title is the report name.

TraceFinder can generate the following types of standard reports:
• Batch Report 
• Blank Report 
• Breakdown Report 
• Calibration Density Report 
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Confirmation Report 
• Confirmation Report 2
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2 Long 
• High Density Sample Report 3 
• High Density Sample Report 3 Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report 
• Manual Integration Report 
• Method Detection Limit Report 
• Method Report 
• Method Validation Report 
• MSMSD Report 
• Quantitation Report 
• Solvent Blank Report 
• Surrogate Recovery Report 

To view an example of each type of standard reports, see “Sample Reports” on page 221.
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Specifying Reports
Custom Reports

For each custom report you generate, you can create a hardcopy printout or an XLS (.xlsm) 
output file. The default report title is the report name. 

A user in the role of IT Administrator or Lab Director can configure custom reports to 
generate a single report for an entire batch or to create separate reports for each sample. 
Rather than creating separate reports for each sample, this method uses data from only the last 
sample to create a single report for the entire batch.

The TraceFinder application includes the following custom reports:

• AltCalibrationReport
• Alternate BatchReport
• Alternate CalibrationReport
• Alternate ConfirmationReport
• Alternate MatrixSpikeReport
• Alternate SampleReport
• Alternate SummaryReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport 
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long
• QuantitationReport
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Report Flags
When generating or viewing a report, you might see one of the following quantification or 
calibration flags listed on the page. 

A QA/QC failure is identified by an asterisk (*), a shaded row, or the word Fail.

Values on a report that are the result of a manual integration will use an uppercase M to 
signify a manually integrated quantification ion and a lowercase m to signify a manually 
integrated qualifying/confirming ion. On alternative reports, manual integration are signified 
by a black box around the value. 

Table 41. Quantification flags

Flag Definition

b Compound was observed at a concentration in a matrix blank sample above the 
specified limit. 

s Compound was observed at a response in a solvent blank sample above the 
specified limit. 

J Compound was observed at a concentration above the limit of detection, but 
below the limit of quantitation. 

I or * Confirming/qualifying ion ratio for a compound was observed outside the target 
ratio range or the coelution between quantification and confirming/qualifying 
ion was larger than acceptable limit. 

C Compound was observed at a concentration above the specified carryover limit. 
? Compound was observed at a concentration above the specified linearity limit. 
D Compound was observed at a concentration below the specified limit of 

detection. 
Q Compound was observed at a concentration below the specified limit of 

quantitation. 
POS Compound was observed at a concentration above the specified cutoff. 

Table 42. Calibration flags

Flag Definition

D Calibration for this compound exceeded the specified maximum percent relative 
standard deviation (%RSD). 

F Response factor for this compound was below the specified minimum response 
factor (Min RF). 

R Calibration for this compound was below the specified minimum correlation 
coefficient (r2). 

A Back calculation of the calibration points for this compound exceeded the 
specified maximum percent difference (Max %D). 

X Calibration point for this compound was excluded from the overall calibration 
by manual selection. 

X(ISNF) Calibration point for this compound was excluded from the overall calibration 
because its associated internal standard was not found. 
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This section shows samples of the following standard report types:

• Batch Report

• Blank Report

• Breakdown Report

• Calibration Density Report

• Calibration Report

• Check Standard Report

• Chromatogram Report

• Compound Calibration Report

• Confirmation Report

• Confirmation Report 2

• High Density Sample Report 1

• High Density Sample Report 1 Long

• High Density Sample Report 2

• High Density Sample Report 2 Long

• High Density Sample Report 3

• High Density Sample Report 3 Long

• High Density Internal Standard Report

• Internal Standard Summary Report

• Ion Ratio Failure Report

• LCSLCSD Report

• Manual Integration Report

• Method Detection Limit Report

• Method Report

• Method Validation Report

• MSMSD Report

• QC Standard Report

• Quantitation Report

• Solvent Blank Report

• Surrogate Recovery Report

Tip  To easily view reports in landscape format, choose View > Rotate View > Clockwise 
from the Adobe Acrobat viewer menu.
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Calibration Report 
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Chromatogram Report 
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 A Reports
Sample Reports
Compound Calibration Report 

�
��
��
��
��
	

�
�

�

���
��
�
��
��
�

�



��

�
��

��
��
��
�
��
��

�
��
��



#

	$
%&


�
��

�'
(�

"'
���

�

�'
��

�
!�

)�
�'

��
��


*
!�


 
!�

�
�'

��
�

!�
��

��
� 

�+�
��

��
� 

�(
�

��
 

�

�
��
�

��
��

��
�

�

�
��
��
��

	

�
���
���
�

��
��

��
�

�	

�

�
�


��
��

��
��

��
�

��
��

��
�

��
��

��

�

�
�


��
��

��
��

��
�

��
��

��
��

���

�
 �

	
��
��
��
��
�

�
��

	

�
��

�
�

�
��
��
��
��
�

���

��
��
��



��
��
�
��
��

��
��
�
��



��
��
�
�
��
��

�
��
��

��
��

!�
��

��

�
��
��

�
	
 

�
��
�!

��
"�

��
"

�#
��

�
��

""
"


�
#�

$

"�

"$
"

"�
�


$
��

%&
�

'
%�

'
%�

��
"�

�"
"

�"
��

#
��

""
"




��

��
"�

��
�

"�
4#

�
��

%&
�

'
%�

'
%�

�

��

""
"

#"
4


�
��

""
"

�$
"�

��
"�

��
�

"�
$$

�
��

%&
�

'
%�

'
%�

�4
��

""
"

��
#�

��
��

""
"

�#
4�

��
"�

��
#

��
��

$
��

%&
�

'
%�

'
%�

��
��

�"
"

�#
��

��
��

""
"

�#
�$

#"
"�

�

�

��
4�

$
��

%&
�

'
%�

'
%�

��
��

""
"


�
��

"�
��

""
"

�$
�4


$
��

��
4

4�
$$

�
��

%&
�

'
%�

'
%�

�

�
�

��"
���
��
#�

�
��
�

	

�
�

�

���
��
$�

#�
��!
�%
�
�!
&��
�%
��
��
��
��
��
$

��
��
&��
�%
��
��
'�

�
��
&��
�%
��
�
��
��
Thermo Scientific TraceFinder User Guide 231



A Reports
Sample Reports
	
��
��
��
��
	

�
�

�

���
��
�
��
��
�

�



��

�
��

��
��
��
�
��
��

�
��
��

�
(


)
*+�

&
��

�,
-&

.,
���

�

�,
��

&
��

/�
�,

��
�!

�0
��

�1
��

2
�,

��
&

��
3�

��
�1

���
��

 �
�1

�-
&

��
1

�

�
��
�

��
��

��
�

�

�
��
��
��

	

�
���
���
�

��
��

��
�

�	

�

�
�


��
��

��
��

��
�

��
��

��
�

��
��

��

�

�
�


��
��

��
��

��
�

��
��

��
��

���

�

�

	
��
��
��
��
�

�
��

	

�
��

�
�

�
��
��
��
��
�

���

��
��
��



��
��
�
��
��

��
��
�
��



��
��
�
�
��
��

�
��
��

/�
���

�
!�

��
��

�
��
��

�
	
 

�
��
�!

��
"�

��
"

$�
��

�
��

""
"

�#

�

�

�

"�
"�

"
"�


�
4

�
��

%&
�

'
%�

'
%�

��
"�

�"
"

��
�4

"�
��

""
"

�#
�4

��
�

"�
"$

�
"�

�4
$

��
%&

�
'

%�
'

%�

�

��

""
"


�
�4

��
��

""
"

��
��

$�
�

"�
�$

�
��

"�
"

��
%&

�
'

%�
'

%�

�4
��

""
"

�4
��

��
��

""
"

��
4�

#�
#

"�

$

"
��

"�
�

��
%&

�
'

%�
'

%�

��
��

�"
"

�

�"

��
��

""
"

��
�$

$

�

"�
4


�
��

�4
�

��
%&

�
'

%�
'

%�

��
��

""
"

��
#


#�
4

��
""

"
��

�#
�$

�
��

"�
"

��
��

�
��

%&
�

'
%�

'
%�

�

�
�

��"
���
��
#�

�
��
�

	

�
�

�

���
��
$�

#�
��!
�%
�
�!
&��
�%
��
��
��
��
��
$

��
��
&��
�%
��
��
'�

�
��
&��
�%
��
�
��
��
232 TraceFinder User Guide Thermo Scientific



 A Reports
Sample Reports
	
��
��
��
��
	

�
�

�

���
��
�
��
��
�

�



��

�
��

��
��
��
�
��
��

�
��
��

�
(


)
*+�

&
��

�,
-&

.,
���

�

�,
��

&
��

/�
�,

��
�!

�0
��

�1
��

2
�,

��
&

��
3�

��
�1

���
��

 �
�1

�-
&

��
1

�

�
��
�

��
��

��
�

�

�
��
��
��

	

�
���
���
�

��
��

��
�

�	

�

�
�


��
��

��
��

��
�

��
��

��
�

��
��

��

�

�
�


��
��

��
��

��
�

��
��

�

��

���

4
2�

��
��

��
	
��
��
��
��
�

�
��

	

�
��

�
�

�
��
��
��
��
�

���

��
��
��



��
��
�
��
��

��
��
�
��



��
��
�
�
��
��

�
��
��

/�
���

�
!�

��
��

�
��
��

�
	
 

�
��
�!

��
"�

��
"

��
�4

��
��

""
"

�

��


"
�

"�
"�

4
"�


�
$

�
��

%&
�

'
%�

'
%�

��
"�

�"
"




�$

$

��

""
"

�4
��

�4
�

"�
�


�
"�

��
#

��
%&

�
'

%�
'

%�

�

��

""
"

��
##

$�
��

""
"

��
"#

$�



"�
��

#
��

"�
4

��
%&

�
'

%�
'

%�

�4
��

""
"

�"
#"

#$
"

��
""

"
��

$4
�$

#
"�
4$



��

$�
#

��
%&

�
'

%�
'

%�

��
��

�"
"

�


�

��
�

��
""

"
��

��
4#

�
"�

�$
"

��
�#

$
��

%&
�

'
%�

'
%�

��
��

""
"

��
�$

��
$

��
""

"
�"

#"
#�



��




�

��
��



��

%&
�

'
%�

'
%�

�

�
�

��"
���
��
#�

�
��
�

	

�
�

�

���
��
$�

#�
��!
�%
�
�!
&��
�%
��
��
��
��
��
$

��
��
&��
�%
��
��
'�

�
��
&��
�%
��
�
��
��
Thermo Scientific TraceFinder User Guide 233



A Reports
Sample Reports
	
��
��
��
��
	

�
�

�

���
��
�
��
��
�

�



��

�
��

��
��
��
�
��
��

�
��
��

�
(


)
*+�

&
��

�,
-&

.,
���

�

�,
��

&
��

/�
�,

��
�!

�0
��

�1
��

2
�,

��
&

��
3�

��
�1

���
��

 �
�1

�-
&

��
1

�

�
��
�

��
��

��
�

�

�
��
��
��

	

�
���
���
�

��
��

��
�

�	

�

�
�


��
��

��
��

��
�

��
��

��
�

��
��

��

�

�
�


��
��

��
��

��
�

��
��

�4
��

���

3�
&

��
��

�
	
��
��
��
��
�

�
��

	

�
��

�
�

�
��
��
��
��
�

���

��
��
��



��
��
�
��
��

��
��
�
��



��
��
�
�
��
��

�
��
��

/�
���

�
!�

��
��

�
��
��

�
	
 

�
��
�!

��
"�

��
"

4�
"#

�
��

""
"

��
4#

�#
"�

"�



"�

�

�
�

��
%&

�
'

%�
'

%�

��
"�

�"
"

#"
�#

4
��

""
"

�4
��

�#
"�

�4
#

"�
�$

#
��

%&
�

'
%�

'
%�

�

��

""
"

�4
��

�4
��

""
"

4#
$$


�
"�

�$
"

��
"�

�
��

%&
�

'
%�

'
%�

�4
��

""
"

�$
��

��
��

""
"

�"
#4

��
"�

��



��
#�

"
��

%&
�

'
%�

'
%�

��
��

�"
"


�
��

4$
��

""
"

4$
$�

��
"�

�"
�

��
�4

"
��

%&
�

'
%�

'
%�

��
��

""
"

��
44


$
��

""
"

44

$

�

��

�"
"

��
��

�
��

%&
�

'
%�

'
%�

�

�
�

��"
���
��
#�

�
��
�

	

�
�

�

���
��
$�

#�
��!
�%
�
�!
&��
�%
��
��
��
��
��
$

��
��
&��
�%
��
��
'�

�
��
&��
�%
��
�
��
��
234 TraceFinder User Guide Thermo Scientific



 A Reports
Sample Reports
	
��
��
��
��
	

�
�

�

���
��
�
��
��
�

�



��

�
��

��
��
��
�
��
��

�
��
��

�
(


)
*+�

&
��

�,
-&

.,
���

�

�,
��

&
��

/�
�,

��
�!

�0
��

�1
��

2
�,

��
&

��
3�

��
�1

���
��

 �
�1

�-
&

��
1

�

�
��
�

��
��

��
�

�

�
��
��
��

	

�
���
���
�

��
��

��
�

�	

�

�
�


��
��

��
��

��
�

��
��

��
�

��
��

��

�

�
�


��
��

��
��

��
�

��
��

��
��

���

�
1��

��
��

	
��
��
��
��
�

�
��

	

�
��

�
�

�
��
��
��
��
�

���

��
��
��



��
��
�
��
��

��
��
�
��



��
��
�
�
��
��

�
��
��

��
��

!�
��

��

�
��
��

�
	
 

�
��
�!

��
"�

��
"

��
��

#

��

""
"

�4

"


4
�

"�
"�

$
"�

�#
�

��
%&

�
'

%�
'

%�

��
"�

�"
"


4
�#

��
��

""
"

�4
�$

$"



"�
�4



"�

��
"

��
%&

�
'

%�
'

%�

�

��

""
"

�"
��


�
��

""
"

�

��

�"
"

"�
��



"�

$$



��
%&

�
'

%�
'

%�

�4
��

""
"

��
�


#�



��
""

"
��

�$
4$

$
"�

��
�

��
$$

$
��

%&
�

'
%�

'
%�

��
��

�"
"

�4
��

��
$

��
""

"
�


��
��

�
"�

�$
#

��

�

�
��

%&
�

'
%�

'
%�

��
��

""
"

�$
4�

#�
�

��
""

"
��


�
""

4
��


�
$

��
"#

�
��

%&
�

'
%�

'
%�

�

�
�

��"
���
��
#�

�
��
�

	

�
�

�

���
��
$�

#�
��!
�%
�
�!
&��
�%
��
��
��
��
��
$

��
��
&��
�%
��
��
'�

�
��
&��
�%
��
�
��
��
Thermo Scientific TraceFinder User Guide 235



A Reports
Sample Reports
	
��
��
��
��
	

�
�

�

���
��
�
��
��
�

�



��

�
��

��
��
��
�
��
��

�
��
��

�
(


)
*+�

&
��

�,
-&

.,
���

�

�,
��

&
��

/�
�,

��
�!

�0
��

�1
��

2
�,

��
&

��
3�

��
�1

���
��

 �
�1

�-
&

��
1

�

�
��
�

��
��

��
�

�

�
��
��
��

	

�
���
���
�

��
��

��
�

�	

�

�
�


��
��

��
��

��
�

��
��

��
�

��
��

��

�

�
�


��
��

��
��

��
�

��
��

��
��

���

��
�.

��
��

�
	
��
��
��
��
�

�
��

	

�
��

�
�

�
��
��
��
��
�

���

��
��
��



��
��
�
��
��

��
��
�
��



��
��
�
�
��
��

�
��
��

/�
���

)
�

!�
��

��

�
��
��

�
	
 

�
��
�!

��
"�

��
"

�#
�"

��
"

��
""

"
�4

��
�


�$
�#
4"

��
��

�#
�

��
%&

�
'

%�
'

%�

��
"�

�"
"

�#
�#

�4
�

��
""

"

"

��
��

$�
�"

�
"�

$�
�

�
��

%&
�

'
%�

'
%�

�

��

""
"

��
�4

��



��
""

"
��

"

##

4�
#�

$
��
4�

$
�

��
%&

�
'

%�
'

%�

�4
��

""
"

��
$�

�4
�

��
""

"
�"

��
#�



��

��




�
�#



�

��
%&

�
'

%�
'

%�

��
��

�"
"

��
"�

$"



��
""

"
�


�

4�

�
��

"�
�


�
4


$
�

��
%&

�
'

%�
'

%�

��
��

""
"

��
�4

��



��
""

"
��

��
�


$
"�

$4
�


�
#�

�
�

��
%&

�
'

%�
'

%�

�

�
�

��"
���
��
#�

�
��
�

	

�
�

�

���
��
$�

#�
��!
�%
�
�!
&��
�%
��
��
��
��
��
$

��
��
&��
�%
��
��
'�

�
��
&��
�%
��
�
��
��
236 TraceFinder User Guide Thermo Scientific



 A Reports
Sample Reports
	
��
��
��
��
	

�
�

�

���
��
�
��
��
�

�



��

�
��

��
��
��
�
��
��

�
��
��

�
(


)
*+�

&
��

�,
-&

.,
���

�

�,
��

&
��

/�
�,

��
�!

�0
��

�1
��

2
�,

��
&

��
3�

��
�1

���
��

 �
�1

�-
&

��
1

�

�
��
�

��
��

��
�

�

�
��
��
��

	

�
���
���
�

��
��

��
�

�	

�

�
�


��
��

��
��

��
�

��
��

��
�

��
��

��

�

�
�


��
��

��
��

��
�

��
��

��
��

���

�
��
��

��
��
�!

�
�

�

�
��
��
�

�
�

	
��
�
��
�

�

�
��
��
�!

��
��
�

�
�

(�
�

4
��

""
�

3�
&

.�
� 

�
��



�

��



'
��

��
��-

1��
��

��
%�

�%
�"

"�
�5

2.
��

��
��6

��
7�

�"
"�

��
�%

��
%�

""
��

�8

#

84
"�

�(
��

��
�2

�8
�

4
��

""
�

3�
&

.�
� 

�
""

�
�

""
�

'
��

��
��-

1��
��

��
%�

�%
�"

"�
�5

2.
��

��
��6

��
7�

�"
"�

��
�%

��
%�

""
��

�8
"$

84
��

�(
��

��
�2

�8



4
��

""



3�
&

.�
� 

�
""



�

""



'
��

��
��-

1��
��

��
%�

�%
�"

"�
�5

2.
��

��
��6

��
7�

�"
"�

��
�%

��
%�

""
��

�8
4"

8�
#�

�(
�


��
�2

�8
4

4
��

""
4

3�
&

.�
� 

�
""

4
�

""
4

'
��

��
��-

1��
��

��
%�

�%
�"

"�
�5

2.
��

��
��6

��
7�

�"
"�

��
�%

��
%�

""
��

�8
��

8"
��

�(
�4

��
�2

�8
�

4
��

""
�

3�
&

.�
� 

�
""

�
�

""
�

'
��

��
��-

1��
��

��
%�

�%
�"

"�
�5

2.
��

��
��6

��
7�

�"
"�

��
�%

��
%�

""
��

�8
4


8�
��

�(
��

��
�2

�8
�

4
��

""
�

3�
&

.�
� 

�
""

�
�

""
�

'
��

��
��-

1��
��

��
%�

�%
�"

"�
�5

2.
��

��
��6

��
7�

�"
"�

��
�%

��
%�

""
��

#8
�4

8�
"�

�(
��

��
�2

�8
�

�

�
�

��"
���
��
#�

�
��
�

	

�
�

�

���
��
$�

#�
��!
�%
�
�!
&��
�%
��
��
��
��
��
$

��
��
&��
�%
��
��
'�

�
��
&��
�%
��
�
��
��
Thermo Scientific TraceFinder User Guide 237



A Reports
Sample Reports
Confirmation Report 

Lab name:
Instrument:
User:

Confirmation Report

AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 1

Batch: Preview2

Method:

Cali file:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
5ppb-004SampleID004 D004 New Dilutions 6/26/2007 6/27/2007 2:28:00 AMN/ATray1:18

MS-Data

MS-Library ings\Thermo\Desktop\EPA536-Triazines\5ppb-002.RAW

Atrazine

5.249 ng/mlConc:

Injected Sample

5.249 ng/ml

Retention time: 18.34
Area: 2905258

716288Height:

Calibration curve

Quan Ion: 174.06
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Confirmation Report 2

Thermo Scientific Instrument

Confirmation Report 2
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory Page 1 of 1

Batch: Preview2

Method:

Cali file:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
5ppb-004SampleID004 D004 New Dilutions 6/26/2007 6/27/2007 2:28:00 AMN/ATray1:18

Injected Conc:
5.249 ng/mlSample Conc:
5.249 ng/ml

Retention time: 18.34
Area (Quan): 2905258

716288Height (Quan):

Quan Ion: 174.06

Qual ratio 1:
Qual ratio 2:

Pass

Pass

MS-Data

MS-Library nts and Settings\Thermo\Desktop\EPA536-Triazines\5ppb-002.RAW

Compound Name: Atrazine
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A Reports
Sample Reports
Internal Standard Summary Report
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 A Reports
Sample Reports
Ion Ratio Failure Report 
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A Reports
Sample Reports
LCSLCSD Report 
IMPORTANT  When the Sample ID is the same for an unknown sample and an LCS or LCSD sample, the unknown 
sample is included in the LCSLCSD report. The report information for the unknown sample displays as zeros.
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 A Reports
Sample Reports
Manual Integration Report 
Manual Integration Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 2

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
Cal003SampleID003 D003 New Dilutions 6/26/2007 H6/26/2007 6:40:58 PMc3Tray1:4

Atrazine D-5

2377500

Method integration

Apex RT:
Height:
Area:

Manual integration
Apex RT:
Height:
Area: 860754

18.26
608261

18.26
361974

m/z: 179.00

Manual Integration Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 2 of 2

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Atrazine

601232

Method integration

Apex RT:
Height:
Area:

Manual integration
Apex RT:
Height:
Area: 457354

18.30
160397

18.30
144422

m/z: 174.06
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A Reports
Sample Reports
Method Detection Limit Report 
Method Detection Limit Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Method Detection Limit Summary
Compound Avg Conc Std Dev t-stat % RSD MDL

DIA D-5 290218 0 0.00  IS

DIA 0.095 0.000 0.000 0.00 <<<0.000

DEA D-7 1704578 0 0.00  IS

DEA 0.065 0.000 0.000 0.00 <<<0.000

Cyanazine D-5 2204710 0 0.00  IS

Cyanazine 0.062 0.000 0.000 0.00 <<<0.000

Simazine D-10 513521 0 0.00  IS

Simazine 0.168 0.000 0.000 0.00 <<<0.000

Atrazine D-5 2292164 0 0.00  IS

Atrazine 0.023 0.000 0.000 0.00 <<<0.000

Propazine -1069.216 0.000 0.000 0.00 <<<0.000

Propazine D-14 826 0 0.00  IS

Manually integrated
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 A Reports
Sample Reports
Method Detection Limit Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 2 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

1Compound
Method Validation Report Data

DIA D-5 290218
DIA 0.095
DEA D-7 1704578
DEA 0.065
Cyanazine D-5 2204710
Cyanazine 0.062
Simazine D-10 513521
Simazine 0.168
Atrazine D-5 2292164
Atrazine 0.023
Propazine -1069.216
Propazine D-14 826

Manually integrated
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A Reports
Sample Reports
Method Detection Limit Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 3 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
Cal007SampleID007 D007 New Dilutions 6/26/2007 H6/26/2007 8:45:28 PMN/ATray1:1

Manually integrated
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 A Reports
Sample Reports
Method Report 
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A Reports
Sample Reports
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Method Validation Report 
Method Validation Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Method Validation Summary
Compound Avg Conc Theo Conc % Diff Min Conc % RSD Max % RSDMax Conc

DIA D-5 295652  IS0.00

DIA 0.358 0.500 -28.34 0.250 20.000.750 0.00

DEA D-7 1778658  IS0.00

DEA 0.602 0.500 20.45 0.250 20.000.750 0.00

Cyanazine D-5 2224244  IS0.00

Cyanazine 0.565 0.500 12.90 0.250 20.000.750 0.00

Simazine D-10 505462  IS0.00

Simazine 0.607 0.500 21.49 0.250 20.000.750 0.00

Atrazine D-5 2334865  IS0.00

Atrazine 0.512 0.500 2.46 0.250 20.000.750 0.00

Propazine 0.757 0.500 51.41 0.250 20.00 <<<0.750 0.00

Propazine D-14 272050  IS0.00

Manually integrated <<< = Failure
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Method Validation Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 2 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

1Compound
Method Validation Report Data

DIA D-5 295652
DIA 0.358
DEA D-7 1778658
DEA 0.602
Cyanazine D-5 2224244
Cyanazine 0.565
Simazine D-10 505462
Simazine 0.607
Atrazine D-5 2334865
Atrazine 0.512
Propazine 0.757
Propazine D-14 272050

Manually integrated <<< = Failure
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Method Validation Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 3 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
500ppt-003SampleID003 D003 New Dilutions 6/26/2007 H6/26/2007 10:18:49 PMN/ATray1:10

Manually integrated <<< = Failure
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MSMSD Report 
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QC Standard Report
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Quantitation Report 
��

��
��
��
	�


�
��
��
���
���
�	


��
�

�

�
��
	�
��
��

��
��

�
�
��
��

�
��

�

�
�


�
���

�
��
��
��

��
���

�

��
��
�
��
��
��

��
��
��

��
��
��
�

��
��
�
��
� 

��
!�
�	�

 �
"!
��
��
�
�!

�

�
��
��
�

��
�#

��
$



�
��
��
��

�
��
�	�
���
�

��
�#

��
$

%


�
�
&'

()
��

��
*�
!�

�

��
�#

��
$

�
 �

+,

�

�
&'

()
��

��
*�
!�

�

�
��
��

��
��
	�
��
�

��
�
��
�	
�
��
�

�
��
�
��
�

��
�
��
�	
��

��
��
��
�
�

��
�

�
�+
��

&
��

�
�+
�"


��

&


��

&


�$

�

�+�

���
!�

�(
1

(1

�
�2

��
��

��
��
+��

�+
��
��
�,



(1

(

1

��

2�
2"

#'
"�

�
��

 &
��

��
�"
(

��
��

�
��
	�
��
��
�

��



�

�
��
�



��
��
��
�

��
��
��
��

�
��
��
��
��
�

�
��
�

�
��
��

�
��
��

�
��
�

 
��

�
!�
	

�"
	



��
��
��
�	


��
��

�
�

��
	�
#�
�


>
2$

>�
�'

2�
��

�#
�


#


"�

�

)&

��
��
�

!�
1�

+
��
��
�

!�
1�

+
��
��
�

��
!�

��

�(
2$

$'
2

�#
2�
��

�&
�$






�

�

)2

��
��
�

!�
1�

+
��
��
�

!�
1�

+
��
��
�

��
!�

��




&&

#>
2


�
$�
��

�2
��
&

�
��

!�
*�
!�

�

)&

��
��
�

!�
1�

+
��
��
�

!�
1�

+
��
��
�

��
!�

��

#$
$&

&�
�'

2�
��

�2
�


$
��
�
�*

�!
��


)�
�

��
��
�

!�
1�

+
��
��
�

!�
1�

+
��
��
�

��
!�

��


'
(2

&&
(

�2
$�
��

�>
�

2

�
���

*�
!�

�

)&

��
��
�

!�
1�

+
��
��
�

!�
1�

+
��
��
�

��
!�

��

�'
�'

#2
&

�>
>�
�#

�$
��
(

��
��

�*
�!
��


)�

#
��
��
�

!�
1�

+
��
��
�

!�
1�

+
��
��
�

��
!�

��

�
�

!�
�	�
��
��
��
��



�

�
��
�



��
��
��
�

��
��
��
��

�
��
��
��
��
�

�
��
�

�
��
��

�
��
��

�
��
�

 
��

�
!�
	

�"
	



��
��
��
�	


��
��

�
�

��
	�
#�
�

�>

�

�2
�'


�
�$

�#
�'
�



"�


�
#�

$
!�

1�
+


�
#�

$
!�

1�
+

��
('



��

!�
��

2'

�

&2
�#

(�
�(

�&
�$
>




�


�

#

�
!�

1�
+


�

#

�
!�

1�
+

��
#'

(
��

!�
��

�'
'�

�2
&


�
#�
�'

�2
��
>

�
��

!�
*�
!�


�

>

$
!�

1�
+


�

>

$
!�

1�
+

��
&$
�

��
!�

��

'&




#$
�


#�
�2

�2
�'
2

��
�
�*

�!
�


�

#

!�
1�

+

�

#

!�
1�

+
��
2�

&
��

!�
��

�
��
��
��#
	��
��
!

��
��
270 TraceFinder User Guide Thermo Scientific



 A Reports
Sample Reports
��
��

�

��
	�


�
��
��
���
���
�	


��
�

�

�
��
	�
��
��

��
��

�
�
��
��

�
��

�

�
�


�
���

�
��
��
��

��
���

�

��
��
�
��
��
��

��
��
��

��
��
��
�

��
��
�
��
� 

��
!�
�	�

 �
"!
��
��
�
�!

�

�
��
��
�

��
�#

��
$



�
��
��
��

�
��
�	�
���
�

��
�#

��
$

%


�
�
&'

()
��

��
*�
!�

�

��
�#

��
$

�
 �

+,

�

�
&'

()
��

��
*�
!�

�

�
�

!�
�	�
��
��
��
��



�

�
��
�



��
��
��
�

��
��
��
��

�
��
��
��
��
�

�
��
�

�
��
��

�
��
��

�
��
�

 
��

�
!�
	

�"
	



��
��
��
�	


��
��

�
�

��
	�
#�
�

�#
�&

�2
$

�2
#�
�(

�>
�'
�

�
���

*�
!�


�
'�

(
!�

1�
+


�
'�

(
!�

1�
+

��
&$

>
��

!�
��


2
�2

$�
'

�$
(�
��

�>
�$

$
��

��
�*

�!
�

'�
#'

$
!�

1�
+

'�
#'

$
!�

1�
+


�
�(



��

!�
��

�
��
��
��#
	��
��
!

��
��
Thermo Scientific TraceFinder User Guide 271



A Reports
Sample Reports
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 A Reports
Sample Reports
Surrogate Recovery Report 
Surrogate Recovery Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 1

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
Cal006SampleID006 D006 New Dilutions 6/26/2007 H6/26/2007 8:14:20 PMc6Tray1:7

Compound Conc added Conc recovered % Recovered Limits
0.500 0.000 0.00 50.00 - 150.00DIA D-5
0.500 0.000 100.00 50.00 - 150.00DIA
0.500 5.111 100.00 50.00 - 150.00 RDEA
0.500 5.123 100.00 50.00 - 150.00 RCyanazine

Manually integrated R=Recovery limits exceeded
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B

Using Copy Down and Fill Down

This appendix describes the Copy down and Fill down commands that you can use to make 
entering column values easier.

You can use the Fill down command for the Sample name, Sample ID, Vial position, and 
Sample level columns.

You can use the Copy down command for the Sample type, Vial position, Injection volume, 
Conv factor, and Sample level columns.

Use the following procedures

• To automatically enter sequential column values

• To automatically copy column values

• To use Copy down or Fill down for a range of samples

To automatically enter sequential column values

1. Enter a value for the first row of the fill down sequence.

This does not have to be the first sample row. You can begin the fill down procedure from 
any row in the sequence.

2. Select the cell whose value is the first in the fill down sequence.

Observe that this cell is selected. 

You can repeatedly use the Fill down command to create multiple sequences. See 
“Example 1” on page 277.

3. Right-click and choose Fill down from the shortcut menu.

The application enters sequential column values starting with the value in the selected 
row and ending with the last row in the column. 

Selected 

Not selected 
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B Using Copy Down and Fill Down
To automatically copy column values

1. Select the cell whose value you want to copy to all cells below it.

Observe that this cell is selected. 

2. Right-click and choose Copy down from the shortcut menu.

The value is copied to all rows below the selected row. 

To use Copy down or Fill down for a range of samples

1. To select a range of sample values, do one of the following:

• Drag your cursor to select a contiguous group of sample values.

–Or–

• Hold down the SHIFT key to select a contiguous group of sample values.

2. Right-click and choose the appropriate command from the shortcut menu.

The column values are copied or entered sequentially starting with the value in the first 
selected row and ending with the last selected row. 

Note  If you use the Fill down command for the Vial position column and you have 
an autosampler configured, the TraceFinder application knows the number of vial 
positions configured in your autosampler and numbers the positions accordingly. See 
“Example 2” on page 277.

Selected 

Not selected 
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 B Using Copy Down and Fill Down
Example 1

You can repeatedly use the Fill down command to create multiple sequences.

Example 2

The TraceFinder application knows the number of vial positions configured in your 
autosampler and numbers the positions accordingly.
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C

Using Filter Criteria

The filter criteria tool is available from the compound datastore in the Configuration mode 
and the acquisition list in the Method Development mode. 

To filter the compound list

1. To display only a filtered list of compounds, click the funnel icon, , in the column 
header.

For each column, a list of filterable criteria is displayed. On all columns, your filter choice 
are All, Blanks, and NonBlanks. Other filter criteria is specific to the individual columns.

2. To create a custom filter based on compound values in a specific column, choose Custom 
from the column list box.

The Enter filter criteria dialog box opens. See “Enter Filter Criteria” on page 280.

3. From the Operator list box, select an operator.

4. From the Operand list box, select an operand.

5. When all conditions are defined, click OK.

The complete filter string is displayed at the bottom of the dialog box. For example:

chemical formula = Blanks
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C Using Filter Criteria
Enter Filter Criteria

The Enter filter criteria dialog box is specifically named for the column on which you are 
filtering. In this example, the selected column is the Compound Name column.

Figure 9. Enter filter criteria dialog box

Table 43. Filter criteria parameters

Parameter Description

And 
conditions

Requires that all filter criteria must be met.

Or 
conditions

Requires that any of the specified filter criteria be met.

Add a 
condition

Adds a new, empty condition to the filter criteria.

Delete 
condition

Deletes the selected condition. Click the box at the left of the row to select 
the condition.

Operator The mathematical function applied to the operand.

Operand The arguments to which the operator is applied.
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Index
Symbols
# background scans parameter  106
% Test parameter  121

A
Acquire a new raw data file parameter  72
Acquisition command  15
Active parameter

Breakdown  128
Identification  96

Add a condition parameter  280
Add a mass as new confirming ion command  113
Add Group command  137
Add this mass to existing quan mass ranges command  113
Amount parameter  116
And conditions parameter  280
Application Configuration view  37
Area noise factor parameter  108
Area scan window parameter  110
Area tail extension parameter  109
Assay type parameter  90
Automatically create the master method parameter  72

B
Baseline window parameter  108
Batch view  182
Batch/Template Selection view  152
batches

Acquisition mode  148
calibration  169
Data Review mode  182
development  55

Best match method parameter  85
Breakdown method parameter, General  90

C
cal1-caln parameter  118
Calibration Curve page  205
Calibration method parameter  85
calibration standard (Cal Std) sample type

definition  179
Carryover limit parameter  123
CAS No parameter  96
Category parameter  93
check standard (Chk Std) sample

definition  179
Chemical Formula parameter  93
Collision Energy parameter, precursor  94
comma separated values, defined  2
commands

Acquisition  15
Add a mass as new confirming ion  113
Add Group  137
Add this mass to existing quan mass ranges  113
Configuration  15
Copy down  275
Data Review  15
Delete compound from method

Blank flag  130
Calibration flag  124
ISTD flag  131
Lab Control flag  126
Matrix Spike flag  135
Meth Val flag  127
QC Check flag  125
Quan flag  123
Solvent Blank flag  132
Surrogate flag  133

Display retention time column
Blank flag  130
Calibration flag  124
ISTD flag  131
Lab Control flag  126
Matrix Spike flag  135
Meth Val flag  127
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Index: D
QC Check flag  125
Quan flag  123
Solvent Blank flag  132
Surrogate flag  133

Exit TraceFinder  9
Fill down  275
Help, dashboard  15
Log Off  15
Method Development  15
Real Time Status  15
Reset scaling  113
Set this mass as a new quan peak  113
Set this mass as quan mass  113
Update confirming ion ratios with this spectrum  113

Compound Datastore
administration  30

Compound Datastore view  30
Compound Name parameter  93
Compound parameter

Calibration  116
Calibration flag  124
Calibration levels  118
Identification  96
ISTD flag  130
Lab Control flag  126
Matrix Blank flag  129
Matrix Spike flag  134
Meth Val flag  127
QC Check flag  125
QC levels  121
Quan flag  123
Solvent Blank flag  132
Surrogate flag  133

Compound type parameter
Calibration  116
Identification  96

Compounds for group parameter  128
Configuration command  15
Confirming Ions page  208
Constrain peak width parameter

Genesis  104
ICIS  108

Copy down command  275
Correct surrogates parameter  145
Create method parameter  49
Create PDF parameter  140
Create XLS parameter  141
Create XML parameter  140
CSV, defined  2
Curve type parameter

Calibration  116
Method Template Editor  85

CV Test (%) parameter
Calibration flag  124
ISTD flag  131

D
dashboard parameters  15
Data Review command  15
Data Review view  191
Decimal places to be reported parameter  144
Delete compound from method command

Blank flag  130
Calibration flag  124
ISTD flag  131
Lab Control flag  126
Matrix Spike flag  135
Meth Val flag  127
QC Check flag  125
Quan flag  123
Solvent Blank flag  132
Surrogate flag  133

Delete condition parameter  280
Detection method parameter

Genesis  104
ICIS  108

Detector parameter, Detection  101
Development Batch view  55
Display flags and legend parameter  144
Display retention time column command

Blank flag  130
Calibration flag  124
ISTD flag  131
Lab Control flag  126
Matrix Spike flag  135
Meth Val flag  127
QC Check flag  125
Quan flag  123
Solvent Blank flag  132
Surrogate flag  133

Display valid compounds only parameter  144

E
Enable peak threshold parameter  85
Enable valley detection parameter  104
Energy Ramp parameter  94
Example parameter  140
Exit TraceFinder command  9
Expected RT parameter, Detection  100
Expected width parameter  104
Export SRM data parameter  49
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Index: F
F
feature summary  3
Fill down command  275
Filter parameter, Detection  101
Finish view  168
Flag values above Carryover parameter  145
Flag values above LOR parameter  145
Flag values above ULOL parameter  145
Flag values below LOD parameter  145
Flag values below LOQ parameter  145
Flag values between LOD and LOQ parameter  145

G
Groups parameter, Breakdown flag  128

H
Help command, dashboard  15

I
Import method from PMD parameter  49
Import Published Method parameter

instrument view  49
method view  49

Include compound peak spectrum as reference spectrum 
parameter  85

Include confirming ions parameter  85
Injection amount parameter  72
Injection volume parameter  90
installing

NIST and QED libraries  10
TraceFinder  8

Instrument method parameter
General  90
Method Forge  72

Instrument view  51
instruments, supported  ix
Ion Overlay page  212
Ion range calc method parameter  90
Ionization parameter  93
ISTD parameter  116

L
Lab name parameter  90
Launch Method Forge parameter  49
Lens parameter  94
Level parameter  121
Limit library hits parameter  85
Limit the retention time range parameter  85

Local Method view  215
LOD (Detection limit) parameter  123
Log Off command  15
logging on to TraceFinder  8
Login parameter  9
LOQ (Quantitation limit) parameter  123
LOR (Reporting limit) parameter  123

M
m/z parameter, Detection  102
Manual injection parameter  72
matrix blank sample type, defined  179
Max % breakdown parameter  128
Max Amt Diff (%) parameter  124
Max Conc parameter  130
Max recovery (%) parameter

ISTD flag  130
Lab Control flag  126
Matrix Spike flag  134
Meth Val flag  127
Surrogate flag  133

Max RF Diff (%) parameter  125
Max RPD parameter

Lab Control flag  126
Matrix Spike flag  134

Max RSD (%) parameter
Calibration flag  124
Meth Val flag  127

Max RT (+min) parameter, ISTD flag  131
METH, defined  2
Method Development command  15
Method Forge  67
Method parameter

Flags, Solvent Blank  132
Matrix Blank flag  129

Method selection view  156
Method Template Editor  84
Method view  63
methods

Acquisition mode  156
downloading published  50
importing Xcalibur  73
instrument  51
local  215
master  62
Method Forge  67
Method Template Editor  84
startup and shutdown  168

Min peak height (S/N) parameter
Genesis  105
ICIS  109
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Index: N
Min peak width parameter  109
Min recovery (%) parameter

Flags, ISTD  130
Flags, Lab Control  126
Flags, Matrix Spike  134
Flags, Meth Val  127
Flags, Surrogate  133

Min RT (-min) parameter  131
modes

choosing  13
defined  15

Multiplet resolution parameter  109

N
Name the master method parameter  72
New instrument method parameter  49
New sample list parameter  49
NIST library, installing  10
Noise method parameter  109

O
Only select top peaks parameter  85
Open instrument method parameter  49
Open method parameter  49
Open Qual Browser parameter  49
Operand parameter  280
Operator parameter  280
Or conditions parameter  280
Origin parameter

Calibration  116
Method Template Editor  86

P
parameters

# background scans  106
% Test  121
Acquire a new raw data file  72
Active

Breakdown  128
Identification  96

Add a condition  280
Amount  116
And conditions  280
Area noise factor  108
Area scan window  110
Area tail extension  109
Assay type  90
Automatically create the master method  72
Baseline window  108
Best match method  85

Breakdown method, General  90
cal1-caln  118
Calibration method  85
Carryover limit  123
CAS No  96
Category  93
Chemical Formula  93
Collision Energy, precursor  94
Compound

Calibration  116
Calibration flag  124
Calibration levels  118
Identification  96
ISTD flag  130
Lab Control flag  126
Matrix Blank flag  129
Matrix Spike flag  134
Meth Val flag  127
QC Check flag  125
QC levels  121
Quan flag  123
Solvent Blank flag  132
Surrogate flag  133

Compound Name  93
Compound type

Calibration  116
Identification  96

Compounds for group  128
Constrain peak width

Genesis  104
ICIS  108

Correct surrogates  145
Create method  49
Create PDF  140
Create XLS  141
Create XML  140
Curve type

Calibration  116
Method Template Editor  85

CV Test (%)
Calibration flag  124
ISTD flag  131

dashboard  15
Decimal places to be reported  144
Delete condition  280
Detection method

Genesis  104
ICIS  108

Detector, Detection  101
Display flags and legend  144
Display valid compounds only  144
Enable peak threshold  85
Enable valley detection  104
Energy Ramp  94
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Index: P
Example  140
Expected RT, Detection  100
Expected width  104
Export SRM data  49
Filter, Detection  101
Flag values above Carryover  145
Flag values above LOR  145
Flag values above ULOL  145
Flag values below LOD  145
Flag values below LOQ  145
Flag values between LOD and LOQ  145
Groups, Breakdown flag  128
Import method from PMD  49
Import Published Method

instrument view  49
method view  49

Include compound peak spectrum as reference spectrum  
85

Include confirming ions  85
Injection amount  72
Injection volume  90
Instrument method

General  90
Method Forge  72

Ion range calc method  90
Ionization  93
ISTD  116
Lab name  90
Launch Method Forge  49
Lens  94
Level  121
Limit library hits  85
Limit the retention time range  85
LOD (Detection limit)  123
Login  9
LOQ (Quantitation limit)  123
LOR (Reporting limit)  123
m/z, Detection  102
Manual injection  72
Max % breakdown  128
Max Amt Diff (%)  124
Max Conc  130
Max recovery (%)

ISTD flag  130
Lab Control flag  126
Matrix Spike flag  134
Meth Val flag  127
Surrogate flag  133

Max RF Diff (%)  125
Max RPD

Lab Control flag  126
Matrix Spike flag  134

Max RSD (%)
Calibration flag  124
Meth Val flag  127

Max RT (+min), ISTD flag  131
Method

Flags, Solvent Blank  132
Matrix Blank flag  129

Min peak height (S/N)
Genesis  105
ICIS  109

Min peak width  109
Min recovery (%)

Flags, ISTD  130
Flags, Lab Control  126
Flags, Matrix Spike  134
Flags, Meth Val  127
Flags, Surrogate  133

Min RT (-min)  131
Multiplet resolution  109
Name the master method  72
New instrument method  49
New sample list  49
Noise method  109
Only select top peaks  85
Open instrument method  49
Open method  49
Open Qual Browser  49
Operand  280
Operator  280
Or conditions  280
Origin

Calibration  116
Method Template Editor  86

Password  9
Path  72
Peak height (%)

Genesis  105
ICIS  108

Peak noise factor  108
Peak S/N cutoff  105
Percentage  130
Polarity  94
Precursor Mass  93
Print

custom reports  141
standard reports  140

Product Mass  94
QC1-QCn  121
Qualitative peak processing template  90
R^2 threshold  124
Raw filename  72
Reference compound  96
Report concentration  144
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Index: Q
Report Name
custom reports  141
standard reports  140

Report noise as  106
Report Title  140
Response via

Calibration  116
Method Template Editor  86

RMS  110
RT

Acquisition List  94
Calibration  116
Calibration levels  118
Flags, Calibration  124
Flags, ISTD  130
Flags, Lab Control  126
Flags, Matrix Blank  129
Flags, Matrix Spike  134
Flags, Meth Val  127
Flags, QC Check  125
Flags, QC levels  121
Flags, Quan  123
Flags, Solvent Blank  132
Flags, Surrogate  133
Identification  96

S/N threshold  104
Sample comment  72
Select a custom template  72
Select batch location  49
Sensitivity

Genesis  104
ICIS  108

sensitivity  85
Separate ion overlay display  144
Shade row when sample is outside of evaluation criteria  

144
Show chromatogram on Quantitation Report  144
Smoothing

Genesis  104
ICIS  108

Specify default ion ratio ranges  85
Standard type  116
Tailing factor

Genesis  105
ICIS  109

Theo Conc
Lab Control flag  126
Matrix Spike flag  134
Meth Val flag  127
Surrogate flag  133

Trace, Detection  102
ULOL (Linearity limit)  123
Units  116
Upper Limit  132

Use alternate calibration report format  144
Use an existing raw data file  72
Use as RT Reference  96
Use autosampler  72
Use the default template  72
Use these libraries  85
Username  9
Valley rise (%)  106
Valley S/N  106
Vial position  72
View width, Detection  100
Weighting

Calibration  116
Method Template Editor  86

Window
Acquisition List  94
Detection  100

Password parameter  9
Path parameter  72
Peak height (%) parameter

Genesis  105
ICIS  108

Peak noise factor parameter  108
Peak S/N cutoff parameter  105
Percentage parameter  130
PMD, defined  2
Polarity parameter  94
Precursor Mass parameter  93
Print parameter

custom reports  141
standard reports  140

Product Mass parameter  94
Project Administration view  28
projects and subprojects, creating  28

Q
QC1-QCn parameter  121
QED library, installing  10
QED Spectra page  207
Qualitative peak processing template parameter  90

R
R^2 threshold parameter  124
Raw filename parameter  72
Real Time Status command  15
real-time display  176
Reference compound parameter  96
Report concentration parameter  144
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Index: S
Report Name parameter
custom reports  141
standard reports  140

Report noise as parameter  106
Report selection view  163
Report Title parameter  140
Report View  213
reports

Acquisition mode  163
configuring  40
Data Review mode  213
flags defined  220
sample PDFs  221
viewing landscape in PDF  221

Reset scaling command  113
Response via parameter

Calibration  116
Method Template Editor  86

RMS parameter  110
RT parameter

Acquisition List  94
Calibration  116
Calibration levels  118
Flags, Calibration  124
Flags, ISTD  130
Flags, Lab Control  126
Flags, Matrix Blank  129
Flags, Matrix Spike  134
Flags, Meth Val  127
Flags, QC Check  125
Flags, QC levels  121
Flags, Quan  123
Flags, Solvent Blank  132
Flags, Surrogate  133
Identification  96

S
S/N threshold parameter  104
Sample comment parameter  72
Sample definition view  157
sample types. defined  179
Select a custom template parameter  72
Select batch location parameter  49
Sensitivity parameter

Genesis  104
ICIS  108

sensitivity parameter  85
Separate ion overlay display parameter  144
Set this mass as a new quan peak command  113
Set this mass as quan mass command  113

Shade row when sample is outside of evaluation criteria 
parameter  144

Show chromatogram on Quantitation Report parameter  144
Smoothing parameter

Genesis  104
ICIS  108

Specify default ion ratio ranges parameter  85
Spectra page  206
SRM data, exporting  76
Standard type parameter  116
starting TraceFinder  8
supported software and hardware  ix
system requirements  ix

T
Tailing factor parameter

Genesis  105
ICIS  109

templates
batch  155
method  78

Theo Conc parameter
Lab Control flag  126
Matrix Spike flag  134
Meth Val flag  127
Surrogate flag  133

Trace parameter, Detection  102

U
ULOL (Linearity limit) parameter  123
Units parameter  116
Update confirming ion ratios with this spectrum command  
113

Update methods  90
Upper Limit parameter  132
Use alternate calibration report format parameter  144
Use an existing raw data file parameter  72
Use as RT Reference parameter  96
Use autosampler parameter  72
Use the default template parameter  72
Use these libraries parameter  85
user accounts, creating  20
User Administration view  20
user roles, defined  25
Username parameter  9

V
Valley rise (%) parameter  106
Valley S/N parameter  106
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Index: W
Vial position parameter  72
View width parameter, Detection  100
views

Application Configuration  37
Batch  182
Batch/Template Selection  152
Compound Datastore  30
Data Review  191
Development Batch  55
Finish  168
Instrument  51
Local Method  215
Method  63
Method selection  156
Project Administration  28
Report selection  163
Report View  213
Sample definition  157
User Administration  20

W
Weighting parameter

Calibration  116
Method Template Editor  86

Window parameter
Acquisition List  94
Detection  100

workflow
acquisition mode  150
general  7
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